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Overview - What is IMD and 
what can it do?
IMD is a point-and-click IDL application that can calculate specular and non-
specular (diffuse) optical functions of an arbitrary multilayer structure, i.e., a 
structure consisting of any number of layers of any thickness, and of any 
material. IMD includes a database of optical constants for over 150 
materials, spanning the X-ray region to the infrared. It's also easy to use your 
own optical constants if necessary, or to create new X-ray optical constants 
for any compound, using tabulated atomic scattering factors for 92 elements. 
IMD can be used for both modeling and for parameter estimation by 
nonlinear, least-squares curve-fitting (including confidence interval 
generation) to your own measured data. 

The IMD graphical user interface allows you to quickly define the multilayer 
structure you wish to consider. The general multilayer structure consists of 
any number of individual layers, which can be grouped together to create 
periodic (and optionally depth-graded) multilayers, if desired. You can even 
create 'groups of groups' of layers, with no limit on nesting depth. Layers and 
periodic multilayers can be inserted or removed anywhere in the stack. 

Specular optical functions - reflectance, transmittance, absorbtance, electric 
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field intensities, phase shifts, and ellipsometric psi and delta functions  - are 
computed using an algorithm that is based on recursive application of the 
Fresnel equations [1], modified to include interfacial roughness and/or 
diffuseness [2,3]. Non-specular reflected intensities can be computed using 
either a dynamical Born approximation vector theory [4], or the so-called 
'Distorted-Wave Born Approximation' formalism [5-8], a scalar theory which 
is nonetheless valid below the critical angle of total external reflection in the 
X-ray region. For both specular and non-specular computations, a stochastic 
model of film growth and erosion [9] can be used to account for the evolution 
of  interfacial roughness through the film stack.  Alternatively, a more 
conventional roughness model [10] can be used, with the option of defining 
depth-graded roughness and correlation length parameters. 

The specular and non-specular optical functions can be calculated not just as 
a function of incidence angle and/or wavelength, but also as a function of any 
of the parameters that describe the multilayer structure (i.e., optical constants, 
densities, layer thicknesses, roughness parameters, etc.,) and/or the incident 
'beam' (i.e., polarization, and spectral or angular resolution) You can 
designate as many as eight independent variables simultaneously.  In 
addition, individual structure parameters can be coupled to one another, so 
that a single independent variable (or fit parameter) can be used to vary 
multiple parameters. 

An interactive visualization tool, IMDXPLOT, allows you to view, analyze 
and print 1D or 2D 'slices' through multi-dimensional optical functions; with 
this visualization tool, it's possible to vary a given parameter and see the 
resulting effect on the optical functions in real time. IMDXPLOT makes it 
easy to overlay multiple optical functions on a single plot, and to include a 
variety of labels and legends;  2D 'slices' can be viewed as either surface or 
contour plots  You can also overlay your own measured data in order to 
compare interactively your measurements to the calculations. 

Parameter estimation is afforded by fitting an optical function to your own 
experimental data, using nonlinear, least-squares curve-fitting, with an 
unlimited number of adjustable parameters: any of the parameters that 
describe the multilayer structure or the incident beam can be fit. Multi-
dimensional confidence intervals associated with the best-fit parameter 
values can be estimated as well, and IMDXPLOT can be used to view 
confidence interval 'slices' in parameter space. 

The IMD interface was created with the hope that you will not need to 
consult this documentation very much. Nonetheless, contained in the chapters 
that follow is a detailed description of how to use IMD for modeling and 

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/index.html (2 of 5) [18/06/2002 17:01:25]



IMD V4.0

optical 
functions

●     Independent 
variables

❍     Independent 
variables 
specific to 
electric field 
calculations

❍     Independent 
variables 
specific to 
non-specular 
optical 
functions 

●     Coupled parameters

2.4 Performing the 
computation

2.5 Viewing, printing and 
saving the results

●     Saving the Results
●     Viewing and Printing 

the Results - 
IMDXPLOT

❍     Fixed Curves
❍     Statistics: 

estimating 
film 
thicknesses, 
feature 
widgets, etc.

●     Examples
❍     Reflectance 

and 
transmittance 
contours of a 
Y/Al 
multilayer

❍     Electric field 
intensitie 
contours of a 
Mo/Si 

parameter estimation. In addition, a variety of example files are included with 
the IMD distribution, which illustrate some of IMD's unique modelling and 
visualization capabilities. You might also have a look at the preprint of 
reference [11], to learn a bit more about the inner workings of IMD (as of 
version 3.1, that is.)

next
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Overview - What is IMD and what can it 
do?
IMD is a point-and-click IDL application that can calculate specular and non-specular (diffuse) optical 
functions of an arbitrary multilayer structure, i.e., a structure consisting of any number of layers of any 
thickness, and of any material. IMD includes a database of optical constants for over 150 materials, 
spanning the X-ray region to the infrared. It's also easy to use your own optical constants if necessary, or 
to create new X-ray optical constants for any compound, using tabulated atomic scattering factors for 92 
elements. IMD can be used for both modeling and for parameter estimation by nonlinear, least-squares 
curve-fitting (including confidence interval generation) to your own measured data. 

The IMD graphical user interface allows you to quickly define the multilayer structure you wish to 
consider. The general multilayer structure consists of any number of individual layers, which can be 
grouped together to create periodic (and optionally depth-graded) multilayers, if desired. You can even 
create 'groups of groups' of layers, with no limit on nesting depth. Layers and periodic multilayers can be 
inserted or removed anywhere in the stack. 

Specular optical functions - reflectance, transmittance, absorbtance, electric field intensities, phase shifts, 
and ellipsometric psi and delta functions  - are computed using an algorithm that is based on recursive 
application of the Fresnel equations [1], modified to include interfacial roughness and/or diffuseness 
[2,3]. Non-specular reflected intensities can be computed using either a dynamical Born approximation 
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vector theory [4], or the so-called 'Distorted-Wave Born Approximation' formalism [5-8], a scalar theory 
which is nonetheless valid below the critical angle of total external reflection in the X-ray region. For 
both specular and non-specular computations, a stochastic model of film growth and erosion [9] can be 
used to account for the evolution of  interfacial roughness through the film stack.  Alternatively, a more 
conventional roughness model [10] can be used, with the option of defining depth-graded roughness and 
correlation length parameters. 

The specular and non-specular optical functions can be calculated not just as a function of incidence 
angle and/or wavelength, but also as a function of any of the parameters that describe the multilayer 
structure (i.e., optical constants, densities, layer thicknesses, roughness parameters, etc.,) and/or the 
incident 'beam' (i.e., polarization, and spectral or angular resolution) You can designate as many as eight 
independent variables simultaneously.  In addition, individual structure parameters can be coupled to one 
another, so that a single independent variable (or fit parameter) can be used to vary multiple parameters. 

An interactive visualization tool, IMDXPLOT, allows you to view, analyze and print 1D or 2D 'slices' 
through multi-dimensional optical functions; with this visualization tool, it's possible to vary a given 
parameter and see the resulting effect on the optical functions in real time. IMDXPLOT makes it easy to 
overlay multiple optical functions on a single plot, and to include a variety of labels and legends;  2D 
'slices' can be viewed as either surface or contour plots  You can also overlay your own measured data in 
order to compare interactively your measurements to the calculations. 

Parameter estimation is afforded by fitting an optical function to your own experimental data, using 
nonlinear, least-squares curve-fitting, with an unlimited number of adjustable parameters: any of the 
parameters that describe the multilayer structure or the incident beam can be fit. Multi-dimensional 
confidence intervals associated with the best-fit parameter values can be estimated as well, and 
IMDXPLOT can be used to view confidence interval 'slices' in parameter space. 

The IMD interface was created with the hope that you will not need to consult this documentation very 
much. Nonetheless, contained in the chapters that follow is a detailed description of how to use IMD for 
modeling and parameter estimation. In addition, a variety of example files are included with the 
IMD distribution, which illustrate some of IMD's unique modelling and visualization capabilities. You 
might also have a look at the preprint of reference [11], to learn a bit more about the inner workings of 
IMD (as of version 3.1, that is.)
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Nonspecular x-ray scattering in a multilayer-coated imaging system
D. G. Stearns,a) D. P. Gaines,b) and D. W. Sweeney
Lawrence Livermore National Laboratory, P.O. Box 808, Livermore, California 94550

E. M. Gullikson
Center for X-Ray Optics, Lawrence Berkeley Laboratory, 1 Cyclotron Road, Berkeley, California 94720

~Received 6 January 1998; accepted for publication 11 April 1998!

We present a rigorous theoretical treatment of nonspecular x-ray scattering in a distributed imaging
system consisting of multilayer-coated reflective optics. The scattering from each optical surface is
obtained using a vector scattering theory that incorporates a thin film growth model to provide a
realistic description of the interfacial roughness of the multilayer coatings. The theory is validated
by comparing calculations based on measured roughness to experimental measurements of
nonspecular scattering from a Mo–Si multilayer coating. The propagation of the scattered radiation
through the optical system is described in the context of transfer function theory. We find that the
effect of nonspecular scattering is to convolve the image with a point spread function that is
independent of the coherence of the object illumination. For a typical soft x-ray imaging system, the
scattering within the image field from the multilayer coatings is expected to be slightly greater than
for single surfaces~as normalized to the reflectivity!. This is because the roughness of the coatings
includes both replication of the substrate roughness and the intrinsic roughness of the multilayer
growth process. Our analysis indicates that the current multilayer coating technology is capable of
producing soft x-ray imaging systems that have acceptably low levels of scattering, provided that
the optical substrates are sufficiently smooth.@S0021-8979~98!02214-2#

I. INTRODUCTION

Advancement in areas such as extreme ultraviolet~EUV!
lithography1 and x-ray astronomy2 are spurring dramatic im-
provement in the performance of optical imaging systems for
the soft x-ray regime (1,l,100 nm). The ultimate goal is
to achieve high throughput with resolution near the diffrac-
tion limit. This requires the use of all reflective, distributed
imaging systems working near normal incidence. However,
the normal incidence reflectivity of all materials is very low
at soft x-ray wavelengths. The problem is overcome by coat-
ing the optical surfaces with multilayer films, which in-
creases the reflectivity by several orders of magnitude in
comparison to a single surface. There are yet many potential
problems that can degrade the image formation and limit the
resolution. One of the most important of these is the non-
specular scattering from the multilayer coatings.

The ultimate resolution of a soft x-ray imaging system
depends in detail on the nonideal nature of the optical sub-
strate and the interfaces in the multilayer coatings. These
structures are imperfect at all spatial frequencies. The errors
at frequencies less than;10 cm21 are called figure error and
are treated deterministically. The figure errors produce an
aberration of the image that can be calculated using ray trac-
ing techniques. The errors at higher frequency are called
roughness~or surface finish! and are usually treated statisti-

cally. The effect of the roughness is to remove intensity from
the image~the specular field! and scatter it throughout the
image field. This nonspecular scattering is problematic for
two reasons:~1! it decreases the useful throughput of the
optical system and,~2! it produces a background halo which
reduces the contrast of the image.

Soft x-ray imaging systems are particularly susceptible
to nonspecular scattering. The first reason is that the optics
are by necessity all reflective. The second reason is the well-
known l24 dependence of the cross section for dipole scat-
tering. For a given interfacial roughness, the nonspecular
scattering increases rapidly with decreasing wavelength. The
implications for high resolution imaging are clear: the optical
substrates and multilayer coatings must be very smooth to
avoid significant scattering. But how smooth is smooth
enough? The answer to this question is of both fundamental
and practical interest. Fundamentally, there has been until
now a general lack of understanding of the effects of scatter-
ing in a multilayer-coated imaging system. From a practical
perspective, the time and cost of producing figured optical
substrates increases dramatically with the smoothness of the
surface. An accurate model of scattering is needed to derive
realistic specifications for surface finish that can be used as a
guideline for manufacturing precision optical components.

The problem of nonspecular scattering of x rays from
multilayer films has been addressed by many authors in re-
cent years.3–7 It is now understood that the scattering from a
multilayer film is fundamentally different than the scattering
from a single rough surface. The multilayer scattering is
characterized by strong interference effects, due to the cor-

a!Current address: OS Associates, 1174 Castro St., Suite 250, Mountain
View, CA 94040; electronic mail: healthst@ricochet.net

b!Current address: Ultratech Stepper, 3050 Zanker Rd., San Jose, CA 95134.
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relation of the roughness of the different interfaces. Reso-
nances in the scattering were theoretically predicted3,4 and
have been experimentally observed.4,7–10 Dynamical effects
arising from the multiple specular reflection and extinction
of the scattered radiation can also be important,5 particularly
in the vicinity of a specular Bragg peak. We will show that
these unique characteristics of the scattering from multilayer
coatings have important consequences in an imaging system.

There have been previous attempts to address the prob-
lem of nonspecular x-ray scattering in an imaging system.
Church and Takacs11 have considered the scattering in a
simple imaging system consisting of a single reflecting sur-
face operating near normal incidence. Here the multilayer
coating is treated as a single rough surface. Harvey12 has
discussed scattering in a distributed imaging system, and has
proposed anad hocmethod for incorporating the effects of
multilayer coatings. More recently, Singhet al.13 have ap-
plied a Monte Carlo ray tracing technique to simulate non-
specular scattering in a Schwarzschild imaging system. In
spite of this previous work, we believe that the current un-
derstanding of scattering in a soft x-ray imaging system is
incomplete. In particular, these important issues have yet to
be adequately addressed:

~1! Owing to the high spatial frequencies characteristic
of roughness there is significant diffraction of the scattered
field as it propagates between the optical surfaces that pro-
duce the scattering and the exit pupil. How does this diffrac-
tion affect the pupil function and the image formation pro-
cess in the context of the transfer function theory of
imaging?

~2! It is well known that the coherence state of the object
illumination is an important parameter in the imaging pro-
cess. What is the relationship between the coherence state
and the effects of scattering on the image process?

~3! The scattering from a multilayer coating occurs over
a large number of interfaces throughout the volume of the
film. The magnitude and distribution of scattering depends
on the detailed structure of the roughness of the interfaces.
What is a correct description of the roughness of a multilayer
coating and how is it related to the roughness of the sub-
strate?

~4! What are the characteristics of the scattering from a
multilayer coating, particularly in the vicinity of the Bragg
peak, and how do they differ from that of a single rough
surface? In particular, the description of the scattering pro-
cess must include interference effects~from the correlation
of the interfacial roughness!, dynamical effects~multiple re-
flection of the incident and scattered fields!, and extinction of
the scattered radiation in the film.

To investigate these issues we present a comprehensive
theoretical description of scattering in a soft x-ray imaging
system, which includes rigorous treatments of the image for-
mation process, the roughness of the multilayer coatings, and
the scattering process. In the following section we derive,
following Born and Wolf,14 a very general expression for the
transfer function that relates the mutual intensity at the object
and image planes. In Sec. III we consider the scattering in a
distributed imaging system having single reflecting surfaces.
We explicitly include the diffraction of the scattered field

and obtain an effective pupil function for the distributed im-
aging system. The intensity distribution at the image plane is
derived in Sec. IV. We show that the effect of scattering is to
convolve the image with a point spread function independent
of the coherence state of the object illumination. In Sec. V
we consider the case of multilayer coatings, and we relate the
point spread function to the angular scattering distributions
from the multilayer coatings. The calculation of these scat-
tering distributions is the topic of the next two sections. In
Sec. VI we review a thin film growth model that has been
previously developed15 to describe the interfacial roughness
in multilayer coatings, and we apply this model to measure-
ments of roughness in a Mo–Si multilayer film. The
multilayer scattering problem is treated in Sec. VII using an
existing scattering theory extended to include dynamical ef-
fects in the scattered field. To validate the scattering theory,
we compare calculations to experimental measurements of
nonspecular scattering from a high-performance Mo–Si
multilayer coating. In Sec. VIII we evaluate the scattering in
a soft x-ray imaging system in terms of conventional perfor-
mance parameters, namely the point spread function and the
optical transfer function. We close our discussion by model-
ing the effects of scattering in a hypothetical imaging system
designed for EUV lithography.

Throughout the course of the theoretical development
we make several critical assumptions and approximations. It
is important to observe the restrictions and constraints im-
posed by these approximations whenever the theory is ap-
plied to specific imaging systems. The approximations are
enumerated as they appear in the text and are summarized in
Appendix A.

II. DERIVATION OF THE TRANSFER FUNCTION

Consider a distributed imaging system consisting ofN
reflecting surfaces and having a real aperture stop as shown
in Fig. 1. The Cartesian coordinates of the object plane and
the image plane areS0 and s1 , respectively. We introduce
the scale normalized coordinates for the object plane,s0

5MS0 , whereM is the lateral magnification of the optical
system. This allows us to describe an object point and its
Gaussian image point by the same coordinate values. The
aperture stop of the imaging system limits the angular dis-

FIG. 1. Schematic diagram of a distributed imaging system showing the
trajectory of the principal ray. The (X,Y,Z) coordinate system of the rough
surface is related to the (x,y,z) coordinate system of the exit pupil through
a rotation of angleu. The exit pupil is located a distancez5zP from the
rough surface.
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persion of rays through the system. For a point object, the
ray that intersects the center of the aperture stop is called the
principal ray. The image of the aperture stop by the part of
the optical system which follows it is called the exit pupil.
The exit pupil is located a distanceR from the image plane.
The amplitude of the radiation field at the plane of the exit
pupil is called the complex pupil function,G(s).

Let the object be illuminated by quasimonochromatic ra-
diation of wavelengthl. The mutual intensity functions in
the object and image planes areJ0(s0 ,s08) and J1(s1 ,s18),
respectively. Following Born and Wolf14 the Fourier trans-
forms of the mutual intensity functions,J0(f,f8) and
J1(f,f8), are related by

J1~ f,f8!5G~lRf!G* ~2lRf8!J0~ f,f8!, ~1!

wheres5lRf are the coordinates of a point in the plane of
the exit pupil. This description of the transfer of the mutual
intensity function through the imaging system is only valid
within two important approximations. These are:

~a! The angle between the principal ray and any other
ray that propagates through the imaging system is small.
Specifically, if we denote the angle asw, then the approxi-
mation is

sin2 w!1. ~2!

We call this the ‘‘small angle approximation.’’
~b! For a point object, the pupil function is independent

of the location of the point in the object field. In this case the
point spread function is independent of the position of the
Gaussian image point, and the system is called
‘‘isoplanatic.’’ In practice, the assumption of isoplanacity
restricts the applicability of the transfer function formalism
to objects of small spatial extent.

The effect of scattering from roughness at the optical
surfaces is to modify the pupil function in a simple way. Let
G0(s) be the pupil function for the optical system without
rough surfaces. HereG0 contains all of the standard deter-
ministic information about the imaging system such as aber-
rations. We will show in Sec. II that the effect of the rough-
ness can be represented as a pure phase modulation:

G~s!5G0~s!exp@ iF~s!# ~3!

whereF~s! is a function directly related to the structure of
the rough surfaces. Then substituting~3! into ~1! we obtain

^J1~ f,f8!&5G0~lRf!G0* ~2lRf8!

3^exp@ i ~F~lRf!2F* ~2lRf8!!#&J0~ f,f8!.

~4!

The angular brackets denote taking an ensemble average
over many configurations of the rough surface. In practice
this is realized by the breaking up of the coherence of the
illumination of the surface due to the finite size of the object.
For a coherently illuminated object of sizeL and a distance
D between the object plane and the optical surface, the size
of the patch on the surface over which the illumination is
coherent is approximatelylD/2L. For typical sources of fi-

nite size there will be many of these patches within the area
illuminated on the optical surface. If the surface is suffi-
ciently ergodic then each patch represents a different con-
figuration of roughness, and the ensemble average can be
replaced by an average over the illuminated surface area.

III. EFFECTIVE PUPIL FUNCTION

To proceed further it is necessary to derive an expression
for the pupil functionG(s) that includes scattering from the
optical surfaces. For the moment let the optical surfaces be
single surfaces~not coated with multilayer films!, and as-
sume that all but one of the surfaces are perfectly smooth, as
indicated in Fig. 1. Since our goal is to determine the effect
of scattering on the pupil function, we can neglect the cur-
vature of the incident wavefront and the optical surface
~these will be included later!. Then let the specular field be a
plane wave,êeikn̂•x, of unit amplitude and polarizationê
incident onto the rough surface with an angleu ~measured
with respect to the normal!. The field is reflected by the
surface and propagates to the plane of the exit pupil. Choos-
ing the plane of the exit pupil to be perpendicular to the
principal ray, we find thatu is also the angle between the
normal to the exit pupil and the normal to the rough surface.

An expression for the field scattered by the rough sur-
face has been derived in a previous paper.16 The results are
valid under the following approximation:

~c! The scattering is weak so that multiple scattering and
shadowing effects can be neglected. This is called the ‘‘Born
approximation.’’ This approximation is generally valid for
x-ray wavelengths at angles of incidence away from the criti-
cal angle for total external reflection.

The component of the scattered reflected fieldER(x)
having polarizationâ ~S or P type! can be written as:

â•ER~x!5
D

2
~ â•ê!E E S E E exp~ iqXX!exp~ iqYY!

3
exp@ iqZH~X,Y!#

qZ~qZ1knZ!
dXdYD

3exp~ ikm̂•x!dmXdmY . ~5!

HereD512e, wheree is the dielectric constant of the sur-
face material,q5k(m̂2n̂) is the change of momentum of
the x-ray photon andH(X,Y) is the surface height function
describing the roughness of the surface.

The expression~5! for the scattered field has a straight-
forward physical interpretation: it is simply an expansion of
the scattered field using the plane waves exp(ikm̂•x) as a
basis set. The quantity in brackets is the scattering amplitude
of the plane wave modem̂. Note that there are two different
spatial coordinate systems in Eq.~5!. The relationship be-
tween these coordinate systems is illustrated in Fig. 1. The
coordinate system (X̂,Ŷ,Ẑ) is defined such thatẐ is normal
to the plane of the rough optical surface and theY-Z plane is
the plane of incidence. The coordinate system (x̂,ŷ,ẑ) hasẑ
normal to the plane of the exit pupil. The transformation
between the two coordinate systems is a rotation through an
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angleu about thex̂5 x̂8 axis. The momentum transfer vector
q in the two coordinate systems is related according to

qX5qx

qY5cosuqy1sin uqz>cosuqy12k cos2 u sin u ~6!

qZ52sin uqy1cosuqz>2k cosu.

These expressions are valid within the small angle approxi-
mation ~a!, which requires thatqX andqY be small. Noting
that

n̂5sin uŶ2cosuẐ5sin 2u ŷ2cos 2u ẑ ~7!

we rearrange Eq.~5! to get

â•ER~x!5~1/4p2!r SP cosu exp~ iky sin 2u!exp~2 ikz cos 2u!E E E E exp~ iq•x!exp~2 iqxX!

3exp~2 i cosuqyY!exp~22ik cos2 u sin uY!exp@22ik cosuH~X,Y!#dXdYdqxdqy ~8!

wherer SP5D(â•ê)/4 cos2 u is the specular reflectance amplitude from an ideally smooth surface.
Next we propagate the reflected field to the plane of the exit pupil at positionz5zP . The field in this plane is the complex

pupil functionG(s) wheres5sxx̂1syŷ. Then using Eq.~8! the pupil function becomes

G~s!5~1/4p2!r SP cosu exp~ ik sin 2usy!exp~2 ik cos 2uzP!

3E E E E exp~ iqxsx!exp~ iqysy!exp~ iqzzP!

3exp~2 iqxX!exp~2 i cosuqyY!exp~22ik cos2 u sin uY!exp@22ik cosuH~X,Y!#dXdYdqxdqy . ~9!

This is the correct expression for the pupil function that includes the~significant! diffraction of the scattered field on its way
to the exit pupil. However, the propagation of the mutual intensity, as described in Eq.~1!, requires the determination of the
transfer function̂ G(s)G* (2s8)&. Substituting from Eq.~9! we have

^G~s!G* ~2s8!&5~1/16p4!RSP cos2 u exp@ ik sin 2u~sy1sy8!#

3E E E E exp~ iqxsx!exp~ iqysy!exp~ iqzzP!exp~ iqx8sx8!exp~ iqy8sy8!exp~2 iqz8zP!

3E E E E ^exp$22ik cosu@H~X,Y!2H~X8,Y8!#%&exp~2 iqxX!exp~ iqx8X8!

3exp@2 i cosu~qyY2qy8Y8!#exp@22ik cos2 u sin u~Y2Y8!#dXdYdX8dY8dqxdqydqx8dqy8 . ~10!

We make the following assumptions about the statistical properties of the roughness:
~d! The surface heightH(X,Y) is a Gaussian random variable, is stationary and is ergodic in the sense that the ensemble

average can be replaced by an average over the illuminated surface area.
The assumption thatH is stationary leads to an important simplification: the quantity in the brackets^ & depends only on

the separation of the pointsU5X2X8 andV5Y2Y8. In particular, if we define

F~U,V![^exp$22ik cosu@H~X,Y!2H~X8,Y8!#%& ~11!

then the inner integral in Eq.~10! becomes

E E E E F~U,V!exp~2 iqxU !exp~2 i cosuqyV!exp~22ik cos2 u sin uV!exp@2 i ~qx2qx8!X8#

3exp@2 i cosu~qy2qy8!Y8#dX8dY8dUdV

5cos21 ud~qx2qx8!d~qy2qy8!E E F~U,V!exp~2 iqxU !exp~2 i cosuqyV!exp~22ik cos2 u sin uV!dUdV. ~12!

Substituting~12! into ~10! we obtain:
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^G~s!G* ~2s8!&5~1/4p2!RSP cosu exp@ ik sin 2u~sy1sy8!#E E E E F~U,V!exp~22ik cos2 u sin uV!

3exp@ iqx~sx1sx82U !#exp@ iqy~sy1sy82cosuV!#dqxdqydUdV

5RSP cosuE E F~U,V!d~sx1sx82U !d~sy1sy82cosuV!dUdV5RSPFS sx1sx8 ,
sy1sy8

cosu D . ~13!

We find that the transfer function̂G(s)G* (2s8)& does not
depend onzP , the distance between the optical surface and
the exit pupil. In other words, the diffraction of the scattered
field between the optical surface and the exit pupil does not
contribute to the image formation. This surprising conclusion
is due to the process of averaging over an ensemble of con-
figurations corresponding to a stationary distribution.
Diffraction effects must cancel out in the ensemble
average because all points on the optical surface are
equivalent. Consequently, for the purpose of evaluating
^G(s)G* (2s8)&, we can map the rough surface directly
onto the exit pupil as if there was no separation (zP50). The
effect of the roughness on the pupil function can be repre-
sented as a simple phase modulation

G~s!5G0~s!expF22ik cosuHS sx

ax
,

sy

ay cosu D G . ~14!

Here we have reintroduced the effects of the wavefront cur-
vature and surface figure in the factorG0(s), which is the
pupil function in the absence of scattering. The factorsax

5sx /X and ay5sy /(Y cosu) account for the change of
scale between the optical surface and the exit pupil, as de-
termined, for example, by the change in separation of the
extrema rays. The scaling relationship forsy includes a fac-
tor of cosu to account for the angle of inclination of the
optical surface with respect to the plane of the exit pupil. We
emphasize that Eq.~14! is not the correct pupil function for
any particular configuration of surface roughness. It can be
used, however, as aneffectivepupil function, in the sense
that it produces a correct result in the calculation of image
formation when the quantitŷG(s)G* (2s8)& is averaged
over a statistically random andstationarydistribution of con-
figurations.

At first glance it might appear that Eq.~14! cannot cor-
rectly account for all of the radiation scattered within the
imaging system. For example, radiation scattered at large
angles by the first optical surface in the distributed system
will not pass through the subsequent optics and reach the exit
pupil. Yet within the context of the transfer function theory,
the roughness of each optical surface is mapped onto the exit
pupil and all of the scattering occurs at the exit pupil. The
resolution of this apparent inconsistency is to understand that
any scattered radiation that in reality does not reach the exit
pupil, is scattered outside of the image field in the transfer
function description; the transfer function theory correctly
accounts for all scattering that intersects the image field. This
can be illustrated using the following argument. Consider the
ideal imaging system that images a point object ats0 to a
point s1 in the image plane. The scattering from a rough

optical surface into a particular nonspecular directionm̂ will
be imaged by the subsequent optics to a different points18 in
the image plane. Tracing rays back through the imaging sys-
tem from the image points18 , the propagation through the
imaging system of the radiation scattered into directionm̂ is
found to be equivalent to the imaging of a point source at the
conjugate positions08 in the object field. Consequently, the
propagation of the scattered radiation that intersects the im-
age field is equivalent to the propagation of radiation from an
extended object in the absence of scattering, a process that is
correctly described by transfer function theory.

Thus far we have considered the scattering from a single
rough surface. We next consider an imaging system where
each of theN reflecting surfaces has a roughness described
by a unique height functionHn(Xn ,Yn). We assume that the
roughness of the different surfaces each satisfies the condi-
tions ~d! for stationary and ergodic distributions, and are mu-
tually statistically independent. The effective pupil function
for the entire imaging system can be derived by imagining
that we ‘‘turn on’’ the roughness of each surface sequentially
and apply Eq.~14! iteratively. In particular, the pupil func-
tion for n rough surfaces becomesG0 for the case ofn11
rough surfaces, etc. Then the effective pupil function for the
entire distributed system is

G~s!5G0~s!exp@ iF~s!#

5G0~s!expF22k(
n51

N

cosunHnS sx

axn
,

sy

ayn cosun
D G .

~15!

IV. DESCRIPTION OF THE IMAGE

Having derived the effective pupil function, we now ap-
ply the transfer function formalism of Eq.~4! to obtain a
description of the image. We begin by evaluating the quan-
tity

^exp@ i ~F~s!2F* ~2s8!#&

5K expH 22ik (
n51

N

cosunFHnS sx

axn
,

sy

ayn cosun
D

2HnS 2
sx8

axn
,2

sy8

ayn cosun
D G J L . ~16!

It can be shown generally17 that for Gaussian random vari-
ablesBm the ensemble average reduces to

K expS (
n

BnD L 5expF1

2 K S (
n

BnD 2L G . ~17!
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We have assumed that the roughness of the different optical
surfaces is completely uncorrelated, requiring that^HnHm&
50 for nÞm. Then we obtain

^exp@ i ~F~s!2F* ~2s8!#&

5expS 24k2(
n51

N

cos2 un^Hn
2~Xn ,Yn!&

14k2(
n51

N

cos2 un^Hn~Xn ,Yn!Hn~2Xn8 ,2Yn8!& D ,

~18!

where (Xn ,Yn)5@(sx /axn)(sy /ayn cosun)# are the spatial
coordinates on thenth optical surface. The assumption that
H is stationary requires that the quantity^H2(X,Y)& be in-
dependent of (X,Y) and the quantity^H(X,Y)H(2X8,
2Y8)& depends only on the separation of the pointsU5X
1X8 andV5Y1Y8. These statistical quantities are conven-
tionally defined in terms of the surface height variances2,
wheres is called the root-mean-square~rms! roughness, and
the height–height autocorrelation functionC, given by

s2[
1

A E H2~X,Y!dXdY ~19!

and

C~U,V!5
1

A E H~X,Y!H~U1X,V1Y!dXdY. ~20!

Here we have replaced the ensemble average with an average
over the area,A, of the illuminated surface. We write

^exp@ i ~F~s!2F* ~2s8!#&5expS 24k2(
n51

N

cos2 unsn
2

14k2(
n51

N

cos2 unCn~un!D ,

~21!

where

un[
sx1sx8

axn
x̂1

sy1sy8

ayn cosun
ŷ.

The final step for determining the intensity distribution
in the image plane is to take the inverse Fourier transform of
^J1(f,f8)&. Applying the convolution theorem to Eq.~4! we
obtain

^J1~s1 ,s18!&5J1
0~s1 ,s18!* expS 24k2(

n
cos2 unsn

2D
3E E expF4k2 (

n
cos2 unCn~un!G

3exp~2p is1•f!exp~2p is18•f8!dfdf8. ~22!

Here

J1
0~s1 ,s18!5E E G0~lRf!G0* ~2lRf8!J0~ f,f8!

3exp~2p is1•f!exp~2p is18•f8!dfdf8, ~23!

is the mutual intensity at the image plane in the absence of
roughness. SinceCn is dependent only on the difference vec-
tor un , the double integral in~22! collapses to yield,

^J1~s1 ,s18!&5J1
0~s1 ,s18!* d~s12s18!

3expF24k2(
n

cos2 unsn
2G

3E E expF4k2(
n

cos2 unCn~un!G
3exp~2p is1•v!dv, ~24!

wherev[f1f8. The intensity distribution is obtained by set-
ting s15s18 . Then,

^I 1~s1!&5I 1
0~s1!* expF24k2(

n
cos2 unsn

2G
3E E expF4k2(

n
cos2 unCn~un!G

3exp~2p is1•v!dv. ~25!

Further simplification is possible if each surface is suffi-
ciently smooth to satisfy the following condition:

~e! The deviations of the surface heightHn(Xn ,Yn) from
the ideally smooth surface are small compared to the radia-
tion wavelength such that 2k cosunHn(Xn ,Yn)!1 for all Xn ,
Yn . We call this the ‘‘small roughness approximation.’’ A
necessary consequence of the small roughness approxima-
tion is that the power scattered into the nonspecular field is
small compared to the specularly reflected power, a condi-
tion that is implicitly satisfied by high-performance optics.

For a randomly rough surface the autocorrelation func-
tion Cn will have a maximum value ofsn

2. Then invoking
the small roughness approximation, we can expand the ex-
ponential in the integrand in Eq.~25! to obtain

^I 1~s1!&5I 1
0~s1!* expS 24k2(

n
cos2 unsn

2D
3Fd~s1!1

4k2

l2R2 (
n

axnayn cos3 un

3PSDnS axns1x

lR
,

ayn cosuns1y

lR D G . ~26!

Here PSDn is the~power spectral density! of thenth surface,
which is the Fourier transform of the autocorrelation func-
tion.

The result shown in Eq.~26! has a simple physical in-
terpretation. The effect of the surface roughness on the for-
mation of an image is to convolve the image that would exist
in the absence of scattering,I 1

0, with a point spread function
due to scattering

^I 1~s1!&5I 1
0~s1!* kPSFsc~s1!. ~27!
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The point spread function, PSFsc, consists of two parts:

PSFsc~s1!5
1

k FSd~s1!1(
n

dPn~s1!

ds1
G . ~28!

The first term is the contribution from specular reflection. It
is simply a delta function reduced by the Strehl factor,S,
where:

S5)
n

Sn5)
n

exp~24k2 cos2 unsn
2!. ~29!

The Strehl factor represents the power removed from the
specular field due to nonspecular scattering. The second term
in the PSF corresponds to the power per unit area scattered
into the image plane given a point source in the object plane,
where

dPn~s1!

ds1
5

4k2S

l2R2 axnayn cos3 un

3PSDnS axns1x

lR
,

ayn cosuns1y

lR D . ~30!

The factork accounts for any loss of integrated image inten-
sity due to, for instance, scattering outside of the image field
or absorption in the multilayer coating. It is defined by

k[E E FSd~s1!1(
n

dPn~s1!

ds1
Gds1 ~31!

which ensures that the PSF integrates to unity.
We note that the effect of scattering on the image for-

mationis independentof the coherence of the illumination of
the object. All of the coherence effects in Eq.~29! are con-
tained in the imageI 1

0(s1) formed in the absence of scatter-
ing. The effect of scattering is to convolve this image with a
PSFsc that is independent of the coherence state. This inter-
esting result is due to the process of taking an ensemble
average over the statistical distribution of configurations of
surface roughness. The coherence state of the source deter-
mines the specific illumination of the rough surface. How-
ever, taking the ensemble average makes each surface point
equivalent in terms of its contribution to scattering, which
means that the specific illumination pattern cannot effect the
scattering distribution.

V. EXTENSION TO MULTILAYER COATINGS

Thus far we have assumed that the optical surfaces are
single reflecting surfaces. In fact, these surfaces are coated
with multilayer films to produce efficient reflectivity at soft
x-ray wavelengths. Although the reflectance from a single
surface is small at these wavelengths, the reflections from
each interface in the multilayer coating add constructively to
produce a large total specular reflectance. For example, for a
single Mo surface the normal incidence reflectance of soft
x rays at a wavelength of 13 nm is;0.15%; the reflectance
from a Mo–Si multilayer coating consisting of 40 bilayers of
period 6.8 nm is;70% ~see Sec. VII!.

Multilayer coatings typically have roughness at the layer
boundaries, due to both replication of the substrate roughness
and roughness introduced during the film growth process.

The incident specular field scatters at each of the multilayer
interfaces, and these contributions add coherently to produce
a total scattered field. Hence, in principal, the calculation of
the scattered field from a multilayer coating requires knowl-
edge of the PSD of each of the interfaces, as well as the
correlation of the roughness between every pair of interfaces.
It is intractable to measure the roughness of each interface in
each coating of an imaging system. We have found that an
effective approach to this very complicated problem is to
describe the multilayer interface structure in terms of a
simple multilayer growth model.15 The model provides a
straightforward method for describing all of the detailed
structural information required by the scattering theory in
terms of a small set of fundamental parameters. A descrip-
tion of the multilayer growth model is presented in the next
section.

The nonspecular scattering from a multilayer film is fun-
damentally different than the scattering from a single sur-
face. This is because the scattered field is the coherent su-
perposition of the fields scattered by each of the interfaces.
Just as the specular reflectance is a resonance property of the
coating, the nonspecular scattering exhibits resonance behav-
ior that is absent in the case of a single surface. The phenom-
enon of resonant nonspecular scattering has been discussed
previously.3,5 The scattering is enhanced whenever the mo-
mentum change normal to the film is equal to a reciprocal
lattice vectorandwhen the structure of the interfaces is cor-
related from layer to layer~i.e., is at least partially confor-
mal!. This has important implications for the scattering in an
imaging system. Since the specular field is near the center of
the Bragg peak, the scattering at small angles will necessar-
ily satisfy the conditions for resonant scattering. To the ex-
tent that the interfacial roughness is purely conformal, the
multilayer film will behave like a single surface having the
roughness of the substrate. However, we will see that realis-
tic multilayer films have intrinsic interfacial roughness that
modifies the substrate roughness and reduces the conformal-
ity of the interface structure. These ‘‘multilayer effects’’ tend
to enhance the resonant scattering at small angles and sup-
press the scattering at large angles. To accurately describe
the scattering from realistic multilayer film we must account
for the variation of the interface structure through the film,
and the interaction of the radiation field with each interface.

Once the scattered field is outside of the multilayer coat-
ing, its propagation through the distributed optical system to
the image plane is described by the transfer function formal-
ism derived in the previous section. In particular, the effect
of scattering is to convolve the image with a PSFsc as de-
scribed by Eq. ~28!, where now the quantitiesSn and
dPn /ds1 correspond to the contribution from thenth
multilayer-coated optical surface. The roughness of thenth
coating reduces the specular field by a factor ofSn ; the
power per unit area scattered bynth coating into the image
plane~for a point source! is dPn /ds1 .

To derive an expression fordPn /ds1 , we relate this
quantity to the angular distribution of power scattered from
the nth coating. The power incident at the points1 in the
image plane corresponds to radiation that is scattered by the
nth coating into the directionm̂, given by
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mX5
anxs1x

R

mY>
anys1y cosun

R
1sin un ~32!

mZ>2
any sin un

R
s1y1cosun .

Note thatm̂ is projected onto the (X,Y,Z) coordinate system
of the rough coating. The power distribution in the image
plane is related to the power scattered per unit solid angle by
the nth coating according to

dPn~s1!

ds1
5

anxany

Rn
SPR2 (

â

dPn~m̂,â;n̂,ê!

dV
, ~33!

whereRn
SP is the specular reflectivity of the coating,n̂ andê

are the direction of propagation and the polarization of the
incident field, respectively, and we must sum over both po-
larization statesâ of the scattered field. In essence, Eqs.~32!
and~33! represent two mappings: first thenth rough coating
is mapped onto the exit pupil and second the angular distri-
bution of scattering from the rough coating is mapped to the
spatial coordinates of the image plane. Our task then reduces
to finding the angular distribution of scattering,dPn /dV,
and the Strehl factorSn for a multilayer-coated surface given
an incident plane wave propagating in directionn̂ with po-
larization ê. This problem is addressed in Sec. VII. How-
ever, before we can calculate the scattering from a multilayer
coating, we must obtain a realistic description of the rough-
ness of the multilayer interfaces, which is the subject of the
next section.

VI. GROWTH MODEL FOR MULTILAYER FILMS

Much attention has been given to the problem of the
roughening of the surface of a thin film by growth and ero-
sion. Stochastic theories of the evolution of the surface have
been developed using two generally different approaches. In
the first approach,18 the phenomenological observation that
randomly rough surfaces are self-affine is used to derive
simple scaling laws describing the width of the interface as a
function of film thickness and the amount of surface area
sampled. One consequence of the scaling theory is that the
autocorrelation function for the rough surface is approxi-
mately described by:19

C~r !5H s2F12
a11

2 S r

j D 2aG , for r<j

0, for r .j

~34!

where j is the correlation length anda is an independent
scaling parameter called the ‘‘roughness exponent.’’ The
corresponding PSD of the rough surface is given by

PSD~ f !5H a

p
s2j2, for q,1/j

a

p

s2

j2a f 22~a11!, for q>1/j

. ~35!

The rms roughnesss and correlation lengthj of the surface
change with the thickness of the growing~or eroding! film.
The scaling laws predict thats;tb andj;tb/a, wheret is
the thickness of the film andb is a second independent scal-
ing parameter.

The second approach19 of describing the roughening of a
surface is through the use of a kinetic continuum equation
for the evolution of the surface heightH(r ). The linear ver-
sion of such a continuum equation~to lowest order inH! has
the form:

]H~r !

]t
52nu¹nH~r !u1

]h

]t
. ~36!

In this approach the evolution of the surface roughness is
viewed to be a competition between relaxation of the sur-
face, wheren is an independent growth parameter that char-
acterizes the relaxation process, and the stochastic roughen-
ing due to the random shot noiseh of the deposition~or
removal! process. Whenn is positive, the first term in Eq.
~36! tends to dampen the surface roughness while the second
term increases the roughness with film thickness. The expo-
nentn in the relaxation term varies according to the kinetic
mechanism that dominates the smoothing process. Edwards
and Wilkinson20 first applied Eq.~36! with n52 to describe
the settling of a granular layer under the influence of the
gravitational potential. Herring21 has identified several relax-
ation mechanisms relevant to film growth corresponding to
viscous flow (n51), evaporation and condensation
(n52), bulk diffusion (n53) and surface diffusion
(n54). It has been pointed out by Saldittet al.22 that, for
high-energy deposition processes such as sputtering at low
pressures, the case ofn52 will more likely correspond to
the sputter and redeposition of adatoms via atomic bombard-
ment of the surface. Tong and Williams19 have suggested
that by using a negative value ofn the first term in Eq.~36!
can also describe roughening of the surface due to three-
dimensional island growth. In this casen51 corresponds to
island growth via deposition onto the surfaces of existing
islands, andn53 represents the growth of islands via the
diffusion of atoms on the surface.

Taking the Fourier transform of Eq.~36! readily yields a
solution for the PSD of the growing surface:15

PSD~ f!5V
12exp@22nu2p f unt#

2nu2p f un . ~37!

Here V is the volume of a constituent element of the film
~e.g., atom, molecule, cluster!. It is surprising to find that the
scaling and kinetic continuum models predict essentially the
same form for the PSD of the surface! A comparison of Eqs.
~35! and~37! shows that the scaling parameters are related to
the exponentn according to

a5~n22!/2, b5~n22!/2n. ~38!

The kinetic model~36! predicts a characteristic shape for
the PSD of a single layer grown on a smooth substrate given
by Eq. ~37!. An example is shown in Fig. 2 for several dif-
ferent film thicknesses and reasonable parameter values of
V50.02 nm3, n52.5 nm3, andn54. The PSD is flat at low
frequencies and rolls over to asymptotically approach a
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power law dependence of; f 2n at high frequencies. The
transition point moves to lower frequency as the film thick-
ness increases. In the limit of infinite film thickness the PSD
of the surface becomes a pure power law, which is the sig-
nature of a self-affine~fractal! surface, and explains in part
the similarity between the kinetic continuum and scaling
models. The behavior of the PSDs shown in Fig. 2 has a
straightforward physical explanation. The low frequency
~large wavelength! components of roughness have a flat re-
sponse characteristic of white noise, which is simply the shot
noise of the random deposition process. At high frequency
~small wavelength! the PSD rolls off due to local relaxation
of the growing surface. In particular, surface features having
a size less than (nt)1/n are unstable and are damped out.

It should be emphasized that Eq.~36! is the simplest
possible kinetic model for roughening. It is a linear and local
description of the roughening process, and is expected to be
valid only when the surface heights and slopes are small. The
first nonlinear correction, corresponding to a term;(¹H)2,
has been considered by Kardaret al.23 Physically, this term
represents growth along the local normal to the film surface
as might be expected under the conditions of isotropic depo-
sition characteristic of, for example, chemical vapor deposi-
tion. The assumption that the roughening is a local process
breaks down when the distribution of deposition angles is
large and the surface slopes are large. In this case the depo-
sition at a point on the surface depends on the topology of
the surrounding surface due to shadowing effects. Karunasiri
et al.24 and later Tanget al.25 have proposed growth models
that explicitly include a nonlocal growth mechanism~shad-
owing!. It is found that when the nonlinear and nonlocal
effects dominate the roughening process, the film surface
rapidly develops discontinuities in the form of cusps and
columns. These features have often been observed in thin
film morphology, particularly for films grown using low-
energy deposition processes.26–28 In contrast, the high-
performance multilayer optical coatings which we are con-
sidering in this paper have small roughness by design. This is
achieved by using a high-energy growth process, such as
sputtering at low pressure, that incorporates a significant re-

laxation mechanism~large n! to compensate the natural
roughening due to the stochastic nature of the deposition. By
balancing the roughening and smoothing mechanisms, the
roughness is never allowed to become large enough to trig-
ger the nonlinear and nonlocal growth modes. We believe
that under these conditions the continuum model of Eq.~36!
is an appropriate description of the thin film growth. This
view is supported by recent experimental studies7 of rough-
ness in multilayer films.

Thus far we have considered the growth of a single
layer. We next extend the kinetic model to describe the evo-
lution of interfacial roughness in a multilayer film. This is
achieved by considering the growth of a multilayer film to be
a sequence of single layers, each growing upon a ‘‘sub-
strate’’ corresponding to the underlying layer. Then the
roughness of an interface naturally separates into two com-
ponents:~1! the ‘‘intrinsic’’ roughness due to the growth of
the i th layer, as would occur if the underlying layer was
perfectly smooth, and~2! the ‘‘extrinsic’’ roughness due to
the replication of the roughness of the underlying layer. To
represent the growth of such a sequence of layers, we recast
Eq. ~36! as a finite difference equation15

hi~ f!5g i~ f!1ai~ f!hi 21~ f!, ~39!

wherehi(f) is the frequency spectrum of the roughness of
the i th interface,Hi(r ), and

ai~ f!5exp@2n i u2p f unt i #, ~40!

is the replication factor that describes the fraction of the fre-
quency componentf in the (i 21)th interface that is repli-
cated in thei th interface. The first and second terms on the
right-hand side of Eq.~39! correspond to the intrinsic and
extrinsic roughness components of thei th interface, respec-
tively.

The growth theory is typically applied to measurements
of surface or interfacial roughness using a statistical descrip-
tion of the roughness in terms of the power spectral density

PSDi~ f!5
1

A
^hi~ f!hi* ~ f!&, ~41!

or the autocorrelation function

Ci~r !5^Hi~x!Hi~x1r !&, ~42!

where the expectation value denotes an average over an en-
semble of interface structures having statistically equivalent
random roughness. These quantities are related by a simple
Fourier transform, and in principal are equivalent descrip-
tions of the structure of the rough surface. In practice, how-
ever, all measurements of surface roughness are limited to a
finite instrumental bandwidth, and the PSD has the distinct
advantage of being accurately measurable within the instru-
mental bandwidth.29 We consider the case where the
multilayer film is grown by alternately depositingN pairs of
high-index (H) and low-index (L) layers onto a substrate
(S) having an isotropic surface roughness described by a
power spectral density PSDsub. The PSD of the top surface of
the multilayer film is found by successive iteration of Eq.
~39! to be

FIG. 2. The theoretical PSD of the top surface of a film grown on a perfectly
smooth substrate at different values of the film thickness. The growth pa-
rameters areV50.02 nm3, n52.5 nm3, andn54.
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PSDN5
12~aH

2 aL
2!N

12aH
2 aL

2 ~PSDint
L 1aL

2PSDint
H !

1~aH
2 aL

2!NPSDsub, ~43!

whereaH,L is the replication factor of the high- or low-index
layer and

PSDint
i ~ f !5

1

A
^g ig i* &5V i

12exp@22n i u2p f unt i #

2n i u2p f un ,

~44!

is the PSD of the intrinsic roughness of the layer. Here we
have used the fact that the intrinsic roughness of each inter-
face is statistically independent so that^g ig j* &50 when i
Þ j .

Our measurements of the roughness of high-performance
multilayer optical coatings are generally in good agreement
with the predictions of Eqs.~43! and ~44!. As an example,
we show in Figs. 3 and 4 results of surface metrology mea-
surements on a superpolished fused silica substrate and the
top surface of a Mo–Si multilayer film grown on the sub-
strate, which we will refer to as our ‘‘canonical’’ multilayer
sample throughout this paper. The multilayer film was de-
posited using magnetron sputter deposition in an Ar plasma
of 1.75 mTorr pressure as described in detail elsewhere.30

The film consisted of 40.5 layer pairs with individual layer
thicknesses of 2.1 nm for Mo and 4.75 nm for Si. The first
and last layers deposited were Si. Images of the surface
height were measured using a Digital Instruments Dimension
5000 atomic force microscope operating in the tapping
mode. The lateral resolution was;10 nm, due to the width
of the tip of the single-crystal Si probe, resulting in a band-
width limit at high frequency of;0.1 nm21. The height
resolution of the microscope was;0.01 nm and the surface
area sampled was a square region of width 5mm. To obtain
images of these ultrasmooth surfaces it was necessary to op-
erate the microscope inside an environmental chamber that
significantly reduced noise from vibrations and air currents.
The surface height distributions for the two surfaces are
shown in Fig. 3. The data are seen to be well described by

Gaussian distributions. The PSDs of the surfaces were ob-
tained directly from the surface images through Fourier
transform. The two-dimensional PSDs were found to be iso-
tropic and were averaged over all directions to generate the
radial PSDs shown in Fig. 4.

A complete description of the interfacial roughness in
the multilayer film can be inferred by fitting the data shown
in Fig. 4 to the model of Eqs.~43! and ~44!. To limit the
degrees of freedom of the fitting process, we place the fol-
lowing constraints on the values of the growth parameters:

~1! We set the growth unit volumeV for Si to the atomic
volume of 0.020 nm3. The Si layers in the multilayer film are
deposited in an amorphous phase. The choice of the atomic
volume assumes that the final position of the adatoms on the
amorphous growth surface are random and uncorrelated.

~2! We set the relaxation parameters for the Mo and Si
layers to be equal,n5nSi5nMo . This is an arbitrary and
unrealistic constraint, which is likely to produce a result that
is a weighted average of the true values.

The solid line in Fig. 4 represents the best fit using values of
n52.5 nm3, VMo50.050 nm3, and n54 for the remaining
free parameters. We note that the growth unit volume for Mo
is approximately three times the atomic volume. This sug-
gests that the final position of the atoms on the growth sur-
face are partially correlated. Indeed, the Mo layers in this
film have a polycrystalline bcc phase with a strong^110&
texture,31 and the ordering due to crystal growth is expected
to increase the size of the growth unit. Within the context of
the growth theory, the growth parametersV, n, andn, along
with the PSD of the substrate, provide a comprehensive de-
scription of the roughness of the multilayer film. From these
parameters we can determine the PSD of any interface in the
multilayer. For example, the dotted lines in Fig. 4 show the
PSDs calculated for the interfaces corresponding to the tenth
and twentieth bilayer periods as measured from the substrate.

FIG. 3. Surface height distributions of a fused silica substrate and a Mo–Si
multilayer film grown on the substrate, measured using atomic force micros-
copy. The structure of the multilayer film is@Mo~2.1 nm!/Si~4.75 nm!#
340. The solid lines are Gaussian fits to the data.

FIG. 4. The PSDs of a fused silica substrate and the top surface of a Mo–Si
multilayer film grown on the substrate, measured using atomic force micros-
copy. The PSD of the substrate is empirically described by PSDSUB( f )
5(1.431026/ f 4.2)@12exp(27.53104f 3.6)# in nm4 ~dashed line!. The solid
line is a best fit to the PSD of the top surface of the multilayer film using the
growth model discussed. The dotted lines are the calculated PSDs for the
interfaces at the 10th and 20th bilayer period as measured from the
substrate.
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The value ofn54 indicates that the dominant relaxation
mechanism in these Mo–Si multilayer films grown by sput-
ter deposition is surface diffusion. The importance of surface
diffusion in Mo–Si multilayer growth has been previously
noted32 in a study where films were grown using electron
beam evaporation onto substrates at elevated temperatures. It
was found that the roughness of the interfaces decreased dra-
matically as the temperature of the growing film was in-
creased, up to a point where interdiffusion caused broaden-
ing of the interfaces. The decrease in roughness was
accompanied by an increase in the size and texture of the
crystallites in the polycrystalline Mo layers. Smooth and
abrupt interfaces, comparable to the best sputtered multilayer
films, were obtained in a rather narrow temperature range
around 525 K. This result was interpreted to indicate that the
formation of smooth interfaces required sufficient energy at
the growth surface to allow adequate surface mobility with-
out activating bulk diffusion. A similar result ofn54 has
been found for sputtered Ni0.81Fe0.19–Au multilayer films.9

In contrast, Saldittet al.22 have observedn52 behavior in
sputtered W–Si multilayer films, indicating that sputtering
and redeposition might be another important smoothing
mechanism for specific material systems. It is interesting to
note that in these experiments both the W and Si layers were
amorphous, whereas in the case of the Mo–Si and
Ni0.81Fe0.19–Au multilayer films at least one of the layers
was polycrystalline. Hence it is possible that surface diffu-
sion is the dominant smoothing mechanism when the major
source of interfacial roughness is polycrystalline faceting.

For the case of relaxation via surface diffusion, it is
shown in Appendix B that the parametern can be related to
other standard growth parameters according to

n5
jDV0

4/3

r DkT
. ~45!

Here j is the surface energy,D is the surface diffusion co-
efficient,V0 is the atomic volume,r D is the deposition rate,
k is Boltzmann’s constant, andT is the local temperature of
the growth surface. Based on our measurement of the relax-
ation parametern we can infer from Eq.~45! an estimate of
the surface diffusion coefficient for the Mo–Si multilayer
film growth. Using values33 for Mo of j52250 erg/cm2,
V050.016 nm3, r D50.2 nm/s, andT5525 K we obtain a
surface diffusion coefficient ofD54310215 cm2/s. Then
the range of an adatom on the surface before it is ‘‘frozen’’
by the deposition of the next monolayer would be approxi-
mately given byADt50.9 nm. This suggests that the ada-
tom has the opportunity to relax to a energetically favorable
position within a radius of several atomic sites. Monte Carlo
simulations34 of thin film growth have indicated that such a
relaxation mechanism is sufficient to produce low defect
films of near bulk density.

It is evident in Figs. 3 and 4 that the roughness of the top
surface of the multilayer film is significantly greater than the
substrate. The kinetic growth theory predicts three distinct
regimes:

~1! At low spatial frequencies~less than;1024 nm21 in
Fig. 4! the interfacial roughness replicates the substrate
roughness and is purely conformal.

~2! There is an intermediate frequency range
~1024– 1021 nm21 in Fig. 4! in which the top surface of
the multilayer film is significantly rougher than the sub-
strate due to the additional intrinsic roughness associated
with the growth of the film.

~3! At high frequencies~greater than;1021 nm21 in Fig. 4!
the multilayer film growth process has a smoothing ef-
fect and can actually result in a damping of the rough-
ness of the substrate.

In general, the transition points between these frequency re-
gimes are not unique; they can vary with both the multilayer
growth parameters and the PSD of the substrate.

The increase in the multilayer film roughness in the fre-
quency range of 1024– 1021 nm21 is a particular concern for
soft x-ray imaging, as it represents in some sense the limit of
smoothness that can be obtained for a multilayer-coated sur-
face. For 13 nm radiation near normal incidence these fre-
quency components will produce scattering at angles ranging
from ;0.1 to 90 degrees. The integrated power scattered
over this angular range is proportional to the variance of the
surface height,s2, which is the second moment of the sur-
face height distribution shown in Fig. 3, and can also be
obtained from the PSD according to

s252pE
f min

f max

PSD~ f ! f d f . ~46!

The rms roughness,s, determined by integrating the PSD
over the frequency range of 1024– 1021 nm21, is plotted in
Fig. 5 for all of the interfaces in the multilayer film. The rms
roughness is observed to double throughout the thickness of
the film, increasing from a value ofs50.09 nm at the sub-
strate tos50.18 nm at the top surface. From this example it
is evident that the intrinsic roughness associated with the
growth of the multilayer film can be a significant part of the

FIG. 5. The variation of the rms roughness of the interfaces within the
Mo–Si multilayer film, obtained by integrating the PSDs over the frequency
range of 1024– 1021 nm21.
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total roughness, and should be included to obtain an accurate
description of nonspecular scattering from multilayer-coated
optical surfaces.

VII. THEORY OF NONSPECULAR SCATTERING FROM
A MULTILAYER FILM

The last decade has seen considerable progress towards
developing a rigorous theory of the scattering of x rays from
multilayer films. The existing theoretical framework exploits
the fact that the interaction between x rays and matter is
typically weak, and treats the nonspecular scattering from
interfacial roughness using first- or at most second-order per-
turbation theory. Consequently the theory is limited to the
case where the scattered power is small compared to the
incident power. Within the context of perturbation theory
there are basically two different formulations, each valid in a
different regime. Stearns3 has presented a theory of scatter-
ing from multilayer structures based upon previous work16

describing the scattering from a single interface within the
Born approximation. In this treatment, the incident field at
each interface consists of plane waves incoming from both
sides, corresponding to the exact eigenstate of the ideal
multilayer structure~no roughness!. The rough interface is
considered to be the perturbation, and a solution of Max-
well’s equations is found for the scattered vector field, which
includes the polarization dependence. The total scattered
field, consisting of outgoing plane waves from each of the
interfaces, is treated kinematically. The Born approximation
neglects the refraction of the incident field, which becomes
important near the critical angle for total internal reflection,
and hence this scattering theory is only valid for angles
greater than the critical angle~as measured from the surface!.

In an alternate approach, Holyet al.5 have developed a
scattering theory using the distorted-wave Born approxima-
tion ~DWBA!, based upon the description of scattering from
a single rough surface presented by Sinhaet al.35 The theory
has been extended to second order by de Boer.36 In this
approach the incident field is an eigenstate of the ideal
multilayer structure~in the absence of roughness, although
the interfaces need not be abrupt36! having a wave vectork0 ,
including both the incoming and outgoing waves, and the
scattered field is a time-reversed version of an incident field
having a different wave vectork. The perturbation is just the
change of the multilayer structure upon introducing the
roughness. At first glance the DWBA formulation appears to
be unphysical since the scattered field includes incoming
plane waves. This paradox is resolved by realizing that the
final state only needs to be a reasonable approximation of the
scattered field within the interaction region, that is, the re-
gions where the roughness exists. When the reflectivity is
large, such as near the critical angle, the ‘‘outgoing’’ scat-
tered plane wave will experience multiple reflections within
the interaction region, thereby creating a strong ‘‘incoming’’
plane wave component, and this state is well-represented by
the DBWA final state. Hence this theory is valid at angles
near the critical angle, but is generally not applicable at
larger angles. Another limitation of the DBWA approach is
that it is based on the Helmholtz equation for the scalar field

and neglects polarization effects, which is strictly only valid
at grazing incidence.

An important practical issue in the formulation of the
scattering theory is the way in which the roughness of the
interfaces is incorporated. It is easily shown35 that the scat-
tering from a single surface is proportional to the Fourier
transform of the quantity exp@qz

2C(r )/2#. Consequently, there
has been a tendency to describe and model surface roughness
in terms of the autocorrelation function. However, in the
limit where qz

2s2!1, which we call the ‘‘small roughness
approximation,’’ the exponential can be expanded to obtain
the well-known result that the scattering cross section is pro-
portional to the PSD of the surface roughness. The formula-
tion of the scattering theory in terms of the PSD has several
distinct advantages:

~1! The PSD is directly measurable by instruments having
finite bandwidths, as mentioned previously.

~2! Knowledge of the PSD within a limited bandwidth is
sufficient to model scattering for a given angular range.
In contrast, the complete autocorrelation function is re-
quired to describe the scattering within any angular
range.

~3! The scattering problem can be inverted to determine the
PSD of a surface from the angular distribution of the
scattering.

In the case of scattering from multilayer films the situa-
tion gets more complicated; the scattering is proportional to a
sum of Fourier transforms of exponential terms containing
cross-correlation functions between every pair of interfaces.
Specific models of the correlation functions are typically in-
troduced in anad hocfashion. In contrast, applying the small
roughness approximation~when valid! provides the impor-
tant simplification of linearizing the dependence of the scat-
tering amplitude on the interface roughnessh(f). It then be-
comes possible to directly integrate into the scattering theory
the linear growth model described in the previous section.

In this paper we are interested in modeling the scattering
from high-performance multilayer optical coatings in con-
figurations near normal incidence. Under these conditions it
is appropriate to apply the scattering theory of Stearns based
on the Born approximation and linearized using the small
roughness approximation. It is necessary, however, to extend
the previous theory to account for two effects which are im-
portant in modeling the performance of realistic imaging sys-
tems. These new developments are:

~1! The scattered field is treated dynamically, that is, we
take into account the multiple specular reflection of the scat-
tered field within the multilayer structure. The dynamical
treatment of the scattered field is important when the scatter-
ing angle is within a Bragg resonance condition, as will gen-
erally be the case for small angle scattering in an imaging
system.

~2! The description of the unperturbed multilayer struc-
ture ~without roughness! is allowed to included interfacial
diffuseness. The diffuseness, corresponding to a broadened
composition profile across the interface, arises from interdif-
fusion and reaction at the layer boundaries. For example,
high performance Mo–Si multilayer coatings exhibit inter-
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diffusion zones of;1 nm at the Mo-on-Si interface and
;0.5 nm at the Si-on-Mo interface.37 The relative effects of
roughness and diffuseness on x-ray scattering are discussed
in Ref. 16. In general, diffuseness of the interfaces reduces
the specular reflectivity of each interface, and thereby redis-
tributes the specular field within the multilayer structure. In
this way diffuseness can have an important effect on the
nonspecular scattering without producing any scatteringper
se.

We begin by considering a multilayer film having a se-
ries of rough and diffuse interfaces as shown schematically
in Fig. 6. Let the incident field be a plane wave with
wavevectorkn̂ and polarizationê, corresponding to eitherS
or P type. Multiple specular reflection within the multilayer
film produces counterpropagating plane waves in each layer
and refraction modifies the wave vectors and polarization
vectors. The wave vectors in thei th layer, ki n̂i

6 , for the
fields propagating towards the top of the film~1! and to-
wards the substrate~2! are related to the incident field ac-
cording to

kiniX
6 5knX

kiniY
6 5knY ~47!

kiniZ
6 56kAe i2nX

22nY
2.

Here the wavenumberki5e i
1/2k becomes a complex quantity

for the case of an absorbing medium. The polarization vec-
tors within thei th layer are given by

S type: eiX
6 5

niY

A~niX!21~niY!2
,

eiY
6 52

niX

A~niX!21~niY!2
, eiZ

6 50

P type: eiX
6 5

niXniZ
1

A~niX!21~niY!2
,

eiY
6 5

niYniZ
1

A~niX!21~niY!2
, eiZ

6 57A~niX!21~niY!2 . ~48!

We define interfacei to be located between layersi and j
5 i 11. Then there are two plane waves,Ej

2êj
2 exp(ikjn̂j

2

•x) and Ei
1êi

1 exp(ikin̂i
1
•x), incident on thei th interface

from above and below, respectively. Within the spirit of per-
turbation theory, the incident plane waves correspond to the
specular field in the multilayer film in the absence of rough-
ness.

Let us consider the field scattered by the multilayer film
into directionm̂ with polarizationâ. As before, the scattered
field undergoes multiple specular reflections within the film
which produces counterpropagating waves in each layer hav-
ing wave vectorskim̂i

6 and polarizationsâi
6 . Following the

formalism of Ref. 3, the amplitude of the field scattered by
the i th interface towards the top of the multilayer film is
given by

r i~m̂j
1 ,â j

1!5
D j i kj

3

8p2e jmjZ
1 S Ej

2~ â j
1
•êj

2!
gi~qr !

qrZ

1Ei
1~ â j

1
•êi

1!
g̃i~qr8!

qrZ8
D . ~49!

Here qr5kjm̂j
12kj n̂j

2 and qr85kjm̂j
12ki n̂i

1 are the mo-
mentum transfer vectors,D j i 5e j2e i is the change in the
dielectric function across the interface,gi(q) is the Fourier
transform of the normalized gradient of the dielectric func-
tion given by

gi~X![
1

D

]e~X!

]Z
, ~50!

and g̃i(qX ,qY ,qZ)5gi(qX ,qY ,2qZ). Since we are treating
the scattered field dynamically, we must also include the
scattering that is initially directed towards the substrate, as
this radiation can be reflected back out of the film by under-
lying interfaces. The field scattered by thei th interface to-
wards the substrate is given by

t i~m̂i
2 ,âi

2!5
D i j ki

3

8p2e imiZ
2 S Ei

1~ âi
2
•êi

1!
g̃i~qt!

qtZ

2Ej
2~ âi

2
•êj

2!
gi~qt8!

qtZ8
D , ~51!

whereqt5kim̂i
22ki n̂i

1 andqt85kim̂i
22kj n̂j

2 .
All of the information about the structure of the interface

is contained in the quantityg, which can be thought of as a
structure factor for the interface in the terms of x-ray diffrac-
tion theory. We choose to describe the interface using a
model

g~X!5WD@Z2H~X,Y!#. ~52!

Here the functionWD(Z) represents the gradient of the di-
electric function across the interface due to the diffuseness;
the position of this diffuse interface is modulated by the

FIG. 6. Schematic diagram of a multilayer film having rough and diffuse
interfaces. The inset shows the scattering process at thei th interface. The
specular fieldsEi and Ej are incident on either side of the interface. The
nonspecular scattering into mode (m̂,â) consists of two parts, the fieldr i

that is scattered towards the top of the film and the fieldt i that is scattered
towards the substrate.
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roughness functionH(X,Y). The key underlying assumption
of this model is that the diffuseness is constant over the
interface. We would expect this model to be valid when the
physical mechanisms causing the roughness and diffuseness
are essentially independent. This would be the case, for ex-
ample, when the interface roughness is predominantly due to
the replication of roughness of the underlying layer and the
diffuseness is due to the local interdiffusion or reaction of
the layers. One example where our model would be inappro-
priate is the case where the interface roughness is produced
by nonuniform interdiffusion or reaction at the layer bound-
ary.

Several important examples of a diffuse interface are
listed in Table I, along with the gradient functionWD(Z) and
its Fourier transformwD(qZ). In case~a! we show an ideal
interface, where the dielectric function changes abruptly be-
tween layers. In this case the gradient is a delta function with
a Fourier transform of unity. Classical interdiffusion is rep-
resented by case~b!, where the dielectric function across the
interface is described by an error function, and both the gra-
dient and its Fourier transform are Gaussian. When a com-
pound is formed at the interface, and the growth of the in-
terlayer is rate limited by diffusion through the interlayer,
then the dielectric function should have a linear profile as
shown in case~c!. However, if the growth of the interlayer is
limited by the reaction rate at the interlayer boundary, then
the dielectric function has a step profile as shown in case~d!.
In Table I we normalize the width of the different interface

models to the second moment of the gradient function,sD ,
defined as

sD
2 [E Z2WD~Z!dZ. ~53!

Choosing the appropriate model requires a detailed knowl-
edge of the microstructure of the interface. This information
is accessible from high-resolution imaging techniques such
as transmission electron microscopy of cross-section
specimens.31 Advances in new scanning techniques such as
high-angle annular dark-field microscopy38 make it possible
to map the composition gradient at interfaces with nanometer
resolution.

Taking the Fourier transform of Eq.~52! we obtain for
the nonspecular case (qX ,qYÞ0):

g~q!5wD~qZ!E exp~2 iqXX!exp~2 iqYY!

3exp@2 iqZH~X,Y!#dXdY

>2 iqZh~qX ,qY!wD~qZ! ~54!

where we have used the small roughness approximation~e!
to expand the exponential. Substituting into Eqs.~49! and
~51! yields

r i~m̂j
1 ,â j

1!52
iD j i kj

3hi~qX ,qY!

8p2e jmjZ
1 @Ej

2~ â j
1
•êj

2!wD~qrZ!

1Ei
1~ â j

1
•êi

1!wD~2qrZ8 !#

t i~m̂i
2 ,âi

2!5
iD i j ki

3hi~qX ,qY!

8p2e imiZ
2 @Ei

1~ âi
2
•êi

1!wD~2qtZ!

1Ej
2~ âi

2
•êj

2!wD~qtZ8 !#. ~55!

The power per unit solid angle scattered by all of the
interfaces in the multilayer film is

dP~m̂,â!

dV
5

4p2mZ
2

k2AunZu U(i
~f i

r r i1f i
tt i !U2

, ~56!

whereA is the area of the film illuminated by the incident
field. The propagation factorsf i

r and f i
t account for the

phase shift and attenuation of the field scattered from thei th
interface as it propagates to the top surface of the multilayer
film. We rearrange Eq.~56! to show explicitly the depen-
dence on the interface structure:

dP~m̂,â!

dV
5

mZ
2

16p2k2AunZu (
ik

~G iGk* hihk* !, ~57!

where
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r

e jmjZ
1 @Ej

2~ â j
1
•êj

2!wD~qrZ!

1Ei
1~ â j

1
•êi

1!wD~2qrZ8 !#

2
D j i ki

3f i
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e imiZ
1 @Ei

1~ âi
2
•êi

1!wD~2qtZ!

1Ej
2~ âi

2
•êj

2!wD~qtZ8 !#. ~58!

TABLE I. Several examples of the gradient functionWD(Z) for a diffuse
interface and its Fourier transformwD(qZ).

Description
of

interface WD(Z) wD(qZ)

d(Z) 1

1

A2psD
2

exp~2Z2/2sD
2 ! exp(2sD

2qZ
2/2)

H0, uZu.)sD

1

2)sD

, uZu,3sD

sin~)sDqZ!

)sDqZ

1
2 @d~Z1sD!1d~Z2sD!# cos(sDqZ)
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The next step is to incorporate the multilayer growth
model to describe the roughness of the interfaces, including
the correlation of roughness between interfaces. In particular,
iteration of Eq.~39! shows that the roughnesshi of the i th
interface is a superposition of the intrinsic roughnessg i of
each of the underlying layers~and the substrate!. The rough-
nesshi can be written as

hi5 (
n50

i

cingn . ~59!

The factorcin represents the amount of intrinsic roughness of
thenth layer that propagates to thei th interface. It is explic-
itly related to the replication factors,am , of the intervening
interfaces according to

cin5
Pm50

i am

Pm50
n am

. ~60!

Assuming that the intrinsic roughnessg i of each interface is
statistically independent, we have

hihk* ——→
for k, i

(
n50

k

cinckngngn* 5A(
n50

k

cincknPSDint
n .

~61!

Substituting into Eq.~57! yields

dP~m̂,â!

dV
5

mZ
2

16p2k2unZu

3(
i 50

N F S (
n50

i

cin
2 PSDint

n DG iG i*

1 (
k50

i 21 S (
n50

k

cincknPSDint
n D ~G iGk* 1GkG i* !G .

~62!

This expression is the central result of the multilayer scatter-
ing theory. The angular distribution of the scattering power
is directly related to the detailed structure of the interfaces
through the PSDint of the intrinsic roughness~including the
substrate! and the factorscin which describe the replication
of roughness between interfaces. These quantities are in turn
defined, within the context of our growth model, by the
growth parametersV, n, andn, which are characteristic of
the film media and deposition conditions. It is evident in Eq.
~62! that the scattering separates naturally into two terms.
The first term corresponds to the uncorrelated scattering, and
is simply the sum of the intensities scattered by each inter-
face independently. The second term corresponds to the cor-
related scattering. This contribution represents the interfer-
ence of the radiation fields scattered by interfaces that are
correlated due to the replication of roughness from layer to
layer.

We note that Eq.~62! is only applicable under the con-
ditions for which the multilayer growth model is expected to
be valid, that is, when the roughness is sufficiently small so
that the growth kinetics are local and linear. This limit is
consistent with the ‘‘small roughness approximation’’~e!
that was invoked previously, and is expected to be satisfied

by high performance multilayer optical coatings, where the
roughness is minimized by design. Equation~62! should not
be valid when the roughness is large and the film growth is
dominated by nonlinear and nonlocal effects such as shad-
owing and columnar growth.

Although the formulation of the scattering theory is
complete, its implementation requires a method of calculat-
ing the incident field amplitudes,Ei

1 andEj
2 , and the propa-

gation factorsf i
r and f i

t . These quantities are to be deter-
mined in the absence of roughness, since we are considering
the scattering process as a first-order perturbation~the Born
approximation!. This is accomplished using a well-known
matrix approach to analyze the propagation of the specular
fields within the multilayer film. The matrix method is de-
scribed in detail in Appendix C.

The description of the image formation in the presence
of scattering~Eq. @29#! also requires the calculation of the
Strehl factor,S. This factor accounts for the total decrease in
the specular intensity due to scattering and, for the case of a
multilayer film, includes losses due to the absorption of the
scattered field within the film. In practice, the accurate cal-
culation of the Strehl factor is problematic when there is a
strong reflected field. This is because the scattering from the
roughness significantly alters the configuration of the inci-
dent specular field. In particular, the roughness redistributes
the power between the reflected and transmitted specular
fields, which generates loss through increased absorption.
This is a purely dynamical effect, requiring second-order
perturbation theory to correctly describe the lowest-order
change in the specular field due to the interfacial roughness.
Unfortunately, a general second-order theory of scattering
from rough multilayer structures has not yet been developed.
An alternative approach for estimating the Strehl factor,
based on anad hoctreatment of these interference effects, is
presented at the end of this section.

As an example of the application of the multilayer scat-
tering theory, we have modeled the specular reflectivity and
nonspecular scattering from the canonical Mo–Si multilayer
film described in Sec. VI, and we compare these results to
experimental measurements. The x-ray scattering measure-
ments were performed using synchrotron radiation~S polar-
ization! provided by Beamline 6.3.2 of the Advanced Light
Source at Lawrence Berkeley Laboratory. A detailed descrip-
tion of the beamline and reflectometer is presented
elsewhere.39 A unique feature of this experimental facility,
which is particularly important for performing scattering
measurements on high-quality multilayer films, is the com-
bination of high photon flux~;1012 photons/s in 0.1% band-
width! and excellent collimation of the incident beam. An
example of the profile of the incident beam is shown in Fig.
7. At angles greater than four degrees the wings of the inci-
dent beam are suppressed by over nine orders of magnitude,
making it possible to measure very low levels of scattering.

The measured specular reflectivity of the Mo–Si
multilayer as a function of x-ray wavelength is shown in Fig.
8 for angles of incidence ranging from 5 to 20 degrees as
measured from the film normal. The reflectivity was modeled
using the matrix method described in Appendix C, with op-
tical constants provided by the CXRO World Wide Web
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site.40 Modeling the position and width of the Bragg peaks
provides an accurate and unique determination of the indi-
vidual layer thicknesses. The interfaces have been modeled
as asymmetric zones of intermixing having linear composi-
tion profiles, based upon previous detailed studies of the mi-
crostructure of similar Mo–Si multilayer films.41 The width,
sD , of these zones is 0.3 nm for the Mo-on-Si interfaces and
0.15 nm for the Si-on-Mo interfaces. The best fits are shown
as the solid lines in Fig. 8, and correspond to a layer struc-
ture of @Mo~2.1 nm!/Si~4.75 nm!#340. The amplitude of the
reflectivity ~i.e., the Strehl factor! is not accurately modeled
by the matrix method, as discussed above, and has been
treated as a free fitting parameter.

The nonspecular scattering measured at normal inci-
dence (u50 deg) and at wavelengths of 12.8 and 13.2 nm is
shown in Fig. 9 as a function of the scattering angle. We also
show the calculatedspecular reflectivity for comparison

~dotted lines!. The measurements correspond to the scattered
power per unit solid angle, normalized to the incident power.
These data were obtained using a channeltron detector oper-
ating in pulse counting mode. The solid angle subtended by
the detector was defined by a 2.0-mm-diameter pinhole po-
sitioned 225 mm from the multilayer sample. The scattering
was measured by scanning the detector in the plane of inci-
dence while keeping the incident beam fixed. The scattering
could be measured to within approximately 4 degrees of the
angle of specular reflection, at which point the background
level overwhelmed the scattering signal.

The angular dependence of the nonspecular scattering
exhibits several characteristic features. In both cases there is
a broad peak that mimics the specular Bragg peak. At 12.8
nm @Fig. 9~a!# the scattering peak is shifted to a larger angle
than the specular Bragg peak. At 13.4 nm@Fig. 9~b!# the
scattering and specular peaks appear to coincide. Further-
more, the nonspecular scattering exhibits a small oscillation,
more easily observed in the 13.4 nm data@Fig. 9~b!#, which
dies out at larger scattering angles.

The origin of the broad peak in the nonspecular scatter-
ing is the same as the Bragg peak in specular reflection: the
interference of the fields scattered from the different inter-
faces. This phenomenon has been called ‘‘quasi-Bragg
scattering’’3 or ‘‘resonant diffuse scattering’’5 in the litera-
ture. We will refer to it as resonant nonspecular scattering
~RNS! in this paper. Two conditions are required to observe
a peak in RNS. First there must be correlation between the
roughness of the interfaces in the multilayer. Second, the

FIG. 7. The measured angular profile of the incident beam for the experi-
mental configuration used to obtain the scattering data. The intensity of the
incident beam is reduced by nine orders of magnitude within four degrees of
the center of the beam. The high spatial purity is achieved using a combi-
nation of focusing optics and apertures.

FIG. 8. Measured specular reflectivity of the canonical Mo–Si multilayer
film as a function of soft x-ray wavelength for several different angles of
incidence. The peak reflectivity varies from 66% at five degrees and 13.4
nm to 70% at 20 degrees and 12.6 nm~just above the SiL edge!. The solid
lines are best fits using a multilayer structure of@Mo~2.1 nm!/Si~4.75 nm!#
340.

FIG. 9. Nonspecular scattering measured from the canonical Mo–Si
multilayer film for normal incidence radiation at a wavelength of~a! 12.8
nm and~b! 13.4 nm. The dotted lines are the calculated specular reflectivity
of the film as a function of incident angle.
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fields scattered from the different interfaces must add in
phase constructively. These requirements are best illustrated
using an Ewald construction in reciprocal space, as shown in
Fig. 10. Here the Bragg reflection atqZ52k0 is spread out
into a sheet parallel to theqX2qY plane due to the correlated
roughness of the multilayer interfaces, which produces co-
herent scattering with finite momentum transfer in theX-Y
plane. Figure 10~a! shows the configuration for scattering at
normal incidence with an x-ray momentumk.k0 @as is the
case in Fig. 9~a!#. The allowed~elastic! values of momentum
transfer are constrained to be on the surface of the Ewald
sphere. The peak in the RNS,uRNS, is given by the angle at
which the scattering vectorkm̂ intersects the Bragg sheet.
The RNS peak generally occurs at a larger angle than the
specular Bragg peak. This can be seen in Fig. 10~b!, where
we show an Ewald construction for specular reflection from
the multilayer at the same value of x-ray momentumk. Here
the angle of incidence and reflection isuB . Inspection of the
two diagrams in Fig. 10 shows that the relationship between
the angular positions of the RNS and Bragg peaks is

2k cosuB5k1k cosuRNS, ~63!

which reduces touRNS>&uB in the limit of small angles.
This predicted behavior is consistent with the data of Fig.
9~a!, where the RNS and Bragg peaks are at;25 and 18

degrees, respectively. The two peaks only coincide when the
wavelength and angle of the incident field satisfy the condi-
tion for Bragg reflection (k5k0), as is the case in Fig. 9~b!.

An important consequence of the relationship between
the position of the RNS and Bragg peaks is that the total
integrated scattering increases significantly ask exceedsk0 .
The total integrated scattering~TIS! corresponds to the total
power nonspecularly scattered into all angles for a given in-
cident angle and wavelength. The TIS obtained by integrat-
ing the scattering shown in Fig. 9 is found to be 0.98% and
0.30% at the wavelengths of 12.8 and 13.4 nm, respectively.
The increase in TIS at the shorter wavelength~larger k! is
due to a significant increase in the transmission of the
multilayer film as the RNS peak shifts away from the specu-
lar Bragg peak. Within the Bragg peak, scattered radiation is
trapped inside the film in a standing wave similar to the
specular field, which reflects much of the radiation back into
the film. However, when the RNS is outside of the Bragg
peak, as occurs at shorter wavelengths@Fig. 9~a!#. The radia-
tion scattered at interfaces within the film propagates to the
top surface with little loss. This purely dynamical effect
causes the extinction of the RNS to vary dramatically with
scattering angle.

In Fig. 9 the RNS exhibits a small oscillation having the
same period as the high frequency oscillation of the specular
reflectivity ~sometimes called ‘‘Kiessig fringes’’!. The oscil-
lation in the RNS has the same origin as that in the specular
reflectivity, namely the interference of the radiation scattered
from the front and back surfaces of the multilayer film. This
can occur in scattering whenever there is a correlation be-
tween the roughness of the substrate and the roughness of the
top surface. Indeed, the existence of a finite thickness oscil-
lation in the scattering intensity is an unequivocal indicator
of conformality in the roughness of the multilayer film. The
amplitude of the oscillation indicates the degree to which the
roughness of the substrate is replicated at the top surface.
The growth theory of Sec. VI asserts that the degree of rep-
lication is a strong function of frequency, decreasing at
higher frequency. Hence we expect that the RNS at small
scattering angles, corresponding to lower frequency rough-
ness, should exhibit larger finite thickness oscillations than
the RNS at large scattering angles. This is consistent with the
data shown in Fig. 9, where the amplitude of the oscillation
is observed to dampen with increasing scattering angle, and
is essentially absent at angles greater than;25 degrees.

In Fig. 11 we present additional measurements of non-
specular scattering from the canonical Mo–Si multilayer film
for normal incidence and wavelengths of 12.8, 13.0, 13.2,
and 13.4 nm. The solid lines are calculations of the scattering
intensity using the parameters summarized in Table II. The
growth parameters that characterize the multilayer roughness
are based on the measured PSDs of the substrate and top
surface of the multilayer film, shown in Fig. 4. The layer
thicknesses are derived from measurements of the specular
reflectivity, shown in Fig. 8. We emphasize that all of the
input parameters are obtained from independent measure-
ments and the calculations of the nonspecular scattering have
no adjustable parameters. The good agreement between the
measured scattering and the calculations based on the mea-

FIG. 10. ~a! An Ewald construction showing the nonspecular scattering
process in reciprocal space. The Bragg sheet is located atqz52k0 and the
incident radiation, of momentumkn̂, is normal to the film. The nonspecular
scattered field, of momentumkm̂, is constrained to the surface of the Ewald
sphere. A peak in the resonant nonspecular scattering~RNS! occurs when
the Ewald sphere intersects the Bragg sheet.~b! An Ewald construction
illustrating the conditions for specular reflectivity.
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sured roughness provides an important validation of the
multilayer growth model and scattering theory.

Finally we address an issue that is central to the appli-

cation of multilayer coatings in imaging systems: how does
the scattering from a multilayer coating compare to the scat-
tering from a single reflecting surface? The unique charac-
teristics of scattering from a multilayer film are illustrated in
Fig. 12~a! where we show calculations of the nonspecular
scatteringnormalized to the specular reflectivityfor three
configurations of the surface. In each case the incidence field
is unpolarized, has a wavelength of 13.4 nm and is incident
normal to the surface. The dotted line corresponds to scatter-
ing from a single surface having the roughness of the fused
silica substrate shown in Fig. 4. The scattering is featureless
and decreases relatively slowly with increasing scattering
angle. The rolloff is mostly due to the frequency dependence
of the PSD. In contrast, the dashed line represents the scat-
tering from our canonical Mo–Si multilayer film having
completely conformal interfaces, that is, the roughness at
each interface is identical to the substrate. Here the scattering
is characterized by strong interference effects~RNS!. The
RNS from the conformal multilayer is comparable to the
scattering from the single surface at angles less than
;12 degrees.~The scattering from the multilayer is slightly
reduced due to an increase of the x-ray wavelength within
the film.! Beyond 12 degrees the scattering intensity drops
precipitously, as the radiation fields scattered by the different
interface interfere destructively. Hence the conformal
multilayer scatters like a single surface within the RNS peak,
and strongly suppresses scattering at larger angles.

The solid line in Fig. 12~a! shows the scattering calcu-
lated for the canonical Mo–Si multilayer film~Fig. 9!, where
the interfacial roughness is due to both the replication of the
substrate and the intrinsic roughness of the film growth pro-
cess. The scattering exhibits an angular dependence similar
to the case of the purely conformal multilayer, but has a
nearly sixfold increase in scattering at all angles greater than
;1 degree. The scattering is increased because the
multilayer interfaces are rougher than the substrate, particu-
larly towards the top of the film where most of the scattering
originates~see Fig. 5!. It is also apparent that the finite thick-
ness oscillation is smaller and the decrease in scattering at
large angles is less rapid than for the case of the purely
conformal multilayer film, behavior which is consistent with
the partial correlation of the interfacial roughness. Compar-
ing the realistic multilayer film to the single surface, we find
that the scattering is equivalent only at very small angles of
,1 degree, where the interfacial roughness in the multilayer
film is purely conformal. The scattering from the multilayer
is enhanced in the region of 1–20 degrees due to the intrinsic
roughness of the film, and is suppressed at angles greater
than 20 degrees due the interference effects characteristic of
RNS.

The total integrated scatter~TIS! within a cone of half-
width u centered about the film normal is plotted as a func-
tion of u in Fig. 12~b!. The TIS is normalized to the specular
reflectivity, RSP. We observe that, compared to the single
surface, the scattering from the multilayer coatings is con-
centrated in the relatively small annular region within
;14 degrees from the normal, corresponding to the peak in
RNS. This suggests a simplead hocmethod for estimating
the Strehl factor for the multilayer film in the condition

FIG. 11. Nonspecular scattering measured from the canonical Mo–Si
multilayer film at normal incidence and for several different wavelengths.
Data within four degrees of the specular direction is obscured by the wings
of the specularly reflected beam. The solid lines are the scattering distribu-
tions predicted by the theory, based on the measured roughness of the
multilayer film.

1020 J. Appl. Phys., Vol. 84, No. 2, 15 July 1998 Stearns et al.



where the RNS and Bragg peaks effectively coincide. Our
main assertion is that the effect of roughness can be divided
into two regimes, corresponding to the frequencies that scat-
ter within and without the RNS peak. DefininguC as the
scattering angle at the edge of the RNS peak, we divide the
rms roughness into two parts: the low frequency roughness,
sL , obtained by integrating the PSD over the spatial fre-
quencies less than the valuef C5sinuC /l, and the high fre-
quency roughnesssH obtained by integrating the PSD over
the spatial frequencies greater thanf C . The low-frequency
roughness produces scattering within the RNS peak. Since
the roughness is conformal at these frequencies, the scatter-
ing from the different interfaces is coherent and interferes
constructively. Then the reduction in the specular reflectivity
due to these low frequencies can be estimated by a simple
factor of the Debye–Waller type, exp(216p2sL

2 cos2 u/l2).
For the frequencies of the roughness that scatter outside of
the RNS peak, the situation is very different. Here the loss
due to scattering is significantly reduced for two reasons:~1!
the interference of the fields scattered by the different inter-
faces becomes destructive, and~2! the coherence of the scat-
tering is reduced due to the decreased correlation of the in-
terfacial roughness. Thus in the high-frequency range the
primary effect of roughness is not to produce scattering, but
instead to increase the transmission of the interfaces, thereby
resulting in a larger penetration depth for the incident specu-
lar field and correspondingly greater absorption. This is in
fact the same loss mechanism as the case of a diffuse inter-
face broadened by intermixing or chemical reaction, and can
be treated in a similar way. Specifically, we estimate the
reduction of the specular reflectivity due to the high-
frequency roughness by including a contribution from the
high-frequency roughness in the interface widthsD

→AsD
2 1sH

2 . This modified value ofs can be applied in the
matrix method described in Appendix C to calculate the
specular reflectivityRSP(s) of the multilayer coating re-
duced by both diffuseness and high-frequency roughness.
Then the Strehl factor describing the reduction in the specu-
lar reflectivity due to interfacial roughness is estimated as

FIG. 12. ~a! Calculations of nonspecular scattering from three different
surfaces, normalized to the specular reflectivity. The dotted line is a single
surface having the roughness of the fused silica substrate shown in Fig. 4.
The dashed line corresponds to an ideally conformal Mo–Si multilayer film
where the roughness of each interface is identical to the roughness of the
single surface. The solid line is a realistic Mo–Si multilayer film having
interfacial roughness due to both replication of the substrate roughness and
the intrinsic roughness of the growth process.~b! The total integrated scat-
tering ~TIS! within a cone of halfwidthu, calculated for the three surfaces
and normalized to the specular reflectivity. Nearly all of the scattering from
the multilayer films is within 20 degrees of the specular direction.

TABLE II. A list of the parameters used to model the nonspecular scattering from the canonical Mo–Si
multilayer film. The multilayer growth parametersV, n, andn are described in Sec. VI. These together with the
substrate PSD~shown in Fig. 4! define the roughness of the multilayer interfaces. The diffuseness of the
interfaces is described by a linear profile of widthsD ~case@c# in Table I!. The thickness of the individual layers
is t. The atomic scattering factors aref 1 and f 2 , ther is the mass density, andW is the atomic weight.

Growth parameters
Structural
parameters Optical parameters

V
(nm3)

n
(nm3) n

t
~nm!

sD

~nm!
l

~nm! f 1 f 2

r
(g/cm3)

W
~g/mole!

Mo 0.05 2.5 4 2.1 0.3 12.8 14.34 1.270 10.2 95.94
~Mo-on-Si! 13.0 14.52 1.320

13.2 14.67 1.372
13.4 14.82 1.424

Si 0.02 2.5 4 4.75 0.15 12.8 21.397 0.487 2.33 28.086
~Si-on-Mo! 13.0 20.763 0.475

13.2 20.321 0.464
13.4 0.023 0.452
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S5
RSP~s5AsD

2 1sH
2 !

RSP~s5sD!
expS 2

16p2sL
2 cos2 u

l2 D . ~64!

As an example, consider the scattering from the canoni-
cal multilayer coating calculated from the PSDs of Fig. 4 and
shown as the solid line in Fig. 12~a!. The separation of the
low- and high-frequency ranges is found by inspection to be
at a scattering angle ofuC>14 deg, corresponding to a fre-
quency off C50.02 nm21. We integrate the PSD of the top
surface of the multilayer coating as prescribed in Eq.~46!
over the low- and high-frequency ranges to obtainsL

50.09 nm andsH50.15 nm, respectively. Using these val-
ues in Eq.~64! in conjunction with the structural parameters
of Table II, we obtain a Strehl factor of 0.988 for normal
incidence andl513.4 nm.

We emphasize that the method described by Eq.~64! for
estimating the Strehl factor is only necessary when there is a
strong reflected field, such that dynamical effects associated
with the interference of the fields scattered by the different
interfaces are important. When the incident field is not near
the Bragg peak, or if the specular reflectivity is small
(,0.1) then the scattering process is well approximated by
kinematical theory, that is, the scattering does not signifi-
cantly alter the configuration of the incident field. In this
case, the Strehl factor can be estimated from either the
Debye–Waller factor of Eq.~29! or the matrix method of
Appendix C with modified Fresnel coefficients, using a rms
roughnesss obtained by integrating the PSD over all fre-
quencies.

VIII. MODELING THE PERFORMANCE OF A SOFT X-
RAY IMAGING SYSTEM

We now turn our attention back to the problem of mod-
eling the nonspecular scattering in a distributed optical sys-
tem consisting of multilayer coated optics. The conventional
method for characterizing the performance of an imaging
system is to measure the optical transfer function~OTF!. The
OTF is the ratio of the image intensity to the object intensity
at a particular spatial frequency, and is also the Fourier trans-
form of the point spread function. It is only defined for the
case of incoherent illumination, where there is a purely linear
relationship between the Fourier transforms of the intensities
in the image and object planes. However, we have shown
that the effect of scattering is to produce a point spread func-
tion, PSFsc, that is independent of the coherence of the illu-
mination. Then the Fourier transform of PSFsc yields an
OTFsc that describes the modulation of the image intensity
due to scattering under any illumination conditions. In par-
ticular, collecting the results of Secs. II and III, the intensity
at the image plane is given by

^I 1~s1!&5I 1
0~s1!* kPSFsc~s1!, ~65!

whereI 1
0 is the image produced by the optical system in the

absence of scattering and

PSFsc~s1!

5
1

k S )
n

Snd~s1!1(
n

anxany

Rn
SPR2 (

â

dPn~m̂,â;n̂,ê!

dV D ,

~66!

is the point spread function due to scattering. The quantity in
brackets is calculated using the scattering theory presented in
the previous section; the angular scattering distributions
dPm /dV are obtained from Eq.~62!, where the scattering
vector is related to the points1 in the image field through Eq.
~32!. The Strehl factorSn , corresponding to the ratio be-
tween the specular reflectivity of thenth surface with and
without roughness, can be estimated from the PSD of the top
surface of the multilayer coating using Eq.~64!. The normal-
izing factork is

k5E E S )
n

Snd~s1!

1(
n

anxany

Rn
SPR2 (

â

dPn~m̂,â;n̂,ê!

dV D ds1 , ~67!

where the integration is over the image field. This factor
accounts for the loss of image intensity due to the scattering
outside of the image field and the increased absorption aris-
ing from the high-frequency interfacial roughness.

Taking the Fourier transform of~65! we obtain

I 1~ f!/I 1
0~ f!5OTFsc~ f!, ~68!

whereI 1(f) is the Fourier transform of the image intensity,
and

OTFsc~ f!5
1

k )
n

Sn1
1

k E E (
n

anxany

Rn
SPR2

3(
â

dPn~m̂,â;n̂,ê!

dV
exp~22p is1•f!ds1 .

~69!

Equations~68! and ~69! provide the basis for relating the
optical performance in the presence of scattering, as charac-
terized by the OTFsc, to the key structural parameters of the
optical surfaces, including the surface finish of the substrates
and the roughness of the multilayer coatings. This allows us
to determine specifications for the roughness of the sub-
strates and coatings, given certain performance requirements.
The operational procedure for deriving such specifications
consists of first defining a minimally acceptable OTFsc(f)
that will allow the production of useful images. Then, taking
into account the intrinsic roughness of the multilayer coating,
we determine the limits of substrate roughness required to
satisfy the specified value of OTFsc at each frequency.

A significant simplification is possible in the limit of
very smooth substrates, where the scattering is dominated by
the intrinsic roughness of the multilayer coatings. In this case
the scattering is uniform out to fairly large angles
(;10 degrees) because the PSD of the intrinsic roughness is
flat for frequencies less than;1021 nm21 ~see Fig. 2!.
When the scattered light is uniformly distributed throughout
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the image field it is called ‘‘veiling glare.’’ Under these con-
ditions the second term in Eq.~69! is negligible and the
OTFsc can be approximated as having a constant value of
S/k, that is, the image contrast is reduced by a constant
amount at all but the lowest frequencies.

As an example, we model the nonspecular scattering in
the distributed optical system shown schematically in Fig.
13. The imaging system is purely hypothetical, but is based
on generic designs being considered for applications in EUV
lithography.42,43 It consists of four reflecting surfaces and,
although designed to be used as a ring field, we will consider
for the purpose of modeling scattering that the image field is
a square of width 2.5 cm. A requirement for lithography
applications is that the imaging system be telecentric at the
wafer, that is, the principal ray is parallel to the optical axis
for all points in the image field. A consequence of telecen-
tricity is that the exit pupil is infinitely large and is located an
infinite distance from the image plane. However, we showed
in Sec. III that the effects of scattering on the transfer func-
tion are independent of the position of the actual exit pupil.
We can choose to evaluate the transfer function at any posi-
tion on the image side of the last optical surface, provided
that we apply the correct scaling factors. In this case we
evaluate the transfer function at the position of the last mir-
ror ~M4!, located 23 cm from the image plane. The scaling
factors and angles of incidence of the principal ray, as deter-
mined by ray tracing calculations, are listed in Table III. We
assume that the optical surfaces are coated with Mo–Si
multilayer films designed for an operating wavelength of
13.2 nm. Since the dispersion of the angles of incidence on
any given optical surface is small, the multilayer coatings
will have uniform bilayer spacing. The multilayer structure

that optimizes the reflectivity for the first, second, and fourth
surfaces is @Mo~2.80 nm!/Si~4.00 nm!#340. The third
surface requires a slightly different design of
@Mo~2.80 nm!/Si~4.10 nm!#340, due to the larger angle of
incidence. The calculated reflectivity of these designs at a
wavelength of 13.2 nm is shown in Fig. 14. These calcula-
tions include interdiffusion at the interfaces ofsD50.3 nm
for the Mo-on-Si interface andsD50.15 nm for the Si-
on-Mo interface. All roughness and oxidation is neglected,
and hence the reflectivity values are slightly overestimated.

The PSFsc is calculated using the methodology described
above. The plane of incidence of the principal ray is they–z
plane for all optical surfaces, and the radiation incident on
each surface is assumed to be unpolarized. We assume that
the roughness of the substrates is the same as the superpol-
ished fused silica flat having the PSD shown in Fig. 4. Fur-
thermore, we assume that the roughness of the Mo–Si
multilayer coatings is equivalent to the ‘‘canonical’’ film dis-
cussed in the previous sections, and that the roughness is
described by the thin film growth model and the correspond-
ing growth parameters listed in Table II. Consequently, the
multilayer coating contributes roughness to the optical sur-
faces, causing the rms roughness to increase from the sub-
strate to a final value ofs50.18 nm at the top surface. The
Strehl factorsSn for the coatings are determined from Eq.
~64!, where the rms roughness is divided into low- and high-
frequency components ofsL50.09 nm andsH50.15 nm,
corresponding to those frequencies that scatter within and
out of the RNS peak, respectively. The calculated values of
the Strehl factors are listed in Table III.

The PSFsc calculated over a 2.532.5-cm image field is
shown in Fig. 15. The delta function corresponding to the
specular field@the first term in Eq.~66!# has been omitted
from the plot. The PSFsc exhibits a peak at the optical axis
which drops off to a relatively constant level of scattering at
distances beyond;0.5 cm from the optical axis. The edge of
the image field corresponds to a scattering angle of only
;3 degrees. Since the strong resonant scattering~RNS! from
the multilayer coatings exists out to an angle of
;14 degrees, it is evident that the image field intercepts only

FIG. 13. Schematic diagram of a hypothetical soft x-ray imaging system for
EUV lithography. The optical system, consisting of four multilayer-coated
mirrors, projects an image of the reticle onto the wafer.

TABLE III. Design parameters for a hypothetical soft x-ray imaging system
consisting of four mirrors. The scaling factors,aX andaY , are set equal and
u is the angle of incidence of the principal ray as measured from the normal
to the optical surface. Also listed are the Strehl factorsSn for the multilayer
coatings calculated at an x-ray wavelength of 13.2 nm.

Mirror aX5aY u ~deg! Multilayer structure Sn

M1 1.7 3.0 @Mo~2.8 nm!/Si~4.0 nm!#340 0.985
M2 0.9 7.0 @Mo~2.8 nm!/Si~4.0 nm!#340 0.985
M3 1.8 12.0 @Mo~2.8 nm!/Si~4.1 nm!#340 0.985
M4 1.0 6.0 @Mo~2.8 nm!/Si~4.0 nm!#340 0.986

FIG. 14. Calculated reflectivity of the two Mo–Si multilayer coatings used
in the hypothetical imaging system. The arrows indicate the angles of inci-
dence of the principal ray on each of the optical surfaces.
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a small fraction of the total scattered radiation. In this case
the Strehl factorS for the imaging system is 0.94, corre-
sponding to a 6% decrease in the specular image intensity.
However the fraction of the specular intensity scattered into
the image field is only 0.3% (S/k50.997). The OTFsc ob-
tained by taking the Fourier transform of the PSFsc is shown
in Fig. 16. The OTFsc drops rapidly to a constant value of
S/k50.997 for frequencies greater than;2.5 cm21. This
behavior is characteristic of veiling glare and illustrates the
dominant effect of the intrinsic roughness of the multilayer
coatings in this example; the scattering is fairly uniformly
distributed throughout the image field and hence reduces the

image contrast by a constant amount at all but the lowest
frequencies.

At the risk of oversimplification, we can use our ex-
ample to make some general comments regarding the effect
of scattering in the performance of multilayer-coated imag-
ing systems. High performance imaging systems for soft
x rays require a numerical aperture of;0.1 or less in order
to have a reasonable depth of focus (>1 mm). Consequently
the range of scattering angles subtended by the image field
will be limited to a few degrees, and all of this scattering will
be within the RNS peak of the multilayer coatings. The com-
ponents of roughness that scatter into the image field are in
the midspatial frequency range of;1025/l – 1021/l nm21;
it is this range of frequencies that is responsible for the de-
crease in image resolution and contrast. In this range the
roughness of the multilayer coatings is dominated by the
replication of the substrate roughness and includes~at the
higher end of the frequency range! some intrinsic roughness
of the multilayer film. Consequently, the scattering within
the image field for a multilayer-coated imaging system is
expected to be comparable to, and slightly greater than, an
equivalent system having single reflecting surfaces. Most of
the intrinsic roughness of the multilayer-coatings occurs at
higher frequencies (1023– 1021 nm21) that will scatter out-
side of the image field. Hence the main detrimental effect of
the intrinsic roughness of the coatings is to reduce the
throughput of the imaging system.

IX. CONCLUSION

In summary, we have presented a theoretical framework
for modeling nonspecular scattering in a soft x-ray imaging
system consisting of multilayer-coated reflecting optics. The
theory directly relates the image degradation due to scatter-
ing to the statistical properties of the interfacial roughness of
the multilayer coatings. Consequently, the theory can be a
versatile tool for tasks such as modeling the performance of
optical components of known roughness, deriving specifica-
tions for the roughness of optical substrates and coatings,
and comparing the performance of different optical designs.
When applying the theory in practice, it is important to recall
the numerous approximations that were invoked, and to ob-
serve the restrictions imposed by these approximations. We
summarize the key approximations of the theory in Appen-
dix A.

Throughout the course of this presentation we have at-
tempted to illustrate the theoretical formalism with realistic
examples and analysis of experimental data whenever pos-
sible. In particular, the good agreement between the mea-
sured scattering from Mo–Si multilayer films and the calcu-
lations based on the measured roughness of the films serves
to validate our treatment of the scattering problem. The ulti-
mate test of the theory will require the complete character-
ization of a distributed imaging system, corresponding to in-
dependent measurements of the PSF and the roughness of the
multilayer-coated optics. This will be the goal of future
work.

In addition to its practical importance, our theoretical
investigation has broadened the fundamental understanding

FIG. 15. The point spread function due to scattering (PSFsc) of the hypo-
thetical imaging system, calculated assuming that the roughness of the
Mo–Si multilayer coatings is equivalent to the canonical film shown in Fig.
4. The delta-function component of PSFsc is not shown.

FIG. 16. The optical transfer function due to scattering (OTFsc) of the
hypothetical imaging system. The nonspecular scattering reduces the OTF
of the imaging system by a factorS/k50.997 at all but the lowest
frequencies.
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of scattering in a distributed imaging system and, in particu-
lar, the effects of multilayer coatings. The most important
results are summarized below:

~1! Image formation in a distributed optical system can
be described as a convolution of the image formed in the
absence of scattering with a PSFsc due to scattering.

~2! The PSFsc is independent of the coherence state of
the object.

~3! The roughness of a multilayer coating originates
from both the intrinsic roughness of the growth process and
the replication of the roughness of the substrate. At the low-
est spatial frequencies the multilayer film exactly replicates
the substrate roughness. In the range;1023– 1021 nm21 the
roughness increases from the substrate to the top surface of
the multilayer, and the roughness of the different interfaces is
partially correlated. At higher spatial frequencies the
multilayer film tends to smooth the substrate roughness.

~4! The nonspecular scattering from a multilayer coating
exhibits strong interference effects due to the partial correla-
tion of the roughness of the interfaces. This produces a reso-
nance in the nonspecular scattering~RNS! in the vicinity of
the specular Bragg peak. In particular, the RNS peak and the
Bragg peak are coincident when the incident field satisfies
the Bragg condition for specular reflection.

~5! In a soft x-ray imaging system, the roughness in the
midspatial frequency range of;1025/l – 1021/l nm21 pro-
duces the scattering that reaches the image field. In this fre-
quency range the roughness of the multilayer coatings is due
to replication of the substrate roughness and, to a small ex-
tent, the intrinsic roughness of the multilayer film. Hence the
scattering within the image field for a multilayer-coated im-
aging system is expected to be slightly greater than an
equivalent system having single reflecting surfaces, and de-
pends predominantly on the roughness of the optical sub-
strates.

~6! The main detrimental effect of the intrinsic rough-
ness of the multilayer coatings is to scatter radiation outside
the image field, thereby reducing the throughput of the opti-
cal system.

We conclude with a comment regarding the impact of
scattering on the performance of soft x-ray imaging systems.
The example that we have presented using a hypothetical
imaging system designed for EUV lithography shows a very
minor degradation of performance due to scattering; the OTF
is reduced by only 0.3% and the throughput is decreased by
6%. One might be tempted to infer that scattering is not a
significant problem in such an imaging system. In fact, our
example demonstrates that scattering can be limited to ac-
ceptably low levels in a soft x-ray imaging systemif the
optical substrates can be fabricated with roughness equiva-
lent to the best superpolished flats measured to date. Our
analysis indicates that, once these ultrasmooth substrates are
available, the existing multilayer-coating technology is ca-
pable of producing soft x-ray imaging systems that have ac-
ceptably low levels of scattering. This conclusion is sup-
ported by experiments performed44 on a soft x-ray telescope
designed for normal incidence operation atl56.35 nm. The
optical components were coated with Co–C multilayer films,
and were measured to have roughness similar to the PSDs

shown in Fig. 4. Analysis of the images obtained with the
telescope showed no measurable scattering. Although these
results are encouraging, they must be considered a best case
scenario. We anticipate that fabricating sufficiently smooth
figured optics will be a significant technical challenge, par-
ticularly as the size of the optical components increases and
the figures become aspherical. In practice the effect of scat-
tering on the performance of the soft x-ray imaging system
will define the acceptable limits of roughness for these op-
tics.
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APPENDIX A: SUMMARY OF APPROXIMATIONS

We summarize below the key assumptions and approxi-
mations underlying the theoretical development presented in
this paper.

~a! The angle between the principal ray and any other
ray that propagates through the imaging system is small.
Specifically, if we denote the angle asw, then the approxi-
mation is

sin2 w!1. ~2!

We call this the ‘‘small angle approximation.’’
~b! For a point object, the pupil function is independent

of the location of the point in the object field. In this case the
point spread function is independent of the position of the
Gaussian image point, and the system is called
‘‘isoplanatic.’’ In practice, the assumption of isoplanacity
restricts the applicability of the transfer function formalism
to objects of small spatial extent.

~c! The scattering is weak so that multiple scattering and
shadowing effects can be neglected. This is called the ‘‘Born
approximation.’’ This approximation is generally valid for
x-ray wavelengths at angles of incidence away from the criti-
cal angle for total external reflection.

~d! The surface heightH(X,Y) is a Gaussian random
variable, is stationary and is ergodic in the sense that the
ensemble average can be replaced by an average over the
illuminated surface area.

~e! The deviations of the surface heightHn(Xn ,Yn) from
the ideally smooth surface are small compared to the radia-
tion wavelength such that 2k cosunHn(Xn ,Yn)!1 for all Xn ,
Yn . We call this the ‘‘small roughness approximation.’’ A
necessary consequence of the small roughness approxima-
tion is that the power scattered into the nonspecular field is
small compared to the specularly reflected power, a condi-
tion that is implicitly satisfied by high-performance optics.
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APPENDIX B: RELAXATION OF A ROUGH SURFACE
BY SURFACE DIFFUSION

Consider a rough surfaceH(X,Y) where the growth
units ~e.g., atoms! have mobility to move between sites on
the surface. The chemical potential at each point on the sur-
face depends on the curvature at that point. The gradient of
the chemical potential is the driving force for the surface
diffusion that causes the smoothing of the surface. To ex-
press these concepts quantitatively let us model the local
curvature of the surface at a particular point as a sphere of
radiusR. Then the curvature at that point is

¹2H~X,Y!52
2

R
. ~B1!

The chemical potential of the pointH(X,Y) is found by let-
ting the radius of the spherical feature change by an infini-
tesimal amountDR. The chemical potential is given by

m5
DEs

DN
, ~B2!

whereDEs is the change in the surface energy andDN is the
change in the number of atoms within the sphere. The
change in the surface energy is just proportional to the
change in the surface area

DES58pRjDR, ~B3!

wherej is the surface energy per unit area. The change in the
number of atoms in the sphere is

DN5
4pR2DR

V0
, ~B4!

whereV0 is the atomic volume. Combining Eqs.~B1!–~B4!
we obtain

m5
2jV0

R
52jV0¹2H~X,Y!. ~B5!

This shows explicitly that the chemical potential is propor-
tional to the local curvature of the surface.

The driving force,F, for surface diffusion is the gradient
of the chemical potential

F52¹m. ~B6!

From the Nernst–Einstein relation45 the mean velocity of an
atom on the surface is given by

^v&5
FDS

kT
52

DS¹m

kT
~B7!

where DS is the surface diffusion coefficient,k is Boltz-
mann’s constant, andT is the surface temperature. The flux
of atoms,J, on the surface is

J5
^v&
V0

2/3. ~B8!

The surface flux is the mechanism of mass transport through
which the smoothing of the surface takes place. However,
the surface height at a given point can change only if there is
a divergence of flux. Then the change in the surface height
per unit time is given by

dH~X,Y!

dt
52V0¹•J. ~B9!

Combining Eqs.~B5!–~B9! we obtain

dH~X,Y!

dt
52

jDSV0
4/3

kT
¹4H~X,Y!. ~B10!

In the thin film growth model the evolution of the surface is
measured as a function of film thickness,t, and not time.
However, time and thickness are simply related through the
deposition rater D5dt/dt. Then we can rewrite Eq.~B10! as

dH~X,Y!

dt
52

jDSV0
4/3

r DkT
¹4H~X,Y!. ~B11!

Comparing this result to Eq.~36! we identify the relaxation
parameter for the thin film growth model

n5
jDSV0

4/3

r DkT
. ~B12!

Not surprisingly, the rate at which the smoothing occurs is
proportional to the surface diffusion coefficient. The tem-
perature dependence of the relaxation parameter is domi-
nated by the surface diffusion coefficient which is propor-
tional to exp(2EA /kT), whereEA is the activation energy. In
general the relaxation of the surface will be enhanced at
higher temperature and lower deposition rate.

APPENDIX C: MATRIX METHOD FOR PROPAGATING
SPECULAR FIELDS IN A MULTILAYER FILM

The multilayer scattering theory requires as input param-
eters the incident field amplitudes,Ei

1 and Ej
2 , and the

propagation factorsf i
r and f i

t for each interface of the
multilayer film in the absence of roughness. These are most
easily calculated using a well-known matrix approach46 to
analyze the propagation of the specular fields within the
multilayer film. First we define a scattering matrix,T i , that
relates the specular fields across thei th interface according
to

S Ej
2

Ej
1D 5T i S Ei

2

Ei
1D . ~C1!

It is easily shown that

T i5
1

t j i
S 1 r j i

r i j t j i t i j 1r j i
2 D , ~C2!

wheret j i andr j i are the specular transmission and reflection
amplitudes, respectively, for thei th interface. For a compo-
sitionally abrupt interface the transmission and reflection am-
plitudes are given by the Fresnel equations

S polarization: t j i
0 5

2x j

x j1x i
, r j i

0 5
x j2x i

x j1x i

P polarization: t j i
0 5

2Ae je ix j

e ix j1e jx i
, r j i

0 5
e ix j2e jx i

e ix j1e jx i

~C3!

where
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x i5kAe i2nX
22nY

2. ~C4!

Diffuseness at the interface, characterized by a compo-
sition gradientWD(Z), modifies the transmission and reflec-
tion amplitudes according to the well-known formulas first
derived by Nevot and Croce47

t j i 5t j i
0 1

wD~kjnjZ
1 2kiniZ

1 !

r j i 5r j i
0

wD~kjnjZ
1 1kiniZ

1 !

wD~kjnjZ
1 2kiniZ

1 !
.

~C5!

Specific examples of the functionwD(qz), corresponding to
several simple interface profiles, are listed in Table I.

The scattering matrix describes the propagation of the
specular field across an interface. To propagate the field
through thei th layer of thicknesst i we define the propaga-
tion matrix Pi

Pi5S exp~2 iw i ! 0

0 exp~ iw i !
D , ~C6!

where

w i5kt iAe i2nX
22nY

2. ~C7!

The propagation of the specular field from layer to layer
in the multilayer film is represented by a series of matrix
multiplications. In particular, the field above interfacei is
related to the field below the underlying interfacem through
a matrixA i ,m according to

S Ei 11
2

Ei 11
1 D 5A i ,mS Em

2

Em
1D , ~C8!

where

A i ,m5S A11
i ,m A21

i ,m

A12
i ,m A22

i ,mD 5T iPiT i 21¯Tm11Pm11Tm . ~C9!

The transmission and reflection amplitudes for the entire
multilayer film, tML andr ML , are obtained fromAN,0, corre-
sponding to propagation through allN interfaces. In particu-
lar,

tML5
1

A11
N,0 , r ML5

A21
N,0

A11
N,0 , ~C10!

and the specular transmission and reflectance are correspond-
ingly,

TSP5utMLu2, RSP5ur MLu2. ~C11!

Knowledge of the transmitted amplitude allows us to deter-
mine the specular fields above and below each interface us-
ing the relations

S Ei 11
2

Ei 11
1 D 5A i ,0S tML

0 D , S Ei
2

Ei
1D 5PiA

i 21,0S tML

0 D .

We introduced the factorsf i
r and f i

t in the scattering
theory to account for the propagation of the scattered field
from the i th interface to the top surface of the multilayer
film. Consider a field of unit amplitude initially scattered at
the i th interface towards the top of the film. This produces a

field exiting the front surface of the film of amplitudef i
r and

a field exiting the bottom surface into the substrate of ampli-
tudeEs . Then the matrix equation that describes the propa-
gation of this scattered radiation through the system of layers
is given by

S 0
f i

r D5AN,i 11Pi 11F S 0
1D1A i ,0S Es

0 D G , ~C12!

where the matricesA and P now correspond to a scattered
plane wave mode. Similarly, for a field of unit amplitude
initially scattered towards the bottom of the multilayer film
we can write a matrix equation:

S 0
f i

tD5AN,iF S 1
0D1PiA

i 21,0S ES

0 D G . ~C13!

Solving these matrix equations forf i
r andf i

t we obtain

f i
r5eiw i~A22

N,i 112r MLA12
N,i 11!

f i
t5A21

N,i2r MLA11
N,i .

~C14!
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Abstract

A computer program called IMD is described.  IMD is used for modeling the optical properties

(reflectance, transmittance, electric field intensities, etc.) of multilayer films, i.e., films consisting of any

number of layers of any thickness.  IMD includes a full graphical user interface, and affords modeling

with up to eight simultaneous independent variables, as well as parameter estimation (including

confidence interval generation) using non-linear, least-squares curve fitting to user-supplied experimental

optical data.  The computation methods and user interface are described, and a number of examples are

presented  which illustrate some of IMD’s unique modeling, fitting and visualization capabilities.

Keywords: multilayer films, optical modeling, parameter estimation.
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1. Introduction

IMD is a computer program for modeling the optical properties  reflectance, transmittance,

absorptance, phase shifts and electric field intensities  of multilayer films, i.e., films consisting of any

number of layers of any thickness. Estimating the optical properties of multilayer films is integral to

instrument design and modeling in many fields of science and technology, such as astronomy,

lithography, plasma diagnostics, synchrotron instrumentation, etc.  Also, fitting the calculated reflectance

of a multilayer stack to experimental data is the basis of X-Ray Reflectance (XRR) analysis of thin films,

where one uses the measured reflectance to determine film thicknesses, densities, and roughnesses, and to

optical constant determination from reflectance vs. incidence angle data, a technique utilized in many

spectral regions.1 IMD was designed, therefore, as a completely general modeling and parameter

estimation tool, intended to be used for these and other applications, in order to meet the needs of a broad

range of researchers.  Furthermore, IMD’s flexibility enables many new and unique types of computations.

IMD is available for free via the Internet.2

In IMD, a layer can be composed of any material for which the optical constants are known or

can be estimated.   Any number of  such layers can be designated and optionally grouped together to

define periodic multilayers; ‘groups of groups’ of layers can be defined, in fact, with no limit on nesting

depth. The IMD distribution includes an optical constant database for over 150 materials, spanning the X-

ray to the far infrared region of the spectrum.  User-defined optical constants can be used as well, and in

the 30 eV to 30 keV region in particular, optical constants can be generated by the user for arbitrary

compounds using the CXRO atomic scattering factors.3 Imperfections at an interface, i.e., roughness

and/or diffuseness, can be easily included;  the effect of such imperfections, namely, to reduce the specular

reflectance at the interface, becomes especially important at shorter wavelengths (i.e., below ~30 nm),

where the length scale of these imperfections is comparable to the wavelength of light.

The optical functions (reflectance, transmittance, etc.) can be computed not just versus

wavelength and/or incidence angle, but also as a function of any of the parameters that describe the

multilayer stack (e.g., layer thicknesses, roughnesses, etc.) or the incident beam (polarization,
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angular/spectral resolution.)  An interactive visualization tool, IMDXPLOT,  is used to display the results

of such multiple-variable computations; with this visualization tool one can vary a given parameter and

see the resulting effect on the optical functions (in one or two dimensions) in real time.  This last feature

is especially helpful in discerning the relative sensitivities of the optical functions to the parameters that

describe the multilayer structure.

Parameter estimation is afforded by fitting an optical function to user-supplied experimental data:

non-linear, least-squares curve fitting based on the χ2 test of fit is utilized.  The precision of the best-fit

parameters can be estimated as well, by computing multi-dimensional confidence intervals.  The ability to

simultaneously vary multiple parameters ‘manually’, as mentioned above, prior to performing least-

squares fitting, is particularly useful in selecting initial parameter values; indeed choosing initial fit

parameter  values that are reasonably close to the best-fit values is generally the most difficult aspect of

multi-parameter non-linear fitting.

IMD is written in the IDL language,4 and makes extensive use of IDL’s built-in ‘widgets’ to

provide a full graphical user interface (GUI.)  As such, IMD can be run on most (currently) popular

platforms, including MacOS, MS Windows, and most flavors of Unix.

In the following sections, I will describe first the physics and algorithms used for modeling and

parameter estimation, followed by a description of the IMD user interface.  Finally, I present several

illustrative examples, demonstrating IMD’s unique modeling and fitting capabilities.

2. Computation Methods

2.1 Optical Functions

Computations of the optical functions of a multilayer film in IMD are based on application of the

Fresnel equations, modified to account for interface imperfections, which describe the reflection and

transmission of an electromagnetic plane wave incident at an interface between two optically dissimilar

materials.



4

2.1.1 Reflection and Transmission at an Ideal Interface

We consider first the behavior of a plane electromagnetic wave at an idealized interface, i.e., the

abrupt interface between two semi-infinite media, as shown in Figure 1.  The complex index of refraction

n = n + ik (where n is the refractive index and k is the extinction coefficient) is given in the two regions as

ni and nj. The incident wave vector, with electric field amplitude Ei , makes an angle θi  with respect to

the interface normal (the z axis).  The amplitude of the reflected and transmitted electric fields,

′Ei andE j , respectively, are given by the well-known Fresnel equations:5
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for p-polarization (i.e., E parallel to the plane of incidence), where θ j  is the angle of refraction,

determined from Snell’s law: n ni i j jsin sinθ θ= .  In equation (1) we have introduced the Fresnel

reflection and transmission coefficients, rij  and tij , respectively.6

2.1.2 Interface Imperfections

In order to account for the loss in specular reflectance due to interface imperfections (i.e.,

interfacial roughness and/or diffuseness), we now consider the case where the change in index across the

interface is not abrupt, but can be described instead by an interface profile function p(z).  (See Figure 2.)

That is, following the formalism developed by Stearns,7 we define p(z) as the normalized, average value

along the z direction of the dielectric function,ε( )x (with n = ε ):

p z
dxdy

dxdyi j

( )
( )

( )
= ∫∫

− ∫∫
ε

ε ε
x

, (2)

where

ε
ε
ε

( )
,

,
x =

→ + ∞
→ − ∞





i

j

z

z
(3)

Stearns has shown that in the case of non-abrupt interfaces, the resultant loss in specular reflectance can

be approximated by multiplying the Fresnel reflection coefficients (equations 1a and 1c) by the function

~( )w s , the Fourier transform of w z dp dz( ) /= . That is, the modified Fresnel reflection coefficients are

given by

′ =r r w sij ij i
~( ) (4)
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where si i= 4π θ λcos / , andλ is the wavelength of light.  Note that the loss in specular reflectance

depends only on the average variation (over x and y) in index across the interface. Consequently, the

reflectance can be reduced equally well by either a rough interface, in which the transition between the

two materials is abrupt at any point (x,y),  or a diffuse interface, in which the index varies smoothly along

the z direction (or by an interface that can be described as some combination of the two cases.)

Stearns presents four particularly useful interface profiles, all of which are available for use in

IMD; these interface profile functions and the associated ~( )w s  functions are listed Table 1. Also available

in IMD are modified~( )w s functions, wheresi has been replaced with sij i j= 4π θ θ λcos cos / , in accord

with the formalism developed by Névot and Croce8 to properly account for the effect of roughness on the

specular reflectance below the critical angle of total external reflection in the X-ray region.

The width of each interface profile function presented in Table 1 is characterized by the

parameter σ (see Figure 2), which is a measure of either an rms interfacial roughness, in the case of a

purely rough interface,  an interface width, in the case of a purely a diffuse interface, or some combination

of the two properties in the case of an interface that is both rough and diffuse; it is the parameter σ (along

with the choice of interface profile function) that is specified in IMD to account for the effects of interface

imperfections using the modified Fresnel coefficient approach just described.

2.1.3 Optical Functions of a Multilayer Stack

We now consider a plane wave incident on a multilayer stack, that is, a series of N layers (and

N+1 interfaces), where the i th layer has thickness di, interfacial roughness/diffuseness σi, and optical

constants ni, as shown in Figure 3.  The region above the multilayer stack  the ambient  has optical

constants na, and the region below the film  the substrate  has optical constants ns. (Note that the case

of a free-standing film refers to the condition ns = na.)  Under these circumstances, the net reflection (ri)

and transmission (ti) coefficients of the i th layer are given by:9
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r
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i
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+
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β

β (5b)

where β π θ λi i i id= 2 n cos / ; the reflection coefficients rij are computed from equation (4), the

transmission coefficients tij from equations (1b) and (1d), and rj and tj are the net reflection and

transmission coefficients of the j th interface. Thus, the procedure to compute the net reflection (r) and

transmission (t) coefficients for the multilayer stack is to apply equation (5) recursively, starting at the

bottom-most layer, i.e., i = N, j = s.  (The coefficients r and t for s- and p-polarization are computed

separately, using the appropriate Fresnel coefficients.)  The reflectance, R and transmittance, T, which

measure the energy reflected from or transmitted through the film, respectively, are then given by

R r= 2
(6a)

and

T ts s

a a

=








Re
cos

cos

n

n

θ
θ

2
(6b)

(again, computing separately the values for s- and p-polarization, i.e., Rs, Rp, Ts, and Tp.) The absorptance,

A, which measures the amount of energy absorbed by the film,  is approximated by
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A R T= − −1 (6c)

(Note that equation (6c) is inaccurate when light is removed from the specular direction, i.e., and scattered

into non-specular directions, due to interfacial or surface roughness.) Finally, the phases of the reflected

and transmitted waves are given by:

φr r r= −tan (Im{ } / Re{ })1 (7a)

and

φt t t= −tan (Im{ } / Re{ })1 (7b)

2.1.4 Electric Field Intensity in a Multilayer Stack

In order to compute, in addition to the optical functions, the electric field intensity as a function

of depth in a multilayer stack, a slightly different formalism from that described in the previous section

must be used.  (The previous, more efficient, formalism is used in IMD when electric field intensities are

not required.) Consider the interface between the i th and the j th layers in a multilayer stack, where we now

have both positive-going and negative-going electromagnetic plane waves in both layers. Solving

Maxwell’s equations in this case, it can be shown that the positive-going and negative-going field

amplitudes at a distance zi above the interface are given by

E z
t

e E
r

t
e Ei i

ij

i z
j

ij

ij

i z
j

i i i i+ − + − −= +( ) ( ) ( )( ) ( )1
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E z
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respectively, where β π θ λi i i i iz z( ) cos /= 2 n , and E j
+ ( )0 and E j

− ( )0 are the field amplitudes at the top

of the j th layer.  Again, a recursive approach can be used to compute the field amplitudes throughout the

stack, starting at the bottom-most layer (i = N, j = s) with the field amplitudes in the substrate given as

Es
+ =( )0 1  and Es

− =( )0 0 .  The net reflection and transmission coefficients of the film can then be

computed from the field amplitudes in the ambient:

r
E

E
a

a
=

−

+
( )

( )

0

0
(9a)

and

t
Ea

= +
1

0( )
(9b)

Once the transmission coefficient is computed from equation (9b), the field amplitudes versus depth are

then re-scaled using

E z tE z± ±→( ) ( ) , (10)

(i.e., taking the incident electric field to have unit amplitude) and the field intensities for s- and p-

polarization computed from

I z E z E z( ) ( ) ( )= ++ − 2
(11)
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2.1.5 Polarization

In the case of an incident beam that consists of a mixture of s- and p-polarization, it is often

necessary to compute the ‘average’ values of the optical functions R, T, and A, and the electric field

intensity I, i.e., the values of these quantities for ‘average’ polarization.  We thus define the incident

polarization factor f as

f
I I

I I

s p

s p
=

−
+

, (11)

whereI s
andI p

are the incident intensities for s- and p-polarization (e.g., unpolarized radiation

corresponds to f = 0.)  Furthermore, we define the polarization analyzer sensitivity, q, as the sensitivity to

s-polarization divided by the sensitivity to p-polarization; specifying a value of q other than 1.0 could be

used to simulate, for example, the reflectance one would measure using a detector that (for whatever

reason) was more or less sensitive to s-polarization than to p-polarization.  It can be shown that the

average reflectance is then given by

R
R q f R f

f q q
a

s p

=
+ + −

− + +
( ) ( )

( ) ( )

1 1

1 1
, (12)

with equivalent expressions for Ta, Aa and Ia.

2.1.6 Instrumental Resolution

In general, the experimental determination of an optical function such as R, T or A is made with

instrumentation that is limited in angular and/or spectral resolution.  As such, it is desirable to estimate

resolution-limited values of the calculated optical functions.  This is achieved in IMD by convolving the

calculated optical functions with a Gaussian of width δθ, in the case of finite angular resolution, or with a
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Gaussian of width δλ in the case of finite spectral resolution, using the convolution algorithm built into

IDL.

2.1.7 Graded Interfaces

In addition to the option of using the modified Fresnel coefficients to account for interfacial

roughness and diffuseness, as described in Section 2.1.2,  in IMD it’s also possible to model the effects of

a diffuse interface on the optical functions and electric field intensities by specifying a ‘graded’ interface.

That is, an abrupt interface can be replaced by one or more layers whose optical constants vary gradually

between the values for the pure materials on either side of the interface.

In IMD, a graded interface is described by three parameters, as shown in Figure 4: the interface

width, wg,  the number of layers comprising the graded interface, Ng, and the distribution factor, Xg, which

determines where the graded interface region resides relative to the original abrupt interface (as will be

described below.)

The optical constants in each of the Ng layers of a graded interface are computed as follows.

Consider the graded interface between the i th and j th layers in a multilayer stack. The thickness of each of

the Ng graded interface layers is equal to wg / Ng.  The optical constants in the �
th graded interface layer

are thus given by

n
N n n

N

g i j

g
�

� �

=
+ − +

+
( )

( )

1

1
(13a)

and

k
N k k

N

g i j

g
�

� �
=

+ − +
+

( )

( )

1

1
(13b)
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with � �= 1, Ng . The resulting layer thicknesses, ′di and ′d j , of the pure materials in the i th and j th

layers, respectively, after including the graded interface layers, are given by

′ = − −d d w Xi i g g( )1 (14a)

and

′ = −d d w Xj j g g (14b)

with 0 1< <Xg . (Note that the total thickness of the two layers — including all the graded interface

layers — is constant, i.e., ′ + ′ + = +d d w d di j g i j .)  As an example, a distribution factor of 50%

( X g = 05. ) would result in equal reductions of the i th and j th layer thicknesses.

2.2 Parameter Estimation

As will be described in section 3.2, it is possible in IMD to designate simultaneously up to eight

independent variables when computing optical functions and electric field intensities.  When attempting

to model experimental optical data, however, it is often desirable to estimate parameter values

automatically, using nonlinear, least-squares curve-fitting.  To this end, parameter estimation based on the

χ2 test of fit can be used in IMD to determine any number of parameters that describe the multilayer stack

(or the incident beam polarization and/or instrumental resolution), as will now be described.

2.2.1 Fitting Algorithm

Consider a one-dimensional optical function Y X( )  for a multilayer stack, where Y may be any

one of R Ta a,  or Aa , and X is some independent variable (e.g., λ, θ, etc.) The values for Y X( ) depend

on the values of all of the parameters that describe the multilayer stack (optical constants, layer

thicknesses, etc.) and the incident beam (polarization, instrumental resolution, etc.). The problem we wish
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to solve is the following: determine the values for some fixed number p of these adjustable parameters,

such that the calculated optical function Y X( )  most closely fits a particular set of experimentally-

determined optical data, Y Ym m± δ  , measured as a function of the independent variable Xm , where Xm

takes on i Nm= 1,�  discrete values.

To solve this problem, IMD makes use of the so-called Marquardt gradient-expansion

algorithm,10  based on the χ2 test,11 in which we minimize the value of the statistic S, defined as

S
Y i Y i

w i
m

i

Nm

≡
−

∑
=

( [ ] [ ])

[ ]

2

2
1

, (15)

where w[i] are the weighting factors for each point.  IMD uses the CURVEFIT procedure,11 an adaptation

of the Marquardt algorithm included in the IDL library. The user designates adjustable parameters, and

initial values for each. (In IMD, a constraint on the range of acceptable parameter values can be specified

as well.) Iterations are then performed until the change in S is less than a specified amount, or until a

maximum number of iterations have been performed.  The user can choose to use for w[i]  either (a)

‘instrumental weighting,’ using the experimental uncertainties, w i Y im[ ] [ ]= δ ,  (b) ‘statistical weighting,’

with w i Y im[ ] [ ]= , or (c) ‘uniform weighting,’ withw i[ ] = 1.   Additionally, logarithmic fitting can be

used, in which the numerator in equation (15) is replaced by (ln [ ] ln [ ])Y i Y im− 2 .

2.2.2 Confidence Interval Computation

In addition to a point estimate determination of the ‘best-fit’ parameter values, using the fitting

technique just described, for example, it is generally necessary to estimate also the range of acceptable

parameter values that are consistent with the experimental data.  To this end, in IMD it is possible to

compute multi-dimensional confidence intervals associated with the best-fit values of the adjustable

parameters, using the formalism described in references 12 and 13.
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It can be shown that when using the χ2 test of fit, the minimum value of the S statistic, Smin ,

associated with the best-fit parameter values, is distributed as the χ2 probability function with

N pm − degrees of freedom:

S N pmmin ( )= −χ α2 , (16)

where α is the significance of fit.  That is, if we find, for example, that S N pmmin ( . )= −χ2 0 68 , then we can

conclude that there is a 68% probability that the model (using the p best-fit parameter values) correctly

describes the data.

The confidence region, with significance ′α , is then defined as the p-dimensional region of

parameter space for which the value of S is less than or equal to some value SL, where

S S SL = + ′min ( )∆ α , (17)

with ∆S( )′α  equal to the value of the χ2 probability function with p degrees of freedom and significance

′α ; the confidence region so defined would enclose the true values of the p parameters in 1− ′α of all

experiments.

In IMD, a multi-dimensional confidence region can be determined for up to eight adjustable (i.e.,

fit) parameters simultaneously.   In this case a grid-search algorithm is utilized, wherein the user specifies

the extent and resolution of the grid along each parameter axis.  At each point in the grid, the value of the

statistic S is computed using one of two methods, depending on the dimensionality of the confidence

region being determined.  That is, suppose the best-fit parameters were determined by varying p adjustable

parameters, as described above, and of these p parameters we are interested in the confidence region

associated with some subset of parameters q, where q p≤ .  In the case that q = p, the value of S at each

point on the grid is determined directly from equation (15).  On the other hand, in the case that q < p, the

value of S at each point on the grid is determined in IMD using the minimization algorithm described in
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the previous section, but with only (p - q) adjustable parameters, i.e., q of the parameters are now fixed.

In this case, we note that the correct value of ∆S( )′α  to be used in equation (17) is equal to the value of

the χ2 probability function with q (not p) degrees of freedom and significance ′α .  As an example of a

situation for which q < p, consider the case of making a determination of thin film optical constants from

reflectance vs. incidence angle data, where three adjustable parameters have been used, say  the optical

constants n and k, and the film thickness, d  but of these three parameters, we are interested only in the

uncertainty on the derived values of n and k, and so we must compute the associated 2-dimensional

confidence region in n-k space.  A specific example of a confidence interval computation which illustrates

the concepts described here will be presented in Section 4.4.

3. User Interface

I now describe the IMD graphical user interface (GUI). This interface, which is created from the

widgets tool kit built into IDL,  is used to specify all parameters and variables, and to visualize the results

of all calculations.

Shown in Figure 5 is the main IMD widget as it might look after a periodic multilayer and

associated independent and dependent variables have been specified.  In addition to the menu bar at the

top of the widget, there are three regions of this widget of particular interest to us now: the STRUCTURE

region, and the INDEPENDENT and DEPENDENT VARIABLES regions.

3.1 Structure Specification

The first step in performing a calculation in IMD is defining the ‘structure’, i.e., the parameters

that define the ambient material, the multilayer stack, and (optionally) a substrate. There are a number of

parameters that can be assigned to each structure element, i.e., layer thicknesses, interface

roughness/diffuseness parameters, etc.  But common to all structure elements is the material designation,

which determines which optical constants are used for the calculation, as described in the next section.
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3.1.1 Material Designation

Each structure element - the ambient, the substrate, and each multilayer stack layer element - is

composed of some material. There are two different methods available to the user to designate materials in

IMD: in the first method, the designated material name refers to an optical constants file contained in the

IMD optical constant database;  in the second method, which is applicable only in the X-ray region for

energies between 30 eV and 30 keV, the material is specified by its composition and density, and the

optical constants are computed directly from the atomic scattering factors.

The IMD optical constants database is a directory of ASCII files, where each optical constants

file contains three columns of optical data (λ, n and k) associated with a single material.  To designate a

material by reference to an optical constants file, the user need only specify a valid file name contained in

the optical constants directory. For example, shown in Figure 6(a) is a typical IMD layer widget where the

material has been designated as amorphous Al2O3, i.e., corresponding to a file called ‘a-Al2O3.nk’.

The IMD optical constants database contains data for over 150 materials, compiled from a variety

of published sources, with wavelength coverage extending from the X-ray to the far infrared region of the

spectrum. In order to use additional optical constants, a user need only create an ASCII file containing the

optical constants for the desired material, in accord with a simple format specified in the IMD

documentation.  For many materials, the user can choose from among several data sets already available

in the database.  The contents of any of the files contained in the database can be displayed graphically

using an interactive plot widget, available through a pull-down menu option from the main IMD widget.

The basis for the second method of material designation  by composition and density   is that

in the X-ray region, the complex index of refraction for a compound of density ρ is related to the atomic

scattering factors f1 and f2 by 3

n ≅ −
+∑

∑
1

2

2

2
2

1 2e N

m c

x f i f

x A
a

e

j j j
j

j j
j

π
λ ρ

( ), ,

, (18)



17

where the sums range over each of the chemical elements that comprise the compound, the xj are the

relative concentrations of each element, and the Aj are the associated atomic densities; e, me, c, and Na are

the electron charge, the electron mass, the speed of light, and Avogadro’s number, respectively. To utilize

this method of material designation, the user must specify the atomic composition (i.e., the xj) and the

density of the material, as illustrated in Figure 6(b), for example, showing the layer widget for a layer

composed of Cr3C2 having a density of 6.68 gm/cm3.

3.1.2 Layer and Group Parameters

To create an IMD structure, the user adds layers, periodic multilayers,14 and optionally a

substrate as desired.  Accomplishing these tasks is simply a matter of pushing the appropriate buttons on

the main IMD widget (i.e., on the right side of the STRUCTURE area of the widget shown in Figure 5.)

Layers and periodic multilayers can be subsequently grouped together to form higher level periodic

multilayers (with no limit on nesting depth), and can be moved up or down in the stack, again by pushing

the appropriate buttons.    The structure components are listed on the main IMD widget (on the left side);

by double-clicking on a structure element, the associated ambient, layer, multilayer, or substrate widget is

created, allowing the user to specify adjustable parameters (e.g., materials, layer thicknesses, interface

parameters, multilayer repeat periods, etc.), as well as the preferred units (i.e., Å, nm, µm, etc.), and the

displayed precision of parameter values.   Thus, rather complicated structures can be defined or changed

quickly and with relative ease.

3.2 Variable Designation

For all calculations, at least one wavelength (or energy) and incidence angle must be specified;

multiple wavelengths and/or angles can be specified as well, if desired. (In the case of electric field

intensity calculations, a third independent variable   depth, i.e., the position in the structure, measured

from the top of the first layer   must also be defined.)  In addition to these variables, any of the

parameters that describe the multilayer stack (i.e., layer thicknesses, interface σ values, graded interface

parameters, multilayer parameters, etc.)  or the incident beam (i.e., polarization parameters f and q, and
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angular and spectral resolution) can be designated as independent variables; up to eight independent

variables can be designated simultaneously, and the dimensionality  of the resulting optical functions will

be equal to the number of independent variables specified.

For every independent variable so designated, the user must define the extent and resolution of

the grid of points over which the optical functions are to be computed. The resolution of the grid can be

designated either by specifying the size of the increment between points, or by the total number of

parameter values that comprise the independent variable; Logarithmically spaced grids can also be

designated.  The user can again specify the preferred precision and units, and in the case of wavelengths

(or energies) the instrumental resolution and polarization parameters; the angular instrumental resolution

is likewise specified using the incidence angle independent variable widget.

Once the structure and independent variables are defined, any or all of the optical functions R, T,

and A, and the electric field intensity I, can be computed, by selecting these functions in the

DEPENDENT VARIABLES area of the main IMD widget (see Figure 5.) By then choosing the

appropriate menu option, the computation is performed and the results displayed using another GUI tool,

IMDXPLOT.  Specific examples illustrating the functionality of IMDXPLOT will be presented in

Section 4.

3.3 Fit Parameter Designation

As described in section 2.2, parameter estimation using non-linear, least-squares fitting can be

performed, utilizing user-supplied experimental data.  The experimental data is read by accessing a menu

option from the main IMD widget, and the Parameter Estimation and Confidence Interval widget, shown

in Figure 7(a),  allows the user to add and remove adjustable (fit) parameters, and to specify the

parameters that control how the fitting is performed (i.e., number of iterations, weighting, etc.)  Shown in

Figure 7(b) is a typical Fit Parameter widget, wherein the user specifies the initial parameter value (and

optionally constraints on the fit parameter), as well as the parameters associated with confidence interval

computations, as described above in Section 2.2.2.
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4. Examples

4.1 Multi-Dimensional Optical Functions of a Thin Film

The first example demonstrates how IMD can be used to visualize multi-dimensional optical

functions:  I present the results of a computation of the reflectance and transmittance of an amorphous

carbon film15 on an amorphous SiO2 substrate, determined as a function of three independent variables:

wavelength, for 150 nm < λ < 2.0 µm, i.e., from the UV to the infrared; incidence angle, for 0° < θ < 90°;

and film thickness, for 0 Å < d < 1000 Å.

To visualize the results of  this computation, one might imagine displaying one-dimensional

graphs of R and T, for example, as a continuous function of one variable, θ, say, and for discrete values of

λ and d.  Or, perhaps it would be more useful to display a plot in two dimensions, as a continuous function

of two variables, and for discrete values of the remaining independent variable.  The IMDXPLOT widget,

which is the interactive visualization tool in IMD, indeed allows the user to display such ‘slices’ of the

optical functions, in either one or two dimensions.  For example, presented in Figure 8 are some of the

results of the computation just described.  Figure 8(a) shows superposed 2-dimensional surface plots of

R (θ, λ) and T (θ, λ), for two discrete values of the film thickness, 100 Å and 350 Å.  In Figure 8(b), on

the other hand, are 1-dimensional plots of R (d) and T (d), as well as the transmitted phase, φT(d), at

normal incidence, for two discrete wavelengths, 193 nm and 248 nm (i.e., the wavelengths used for DUV

lithography.)  Using the buttons, sliders, and menu options available on the IMDXPLOT interface, the

user can easily display such slices through parameter space, and customize the graphs according to their

preference: multiple optical functions can be superposed, the appearance (i.e., colors, line-styles, plotting

symbols, etc.) of the different functions can be adjusted, and various legends and plot-labels can be

generated.  Additionally, the sliders associated with each of the independent variables (shown in the

INDEPENDENT VARIABLES region of the IMDXPLOT widgets in Figure 8, for example) can be used

to vary in real time one or more independent variables and view the resulting effect on the optical
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functions.   A variety of standard graphics file formats (i.e., PostScript, PCL, HPGL, and CGM) are

available for output.

4.2 Reflectance and Electric Field Intensity for an X-Ray Multilayer Film

The second example shows how IMD can be used to adjust, for optimal performance, design

parameter values of a periodic multilayer. A determination of the electric field intensity in a periodic

multilayer film is presented as well.  Shown in Figure 9(a) is an IMD-generated plot, showing the normal

incidence soft X-ray reflectance of a Y/Al periodic multilayer film (d=90 Å, N=40), as a function of one

particular design parameter, the film thickness ratio, Γ (where Γ ≡ +d d dY Y Al/ ( ) .)  By using IMD to

compute R(Γ), the optimal value of Γ (i.e., giving the highest peak reflectance) is immediately evident.

Optimized values of other design parameters can be similarly obtained.

Displayed in Figure 9(b) is an IMDXPLOT widget showing the electric field intensity as a

function of depth for the Γ = 0.5 Y/Al multilayer, for two values of λ.   An observation of the position of

the local maxima of the electric field intensity in the standing-wave pattern at λ=192 Å (i.e., the

wavelength corresponding to the peak reflectance) suggests, for example, that any interface imperfections

at the Al-on-Y interfaces, where the electric field intensity is strongest, might have a much different effect

on the peak reflectance than interface imperfections at the Y-on-Al interfaces, where the electric field

intensity is much weaker.

4.3 XRR Analysis of a W/Cr Bilayer

The third example demonstrates how the unique ability in IMD to interactively vary model

parameters ‘manually’ can be used, in conjunction with the non-linear, least-squares fitting capability, to

accurately determine a large number of film parameters from experimental data.

Shown in Figure 10 are the measured and calculated grazing incidence X-ray reflectance-vs.-

incidence-angle curves for a W/Cr bilayer thin film.  These particular films are currently being used as the

electron scattering layers in masks for a projection electron-beam lithography tool currently being

developed16 (SCALPEL®,)  in which the image contrast achieved at the focal plane of the tool depends
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critically on the W and Cr layer thicknesses and densities.  A precise measurement of these parameters is

thus required, and such a measurement can be obtained through the use of XRR analysis, using the curve-

fitting techniques described in Section 2.2.  However, even for these relatively  simple bilayer  films, there

are a number of additional parameters in the model that must be varied in order to fit the data with

sufficient accuracy.  For example, the best-fit curve shown in Figure 10 (labeled ‘σ=3.5 Å’) was obtained

by fitting eight adjustable parameters: the densities, layer thicknesses, and interface roughnesses of both

the W and Cr layers, as well as the thickness and roughness of a top layer oxide (WO3) that forms on

these films.

In order to utilize non-linear, least-squares curve-fitting to determine fit parameters, the choice of

initial parameter values must be relatively close to the final, ‘best-fit’ values, or else the fitting algorithm

will be unable to locate the global minimum in parameter space corresponding to the minimum value of

the χ2 statistic.   This point is especially true in this particular example, where the fitting was performed

with so many adjustable parameters. The ability in IMD to first vary parameters ‘manually’ (as described

in Section 3.2) and to visualize in real-time the resulting effect on the optical functions (reflectance, in

this case), greatly facilitates the task of determining initial fit parameter values.

To illustrate, in order to fit the data shown in Figure 10, one might start (using bulk densities) by

manually varying the W and Cr layer thicknesses, until both the high-frequency and low-frequency

modulations in the calculated reflectance are reasonably coincident with those in the measured data.

These two superposed modulations (seen in Figure 10 as having periods of ~0.18° and ~1.0°,) correspond

to interference due to the total film thickness (i.e., WO3 + W + Cr layer thicknesses) and the Cr layer

thickness, respectively.  Therefore, it’s especially useful to be able to manually vary two (or more) layer

thicknesses in a single calculation, and to view the results interactively using IMDXPLOT, in order to

match both modulations simultaneously.  Nonetheless, the W and Cr layer thicknesses will generally need

significant refinement once other parameters are varied as well, as the effect on the reflectance of other

adjustable parameters are effectively coupled to the layer thicknesses.  An example of such a coupling can

be seen in Figure 10, where reflectance curves are shown for several values of the W layer roughness: it



22

can be seen that the thickness modulations shift significantly with roughness (σ), an effect that cannot be

completely de-coupled from the effect of the individual layer thicknesses.

4.4 Optical Constants Determination for a Thin Film

The final example illustrates the ability in IMD to compute confidence intervals, in order to

estimate the precision of fit parameters determined from non-linear, least-squares curve-fitting.  Shown in

Figure 11(a) are the results of non-linear, least-squares curve-fitting to determine, from reflectance vs.

incidence angle measurements, the optical constants (n and k) for a thin film.  Once the best-fit

parameters were found (as indicated in Figure 11(a)), the value of the χ2 statistic S was computed over a

grid of points in parameter space, as described above in Section 2.2.2.  The result of this computation are

displayed in the IMDXPLOT widget shown in Figure 11(b), where the contours-of-constant-S are shown

in two-dimensions, corresponding to the 68% (i.e., ‘1-σ’) and 95% (‘2-σ’) joint confidence regions.  The

IMDXPLOT sliders in this case can be used to vary the value of ∆S( )′α  (see equation 17), or to vary the

parameter values when displaying contours-of-constant-S  in one dimension (not shown.)

5. Summary

I have described the physics and algorithms on which the IMD computer program is based, and

have presented a number of examples that illustrate some of IMD’s unique capabilities. Future

enhancements to IMD’s capabilities will include the ability to compute the non-specular (diffuse) scattered

intensity due to interfacial roughness, the ability to define depth-graded thicknesses and interface

parameters, and tools to allow the user to further analyze interactively the computed optical functions

(e.g., minimum and maximum values, feature widths, averages, integrals, etc.)  The software is available

for free, and can be downloaded from the website listed in reference (2).
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Table 1. Interface profile functions, p(z), and the associated Fresnel reflection coefficient modification

factors ~( )w s  (from reference 7) available for use in IMD.



Figure Captions

Figure 1. Diagram of a plane wave incident at the interface between two optically dissimilar materials.

Figure 2.  Sketch of the interface profile function p(z), which describes a rough or diffuse interface.

Figure 3. Diagram of a multilayer stack containing N layers, where the optical constants,  thickness,

propagation angle, and interface roughness/diffuseness parameter of the i th layer are ni, di, θi and σi,

respectively.  The ambient (i.e., the region above the film) has optical constants na, and the substrate has

optical constants ns.

Figure 4. Diagram of a graded interface of width wg, consisting of Ng = 3 layers.  In this case, the

distribution parameter Xg is slightly less than 0.5, approximately.

Figure 5.  The main IMD widget, as configured to compute the normal incidence reflectance of a Y/Al

multilayer as a function of wavelength and layer thickness parameter Γ.  (The results of this particular

computation are presented in Section 4.2)

Figure 6.  A typical IMD layer widget, with material designation (a) by reference to an optical constants

file, and (b) by specification of material composition and density.

Figure 7.  (a) The IMD Parameter Estimation and Confidence Interval widget (configured for the curve-

fitting example in Section 4.3,) and (b) a typical Fit Parameter widget (configured for the confidence

interval computation example in Section 4.4.)

Figure 8.  Results of the computation of reflectance and transmittance of an amorphous carbon film on an

amorphous SiO2 substrate, as described in the text. (a) The IMDXPLOT widget showing two-dimensional

surface plots of reflectance and transmittance versus incidence angle and wavelength, for discrete values

of the carbon film thickness. (b) One-dimensional plots of reflectance, transmittance, and transmitted

phase versus film thickness, at normal incidence, and for two discrete wavelengths.
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Figure 9. (a) Reflectance of a Y/Al periodic multilayer film as a function of the film thickness ratio, Γ. (b)

Electric field intensity as a function of depth into the film, for two wavelengths.

Figure 10.  Measured grazing incidence X-ray reflectance for a W/Cr bilayer film (filled circles) and

calculated reflectance curves for different values of the W layer interfacial roughness (as indicated.)

Figure 11. (a) Results of non-linear, least-squares curve-fitting to determine, from reflectance vs.

incidence angle measurements, the optical constants (n and k) for a gold film. (b) An IMDXPLOT widget

showing joint confidence intervals associated with the best-fit values of the optical constants.
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What's New in Version 4.0
IMD Version 4.0 includes several major new features:

●     Non-specular reflected intensity calculations

Computations are performed using either a dynamical Born approximation vector theory [4], or 
the so-called 'Distorted-Wave Born Approximation' formalism [5-8], a scalar theory which is 
nonetheless valid below the critical angle of total external reflection in the X-ray region. 

Two power-spectral-density (PSD) function models are available: a PSD function based on the 
stochastic model of film growth and erosion developed by D. Stearns (see below), and a more 
conventional PSD function parameterized by roughness, correlation length, and jaggedness 
parameters. 

●     A stochastic model of thin film growth and erosion

The model can be used to account for the evolution of  interfacial roughness through the film 
stack [9], and can be applied to both specular and non-specular optical function calculations. 

●     Depth-graded multilayers

A choice of depth-grading profiles is available to model aperiodic multilayer films. When using 
the conventional PSD function (see above,) depth graded roughness and correlation length 
parameters can be defined as well.

●     Coupled parameters

An unlimited number of structure parameters (optical constants, compositions, densities, layer 
thicknesses, PSD parameters, etc.,) can be coupled to one another. Thus, a single independent 
variable or fit parameter can be used to adjust multiple parameters simultaneously.

●     High-energy optical constants and atomic scattering factors
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Atomic scattering factors and optical constants now extend to 100 keV.

●     New specular optical functions

Ellipsometric psi and delta functions, and user-defined specular optical functions (for example, 
Rs/Rp, T3/R, or whatever) can be computed.

●     Enhanced graphics

Several new features have been added to the IMDXPLOT visualization tool: 

❍     There are now four ways to display 2D optical functions: surface plots, contour plots, filled 
color contour plots, and superimposed contour/color image plots.

❍     Interactive zoom and window resizing is now available.
❍     A new IMDXPLOT Tools menu allows for (a) live cross-hair display on 1D and 2D 

contour plots (with live 1D-slices), and (b) region-of-interest analysis: periodicities, min 
and max, average, integral, full-width-half-max, and full-width-half-min.

What's New in Version 4.1
●     Parameter Estimation

In addition to the Marquardt (CURVEFIT) algorithm, IMD now includes C. W. Markwardt's 
implementation of the (more robust) Levenburg-Marquardt (MINPACK-1) fitting algorithm.

Fit parameter values - as well as a'live' plot - are now displayed during curve-fitting, showing the 
progress of the fit with each iteration.

Offsets and/or Scale Factors can be added to your measured data. In addition, Offsets and/or Scale 
Factors can be designated as fit parameters.

In addition to these changes, uses may wish to consult the RELEASE_NOTES.
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1.1 System Requirements

IMD is written in the IDL language, and will run on any platform supported by IDL. Little or no IDL 
expertise is required to use IMD. 

You will need a valid, licensed copy of IDL to run IMD. IDL version 5.0, 5.1 or 5.2 is required; Version 
5.1/5.2 is strongly recommended, especially for Windows and Macintosh platforms. IDL is available 
from Research Systems, Inc, <http://www.rsinc.com>

Note: IMD will not run with the Student Version of IDL.

Note: It is possible to run IMD as an 'extension' to the XOP program, which is available for Unix 
and Windows platforms, free of charge  to research institutes and non-profit organizations. 
Information on XOP can be found at 
<http://www.esrf.fr/computing/expg/subgroups/theory/idl/xop/xop.html>.  Please consult the 
instructions in Section 7 of the IMD README file for further details on using IMD as a 
XOP extension.
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---------------------------------------------------------------------------

1. SYSTEM REQUIREMENTS

IMD is written in the IDL language, and will run on any platform
supported by IDL. Little or no IDL expertise is required to use IMD.

You will need a valid, licensed copy of IDL to run IMD. IDL version
5.0, 5.1 or 5.2 is required; Version 5.1/5.2 is *strongly*
recommended, especially for Windows and Macintosh platforms. IDL is
available from Research Systems, Inc, <http://www.rsinc.com>

      NOTE: IMD will not run with the Student Version of IDL.

      NOTE: It is possible to run IMD as an 'extension' to the XOP program,
      which is available for Unix and Windows platforms, free of charge to
      research institutes and non-profit organizations. Information on XOP
      can be found at
      <http://www.esrf.fr/computing/expg/subgroups/theory/idl/xop/xop.html>.
      Please see section 7 of this document for further instructions.

---------------------------------------------------------------------------

2. DOWNLOADING IMD

There is only one IMD distribution, and it should run on any platform
supported by IDL.  For your convenience, however, I have created
several different download files, making it easier for you to unpack
IMD on your particular platform. (The contents of the three download
files are virtually identical, however.)  Choose whichever one you
like.

Download files:

        Unix: imd.tar.Z
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        Windows: imd.zip

        MacOS: imd.hqx

(Note that you may need to explicitly configure your browser to save
the download file directly to disk.)

---------------------------------------------------------------------------

3. UNPACKING IMD

To unpack the file you downloaded, follow the instructions below for
your specific platform. When you have finished unpacking the
distribution, you will find two directories: "imd" and "windt".  The
total distribution requires approximately 38 MB of disk space,
including approximately 15 MB for the IMD optical constants and atomic
scattering factors databases, ~3 MB for the hypertext documentation,
and ~12 MB for the examples files.  (The examples files are optional
and can be deleted if necessary; consult Appendix B.1 of the IMD
documentation for additional help on conserving disk space.)

        Unix 

        o Unpack the imd.tar.Z file, using the Unix uncompress and tar
        commands:

                $ uncompress -c imd.tar.Z | tar -xvf - 

        Windows

        o Use the (32-bit) WinZip shareware program to unpack the
        imd.zip file.

        MacOS

        o Use the Stuffit Expander freeware program to unpack the
        imd.hqx file; the "imd" and "windt" folders will be located
        in the newly-created "imd.sea Folder".

---------------------------------------------------------------------------

4. INSTALLING IMD

The IMD distribution is contained entirely in the directory (or
folder, if you prefer) called imd. Within this directory are the IMD
programs, and the subdirectories containing optical constants, atomic
scattering factors, documentation, and examples.

The main IMD program is distributed as an IDL SAVE file, and all the
required IDL procedures and functions are already loaded, so you will
not need to include any other directories in your IDL path.  However,
included along with the imd directory is the directory called windt,
which contains a variety of IDL programs for general use, many of
which are used by IMD. (But again, these files are not needed by IMD
as they are already compiled into the IMD SAVE file.) When you unpack
the file you downloaded from the web, you will find both the imd and
windt directories.

The imd directory should nominally be installed in a directory that
you must create called user_contrib, inside the main IDL
directory. That is, you should end up with a directory called
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..../idl/user_contrib/imd (using Unix "notation".) You can also
install the windt directory in the user_contrib directory if you
choose.

Consult Appendix B.1 of the IMD documentation if you need to install
IMD someplace else, and for instructions on other IMD customization
options.

---------------------------------------------------------------------------

5. STARTING IMD

Before you attempt to start IMD, make sure that the imd directory is
included in your IDL Path.  Consult the IDL manuals for instructions
on how to do this.

To start IMD, at the IDL prompt type:

IDL> .run imdstart

This will load IMD and launch the main IMD program. If you exit IMD
and wish to run it again during the same IDL session, at the IDL
prompt type:

IMD> imd

Note: You can define NORUN=1 before executing '.run imdstart', to
inhibit automatic execution of the imd procedure.

Note: On Unix platforms, the IDL_DEVICE environment variable must be
set to 'X'.

---------------------------------------------------------------------------

6. GETTING HELP

A complete hypertext manual explaining how to use IMD is included with
the IMD distribution.  Users are *strongly* encouraged to have a look at
this material in order to fully appreciate the many unique capabilities
of IMD.  Point your browser to the file .../imd/docs.dir/index.html. 

In addition, there are several IMD files in the examples.dir directory
that illustrate some of the features of IMD, so you might want to have
a look there.

---------------------------------------------------------------------------

7. USING IMD AS A XOP EXTENSION

(If you will use IMD with a licensed copy of IDL, you can skip the
following instructions.)

A. To install IMD as a XOP extension, perform the following four
steps:
        
i. Download and install the XOP program, as described at the XOP website:
<http://www.esrf.fr/computing/expg/subgroups/theory/idl/xop/xop.html>.

ii. Download and unpack the IMD distribution, following the
instructions given above in section 2 and 3. Install the imd directory
in the XOP extensions directory. When you complete this step, you
should end up with a directory called .../xop/extensions/imd.

iii. Copy and rename the appropriate imd4xop.sav_V file - where V=50
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for the version of XOP built from IDL version 5.0, V=51 for the
version of XOP built from IDL version 5.1, and V=52 for the version of
XOP built from IDL version 5.2 - from the imd directory to the XOP
extensions directory. When you complete this step, you should end up
with a file called .../xop/extensions/imd4xop.sav. That is:

        for XOP / IDL V5.0: 

        copy .../extensions/imd/extras.dir/imd4xop.sav_50
        to .../extensions/imd4xop.sav

        for XOP / IDL V5.1: 

        copy .../extensions/imd/extras.dir/imd4xop.sav_51 
        to .../extensions/imd4xop.sav

        for XOP / IDL V5.2: 

        copy .../extensions/imd/extras.dir/imd4xop.sav_52
        to .../extensions/imd4xop.sav

iv. Using a text editor, edit the xop_extensions.lis file and add the
single line:

        imd4xop.sav

Consult Appendix B.1 of the IMD documentation for instructions on
other IMD customization options.

B. Starting IMD as a XOP extension:

There are two (platform-specific) ways to run IMD as a XOP extension:

For Unix platforms:

        At the unix system prompt, type:

        xop imd4xop

        -or-

        From the main XOP window:

        a. Select Tools -> IDL Macro
        
        b. Clear the window and type imd4xop
        
        c. Select File -> Quit and accept changes

For Windows platforms:

        Assuming your XOP installation directory is c:\xop, double-click 
        on the file:

        c:\xop\extensions\imd\extras.dir\imd4xop.bat

        Note: If your XOP installation is different from c:\xop, you will 
        need to edit the imd4xop.bat file accordingly.

        -or-

        From the main XOP window:

        a. Select Tools -> IDL Macro
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        b. Clear the window and type imd4xop
        
        c. Select File -> Quit and accept changes

---------------------------------------------------------------------------
---------------------------------------------------------------------------
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1.2 Downloading IMD

The latest version of IMD can be downloaded starting from the following URL:

<http://www.bell-labs.com/user/windt/idl>

(To unpack the download file, follow the instructions in the IMD README file.)

Back | Contents | Next
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1.3 Installing IMD

The IMD distribution is contained entirely in the directory (or folder, if you prefer) called imd. Within 
this directory are the IMD programs, and the subdirectories containing optical constants, atomic 
scattering factors, documentation, and examples.

The main IMD program is distributed as an IDL SAVE file, and all the required IDL procedures and 
functions are already loaded, so you will not need to include any other directories in your IDL path. 
However, included along with the imd directory is the directory called windt, which contains a variety 
of IDL programs for general use, many of which are used by IMD. (But again, these files are not needed 
by IMD as they are already compiled into the IMD SAVE file.) When you unpack the file you 
downloaded from the web, you will find both the imd and windt directories. 

The imd directory should nominally be installed in a directory that you must create called 
user_contrib, inside the main IDL directory. That is, you should end up with a directory called 
..../idl/user_contrib/imd (using Unix "notation".) You can also install the windt directory in 
the user_contrib directory if you choose. 

Consult Appendix B.1 if you need to install IMD someplace else, and for instructions on other IMD 
customization options. 

Back | Contents | Next
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B.1 Customizing the installation

If you will use IMD with a licensed copy of IDL, and you choose not to install the imd directory inside 
of the user_contrib directory in the main IDL directory, then you must edit the file 
imdsiteconfig.pro, located in the imd directory. The file imdsiteconfig.pro contains 
executable IDL code (although the program itself will not run if you just type .run 
imdsiteconfig.pro at the IDL prompt.) You must change the value of the imdhome variable in 
this file so that it refers to the actual IMD installation directory.

There are several other parameters you can adjust in this file:

●     You can specify default widget fonts to be used by IDL, as per your preference: set the value of 
the font_w variable to the name of a valid IDL widget font for your site. In addition, you can tell 
IMD how to display the angstrom symbol and the greek "mu" symbol for the font you specify.

●     You can add additional optical constant directories to the default IMD optical constants search 
path (so that you don't have to add them using the IMD menu option described in Section A.2.) 
The variable imd_nkpath in imdsiteconfig.pro is a string array containing the list of 
optical constant directories to be searched by IMD. 

●     The sp_max_array_size and ns_max_array_size parameters can be adjusted according 
to the memory limitations of your computer. That is, you might be able to avoid the 'Not enough 
memory to make array' error message when trying to calculate large arrays, under certain 
conditions:

For specular optical functions, the largest arrays that IMD will attempt to create to perform 
the actual computation are proportional to (number of wavelengths) x (number of angles) x 
(number of layers). So if you get the 'Not enough memory' message when computing 
specular optical functions as a function of multiple wavelengths, you can try 
DECREASING the sp_max_array_size parameter. 

For non-specular reflected intensities, the 'Not enough memory' error is most likely to 
occur when using the Omega/Nu/N PSD model, if you have defined large Nu values or 
Omega values equal to zero. In this case, IMD will need to create arrays that are 
proportional to (number of angles) x (number of layers) x (number of layers), where 
(number of angles) is equal to the number of incidence angles for Rocking and Offset 
scans, and the number of scattering angles for Detector scans. So if you get the 'Not 
enough memory' message when computing non-specular reflected intensities as a function 
of multiple angles using the Omega/Nu/N PSD model under the circumstances just 
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mentioned, you can try DECREASING the ns_max_array_size parameter. 

Also, these parameters can be decreased if you find that your computer is using a lot of virtual 
memory (i.e., spending a lot of time swapping to disk). Note, however, that decreasing 
sp_max_array_size or ns_max_array_size too low will result in a large speed penalty. 

CONSERVING DISK SPACE

If you need to conserve disk space, there are a number of files that are included in the imd distribution 
that are optional, and can be safely deleted. Specifically, the examples.dir directory contains many 
examples files, all of which can be deleted. Also, three versions of the IMD binary file are shipped: one 
to be used with IDL version 5.0, called imd_50, another to be used with IDL version 5.1, called 
imd_51, and another to be used with IDL version 5.2, called imd_52. If you are sure you will only 
use one version of IDL (V5.0, V5.1, or V5.2), then you can delete whichever IMD binary files are not 
going to be used. Finally, this hypertext documentation is non-essential, and so the entire docs.dir 
directory can also be removed. 
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A.2 Using your own optical constants

If you wish, you can use your own optical constants with IMD. To add you own optical constants, you 
must follow these two steps:

1) Create an nk file, according to these conventions: the file must consist of three columns of data 
(lambda [in angstroms], n, k). You can include comments (preceded by semicolumns in the first column) 
at the beginning of the file, but there can be no comments or blank lines anywhere else in the file. (Make 
sure there are no blank lines at the end of the file!) You should also follow the file-naming convention 
described in the previous section. When creating plots, IMD can display the reference portion of the file 
name as a subscript. (See the File->Global Plot Preferences->Material Names 
option.) Also, any numbers in the Material name are displayed as subscripts, e.g., the "2" in SiO2 will be 
displayed as a subscript.

2) Tell IMD where to find the file you've created. This is done by selecting Materials/Optical 
Constants->Optical Constants Search Path from the IMD menu bar. A widget will 
appear that allows you to add and subtract directories to the IMD optical constants search path; you can 
also adjust the order of directories searched, as IMD will search the directories in the order listed, and 
will use the first file found that matches the material name you specify. Note that the default optical 
constants search path can be changed as desired by editing the imdsiteconfig.pro file. See 
Appendix B.1 for details.

If you wish, you can also create a file called AAACATALOG.TXT, to be kept in your personal optical 
constants directory, so that you will be able to use the Materials/Optical Constants -> 
Browse Optical Constants Database option to view the contents of your files using 
XNKPLOT directly from IMD. Follow the same format that's used in the AAACATALOG.TXT file in 
nk.dir,

Back | Contents | Next
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A.1 The IMD optical constant database

The IMD optical constant database is located in the directory called nk.dir, in the imd directory. 
Optical constant files are designated by a '.nk' extension, and are ASCII files containing three columns of 
numbers: wavelength (in angstroms), n, and k. Comment lines (beginning with a semicolon) may precede 
the data.

Each 'nk' file in nk.dir corresponds to one material, although there is usually more than one nk file for 
any given material. The naming convention I have adopted for nk files is Material_reference.nk. 
For example, the file Si_palik.nk corresponds to the optical constants for silicon, taken from the 
optical constant handbook by Palik [18]; the file Si_llnl_cxro.nk corresponds to other data for 
silicon, in this case data in the X-ray region compiled from the LLNL and CXRO atomic scattering factors 
(see section A.3 below.) Source reference information is usually included as a comment at the beginning 
of the file. In addition to these source-specific files, for every material I have created compilation files that 
cover as wide a range in wavelength as possible. The compilation files include no reference in the name. 
For example, the file Si.nk is a compilation of the data from Si_llnl_cxro.nk and 
Si_palik.nk, and spans the range from 0.124 angstroms to 3.33e6 angstroms.

To use a specific file for a given material, enter the full name of the file (excluding the .nk extension) in 
the Material fields in the relevant ambient, layer, or substrate widgets (be sure that the Optical 
constants file name button is checked, rather than the Composition and density button.). For 
example, to use the data for silver published by Hagemann, et al, specify Ag_hagemann, instead of just 
plain Ag.

The nk files contained in the nk.dir directory are listed in the file called AAACATALOG.TXT, which is 
also located in nk.dir. This file is displayed when you select Materials/Optical Constants -
> Browse Optical Constants Database from the IMD menu bar.
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A.3 Creating new X-ray optical constants

If there is a material that you wish to model using IMD in the X-ray region that is not included in the 
IMD optical constants database, as an alternative to designating that material by composition and density 
as described in Section 2.1, you can generate a file of optical constants over the entire 30 eV to 100 keV 
photon energy range using the program IMD_F1F2TONK. You can then designate IMD structure 
element materials by reference to this file. (Many of the files in the IMD optical constants database were, 
in fact, created using this program.)

The IMD_F1F2TONK program can be run independently of IMD, by typing imd_f1f2tonk at the 
IDL prompt, or it can be accessed from within IMD by selecting the Materials/Optical 
Constants->Create New X-Ray Optical Constants option from the main IMD menu. 

The program computes the optical constants for a compound (specified by its composition and density) 
using the atomic scattering factors, f1 and f2, as described in reference [12]. A combination of atomic 
scattering factors from two sources are used: from 30 eV to 30 keV, the program uses atomic scattering 
factors compiled by Eric Gullikson at the Center for X-Ray Optics, Lawrence Berkeley Laboratory, as 
described in reference [12]; from 30 keV to 100 keV, atomic scattering factors from the Lawrence 
Livermore National Laboratory are used, as described in reference [13]. The composite atomic scattering 
factors files are located in the directory called f1f2.dir in the imd directory. 

The IMD_F1F2TONK widget is show in figure A.3.1:

Figure A.3.1 IMD_F1F2TONK widget, in this example set to calculate the optical constants for Al2O3.
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To create the optical constants for a compound, you must first specify how many different elements 
comprise the compound (using the More Elements and Fewer Elements buttons), the names of 
the elements (by selecting from the list of the 92 available elements,) the relative numbers of each 
element, and the density (in grams/cm3) of the compound. The Precision menu allows you to adjust 
the number of decimal spaces displayed for both density and composition values. By selecting the 
Calculate->Optical Constants menu item, the program will read the f1 and f2 values for each 
element specified, compute the values of n and k, and plot the results. You can then save these results to 
an IMD optical constant file by selecting the File->Save menu item.
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2.1 Designating Materials and Optical Constants

The first step in performing a calculation is defining the structure. At the highest level, a structure consists of three 
components: the ambient material, the multilayer stack, and (optionally) a substrate. Although the different structure 
components are specified in somewhat different ways, as described in section 2.2, common to all structure elements is 
the material designation, which determines what optical constants are used for the calculation. This section discusses 
material designation and optical constants. 

Each structure element - the ambient, the substrate, and each multilayer stack layer element - is composed of some 
material. There are two different methods you can use to designate materials:

●     In the first method, the designated material name refers to an optical constants file contained in the IMD optical 
constant database. 

●     In the second method, which is applicable only in the X-ray region for energies between 30 eV and 100 keV, the 
material is specified by its composition and density, and the optical constants are computed directly from the 
atomic scattering factors. 

The use of the two methods for material designation is best illustrated by example. But before illustrating the 
techniques for material specification, I will describe in the next section the IMD optical constants database.

BROWSING THE IMD OPTICAL CONSTANTS DATABASE

To see which materials are available (and over which wavelengths) in the IMD optical constant database, i.e., the 
materials available for use by the first method of material specification above, select Materials/Optical 
Constants -> Browse Optical Constants Database from the menu bar. Doing so will bring up the 
catalog of available optical constants, as shown in Figure 2.1.1:

Figure 2.1.1 IMD Available Optical Constants widget
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Each available optical constant file is listed, along with abbreviated source reference and wavelength coverage 
information. By selecting an item from the catalog, two new widgets will appear: one displaying a text listing of the 
optical constants contained in the file you selected, and another (an XNKPLOT widget) showing a plot of the optical 
constants (n and k) versus wavelength. For example, shown in Figure 2.1.2 are the optical constants for silver:

Figure 2.1.2 XNKPLOT of the optical constants of Ag
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You can use the XNKPLOT Prefences menu items to adjust the appearance of the optical constants plot, and you 
can print the plot using the File->Print menu option (as if you couldn't have figured that one out.)

Consult Appendix A for more details on optical constants, including how to use your own optical constants, and how to 
create new X-ray optical constants.

MATERIAL DESIGNATION

As mentioned above, there are two different methods available for material designation in IMD. These two methods 
will now be described in more detail. Although the material designation techniques described here apply to all structure 
elements - ambient, substrate and layers - I will show how to specify the material in a layer element as a specific 
example.

METHOD 1: Material designation by reference to an optical constants file

Shown in Figure 2.1.3 is the layer widget associated with a new layer. (i.e., the widget that appears when you press the 
Add Layer button; the techniques for adding a new layer to the multilayer stack are described fully in section 2.2.)

Figure 2.1.3 An IMD Layer widget, as it appears when a new layer is added to the multilayer stack.
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The Optical constants file name button is selected by default, indicating that material designation is by 
reference to a valid optical constants file. The default layer material is "Vacuum", which means that the optical 
constants (n,k) have the value of (1.,0.) for all wavelengths. (Indeed, "Vacuum" is the default material for all new 
structure elements.) To change the material, you can enter a (valid) material name in the material field, or else press the 
Browse... button to display a choice of all available materials, as show in the next figure (entering an invalid 
material name has the same effect as pressing the Browse... button):

Figure 2.1.4 Pressing the Browse... button: the IMD material selection widget
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The material selection widget lists all available optical constant files (.nk files). You can scroll through the list of 
available files and select the material you like by clicking on the file name, and pressing the OK button. 

Note: you'll see that there are no files named 'Vacuum' available. To designate Vacuum as a material, you must 
either type 'Vacuum' in the material field (or leave it blank) and hit return.

As an example, shown in Figure 2.1.5 is the Layer widget after selecting amorphous aluminum oxide - the first choice 
in the list of available optical constants show in Figure 2.1.4. 

Figure 2.1.5: IMD Layer widget corresponding to an amorphous aluminum oxide layer.
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METHOD 2: Material designation by density and composition specification

To utilize the second method for material specification, click on the Density and composition button. Doing 
so will cause the Layer widget to appear as in Figure 2.1.6.

Figure 2.1.6: An IMD Layer widget with the Density and composition button selected. 
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When specifying a material by density and composition, you must specify how many different elements comprise the 
compound (using the More Elements and Fewer Elements buttons), the names of the elements (by selecting 
from the list of the 92 available elements,) the relative numbers of each element, and the density (in grams/cm3) of the 
compound. The Precision menu allows you to adjust the number of decimal spaces displayed for both density and 
composition values. As an example, shown in Figure 2.1.7 is a Layer widget configured to use a material consisting 
of 3 parts Cr and 2 parts C, having a density of 6.68 gm/cm3.

Figure 2.1.7: An IMD Layer widget corresponding to a layer of Cr3C2, having a density of 6.68 gm/cm3.
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Note: material specification by density and composition is applicable only in the photon energy range from 30 
eV to 100 keV (i.e., wavelengths between 413 and 0.124 angstroms.) See Appendix A.3 for more details.

Regardless of which method you use to specify a material, the results of your material selection will be listed in the 
Structure List. For example, if you have chosen water as the ambient material, the Structure List will indicate 
'ambient: H2O'.

Back | Contents | Next
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2.2 Defining a Structure: Specifying Parameters

The STRUCTURE area of the main IMD widget (shown in Figure 2.1.1) consists of the Structure List, which lists the 
current structure elements, the buttons to the right of the Structure List, which are used to add, remove, and modify 
structure elements, and the Layer Count indicator below the Structure List, which indicates the total number of layers that 
comprise the structure. 

Figure 2.2.1 The STRUCTURE area of the main IMD widget.

The techniques for defining each type of structure element - ambient, layers, and the substrate - will be described in turn 
below.

AMBIENT

When IMD first starts up cold, the only structure component listed in the STRUCTURE area of the main widget is the 
ambient (as in Figure 2.2.1). To edit the ambient parameters, double-click on the "ambient" line in the Structure List, or 
select (highlight) this line and press the Edit button (to the right of the Structure List.) This brings up the Ambient 
widget, as shown in Figure 2.2.2. 

Figure 2.2.2 IMD Ambient widget
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The material is the only parameter that can be specified for the ambient. (In contrast, there are many layer and substrate 
parameters, e.g., thicknesses, roughnesses, etc., as described below.) The default ambient material is "Vacuum". Use the 
techniques described in section 2.1, to change the ambient material.

MULTILAYER STACK

In IMD, a 'multilayer structure' consists of individual layers, which can optionally be grouped together to define periodic 
(or aperiodic, i.e., depth-graded) multilayers. You define each layer by specifying the material comprising the layer, the 
layer thickness, and the interface properties: interfacial roughness, diffuseness, power-spectral-density parameters, etc. 

Interface parameters are discussed in detail below.

LAYERS

To add a layer to the multilayer stack, press the Add Layer button to the right of the Structure List. Doing so brings up 
a Layer widget like the one shown in Figure 2.1.3 in the previous section. Use the techniques described in that section to 
specify the layer material.

For every layer, you must also specify the layer thickness, by entering the desired thickness value in thickness entry area. 
You can specify the desired length units (i.e., angstroms, nanometers, or microns) and precision using the Units and 
Precision menus.

Note: length units and precision - which affect layer thicknesses and interface parameters - are global, i.e., all 
layers are described by the same length units and precision, so any changes made in one layer widget will affect 
all others.

As an example, shown in the next figure is the layer widget associated with a layer of gold, 50 nm thick.
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Figure 2.2.3 IMD Layer widget corresponding to a 50-nm-thick layer of gold. 

To add more layers to the structure, continue to press the Add Layer button (to the right of the Structure List.) Each 
new layer will be inserted into the stack just below the currently selected (highlighted) layer. Use the Move Up and 
Move Down buttons to change the position of layers in the stack, and use the Remove and Remove All Layers 
buttons to delete selected layers.

The layers you create are listed in the Structure List, and are numbered consecutively (starting with layer number 1) from 
the top down (towards the substrate.) Layers can be edited either by double-clicking on the corresponding element listed 
in the Structure List, or by selecting a layer from the Structure List and then pressing the Edit button.

PERIODIC MULTILAYERS

Any number of layers can be grouped together to create periodic multilayers. There are two ways to define such 
multilayers:

A. Layers that have already been added to the structure can be grouped by pressing the Group button (to the right 
of the Structure List), once you have selected (highlighted) the layer that you want to designate as the top of the 
group in the Structure List. You will then be asked to choose which layer to designate as the bottom of the group; 
you must choose from a list of available layers (or multilayers) that will be presented. You can then edit the 
periodic multilayer by double-clicking on the corresponding element in the Structure List, or by selecting the 
periodic multilayer in the Structure List and then pressing the Edit button.

or

B. Press the Add Multilayer button (to the right of the Structure List). You will be prompted to enter the 
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number of different layer elements (NOT the total number of layers!) to be contained in the new periodic 
multilayer. Once you have entered the desired number of layer elements (and pressed the OK button), a widget 
appears that allows you to specify the periodic multilayer parameters.

Once layers have been grouped to form a periodic multilayer, these layers will be indented in the Structure List, and an 
additional line describing the multilayer parameters will be added to the list. For example, Figure 2.2.4 shows the 
STRUCTURE area of the main IMD widget after defining a periodic multilayer consisting of two layers. An example of 
the corresponding Multilayer widget is shown in Figure 2.2.5:

Figure 2.2.4 The STRUCTURE area of the main IMD widget after defining a 2-element periodic multilayer.

Figure 2.2.5 IMD Multilayer widget.

The Multilayer widget includes an area to enter parameters specific to the multilayer.

For a periodic multilayer, you must specify the Number of Periods, N, i.e., the number of repetitions of the 
individual layers that comprise the periodic multilayer. For example, a multilayer consisting of three different 
layers - A, B, and C - with N=2 periods, would contain a total of 6 layers: A/B/C/A/B/C. 

The Period, d of the multilayer is determined by the thickness of the individual layers that comprise the periodic 
multilayer. For example, if the A, B, and C layers just described had thickness of 1, 2, and 3 nm, respectively, then 
the multilayer period would be d=(1 + 2 + 3)= 6 nm. (The total thickness of the periodic multilayer is N x d, or 12 
nm in this example.)
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The multilayer period is indicated in both the Structure List and on the Multilayer widget. The period can be 
specified directly only in the case of periodic multilayers consisting of just two layers, in which case the Layer 
Thickness Ratio, Gamma (which is defined as the thickness of the top layer divided by the multilayer period) is 
also indicated and available for direct specification.

If desired, you can also specify a Random layer thickness error, delta(z), in order to simulate, for example, the 
thickness errors that might actually occur during the growth of a multilayer film. Doing so will result in each 
individual layer thickness differing from the specified value by a random amount; the errors follow a Gaussian 
distribution with width delta(z). For example, again using the A, B, C layers with thicknesses 1, 2, and 3 nm, with 
N=2, choosing delta(z)=.1 nm might result in the following thicknesses: A(.997 nm)/B(2.05 nm)/C(3.01 
nm)/A(1.05 nm)/B(2.01 nm)/C(3.05 nm). Note that an error will occur if you specify a random thickness error 
large enough to cause negative layer thicknesses.

Once you have defined a periodic multilayer, you can use the Move Up and Move Down buttons to rearrange the order 
of the layers (or multilayers) within the multilayer. You can remove multilayer elements (i.e., layers or multilayers) using 
the Remove button (once you have selected the element you wish to remove), and you can use the Add Layer and 
Add Multilayer buttons to insert more layers or multilayers inside of an existing multilayer. 

Note: To add layers or multilayers after an existing multilayer, highlight the top line of the existing multilayer in 
the Structure List before pressing the Add Layer or Add Multilayer button.

You can edit layers or multilayers by double-clicking in the Structure List, or by using the Edit button after selecting 
the layer or multilayer you wish to edit.

DEPTH-GRADED MULTILAYERS

It's possible in IMD to vary with depth the layer thicknesses of any or all of the individual layers that comprise a periodic 
multilayer. Figure 2.2.6 shows the layer widget for a layer element that is part of a periodic multilayer containing 200 
periods: note the button labelled 'Depth Grading...'. Figure 2.2.7 shows the Layer Thickness Depth 
Grading widget that appears when the Depth Grading... button is pressed.

Figure 2.2.6 IMD Layer widget for a layer that is part of a periodic multilayer consiting of 200 bilayers.
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Figure 2.2.7 IMD Layer Thickness Depth Grading widget for the layer shown in Figure 2.2.6.

Four different depth grading profiles are available:

Parabolic: z(i)=a+b*i +c*i^2

Exponential: z(i)=a+b*exp(c*i)

Logarithmic: z(i)=a+b*ln(c*i)

Power-Law: z(i)=a/(b+i)^c

where i is the layer index (starting with the top-most layer in the group), z(i) is the thickness of layer i, and a, b, and c are 
parameters you specify. In Figure 2.2.7, a power-law depth-grading profile is shown: for the a, b, and c parameters 
indicated in the figure, the resultant top layer (i=1) thickness is 200 angstroms and the bottom layer (i=200) thickness is 
50 angstroms. A plot of the layer thickness variation is shown in the widget as well.
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Note: when you enter values for the a and b parameters, the resultant top- and bottom-layer thicknesses are 
computed (using the currently defined c parameter); alternatively, you can specify the top- and bottom-layer 
thicknesses, and the resultant a and b parameters are computed. Specifying the c parameter will result in the 
computation of new a and b parameters based on the current top- and bottom-layer thicknesses. (Got that?)

Each layer in a multilayer can have it's own depth grading profile (or no depth grading at all, of course). However, if you 
wish to grade every layer element in a multilayer by the same relative amount, you can either specify identical profiles 
and proportional depth grading parameters for each layer, or else make use of Coupled Parameters, as described in 
Section 2.3 (the latter method is much simpler.) See Section 2.5 for a graded multilayer example. 

NESTED MULTILAYERS

Periodic multilayers can be nested inside one another if so desired. For example, suppose you wish to create a multilayer 
stack consisting of five different materials (A, B, C, D, E), arranged as follows:

A/B/C/D/E/D/E/A/B/C/D/E/D/E/A/B/C/D/E/D/E. 

A shorthand notation for this 21-layer structure is [A/B/C/[D/E]x2]x3

One way to create such a structure would be as follows: (a) Use the Add Multilayer button to create a periodic 
multilayer consisting of 2 periods of the D and E layers; (b) Use the Add Layer button three times to insert the A, B, 
and C layers on top of the [D/E] multilayer, and then (c) use the Group button to define the A/B/C/[D/E] multilayer, by 
selecting the A layer as the top element of the group, and the [D/E] multilayer as the bottom element.

LAYER-DATA FILES

In some cases, for example when you wish to model a structure consisting of a very large number of unique layers, rather 
than using the Add Layer button repeatedly, it is more convenient to read in a text file containing the required layer 
information (i.e., materials, thicknesses, etc.). To do this, use the File->Open Layer-Data File option from the 
menu bar. You will find instructions on how to create such a file in the sample_layerfile.txt file (or in the .xcl, 
.wkz, and .slk spreadsheet versions of this file) located in the directory called examples.dir in the imd directory. 
Also, once you have created a layer structure in IMD, you can save the layer information to a Layer-Data file using the 
File->Save to Layer-Data File option from the menu bar. 

Note: when saving to a layer-data file, all layer-group information is lost.

Note: layer-data files can only use materials specified by reference to optical constant data files; materials 
specification by density and composition is not possible with layer-data files.
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SUBSTRATE

The final component of an IMD structure is the substrate. Use the Add Substrate and Remove buttons to add and 
remove a substrate. A substrate is specified in a way entirely analogous to the way a layer is specified, except that a 
substrate has no thickness, i.e., a substrate is a semi-infinite slab of material. If no substrate is selected, the ambient 
material is used on both sides of the multilayer stack. 

Note: a structure consisting of just the ambient and a substrate is valid, allowing you to simulate the optical 
properties of a front-surface mirror. 

INTERFACES

Interface imperfections, i.e., interfacial roughness and diffuseness, have the effect of reducing the specular reflectance of 
an interface either by scattering light into non-specular directions, in the case of interfacial roughness, or by increasing the 
transmittance of the interface, in the case of interfacial diffuseness. A number of options are available in IMD to account 
for the effects of imperfect interfaces on the specular and non-specular optical functions. These options are described 
below.

Note: Each interface in the IMD structure is described by it's own set of interface parameters. Specifically, you can 
specify the interface parameters for the top surface of the substrate and the top surface of every layer element. In 
the case of periodic multilayers, note that there are two types of interfaces associated with the top layer in the 
stack. Thus, for example, in the case of a periodic multilayer containg A and B layers, with A on top of B, there 
are three different types of interfaces: A-on-B, B-on-A, and ambient-on-A. (Assuming there are no other layers on 
top of the A/B periodic multilayer.)

MODIFIED FRESNEL COEFFICIENTS: INTERFACE WIDTHS AND INTERFACE PROFILE FUNCTIONS

For the calculation of specular optical functions in IMD, the modified Fresnel coefficient formalism is used, as described 
in reference [2]. In the case of specular optical functions, the effects of interfacial roughness and interfacial diffuseness 
are indistinguishable: both types of imperfections reduce the reflectance of the interface. Thus, the interface can be 
characterized simply in terms of an interface profile function, p(z) (described below) and the interfacial width, sigma, as 
shown in Figure 2.2.8. 

Figure 2.2.8. Imperfect interfaces: roughness and diffuseness.
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In the case of a purely rough interface, the value of sigma refers to the rms interfacial roughness, sigmar. In the case of a 

purely diffuse interface, sigma refers to the interfacial diffuseness, sigmad. In the general case of an interface that is both 

rough and diffuse, sigma = sqrt(sigmar
2 + sigmad

2).

The interface profile function, p(z), is defined as the normalized, average value along the z direction of the dielectric 
functions, epsilon(x):

where

The resultant loss in reflectance due to interface imperfections is approximated in IMD by multilplying the Fresnel 
reflection and transmission coefficients by the functions w(s), the Fourier transform of w(z)=dp/dz, as described below. 
Five types of interface profile functions are available in IMD. These functions, and their Fourier transforms, are 
summarized in Table 2.2.1.

Table 2.2.1. Interface profile functions and Fresnel coefficient modification factors available in IMD.
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As can be seen in Figures 2.2.3 and 2.2.6 above, a droplist on the Layer widget is used to select an interface profile 
function. The sigma value can be entered on the Layer widget as well, or, as will be described below, when you select 
the Determine from PSD button, the sigma value can be computed directly from the power-spectral-density 
function.

You can also specify precisely how you wish to modify the Fresnel coefficents used to compute specular optical 
functions, specular electric field, and the electric fields used to compute non-specular optical functions.  The Modified 
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Fresnel Coefficient Preferences widget, shown in Figure 2.2.9, is available from either the File-
>Preferences menu option on the main IMD widget, or from the Preferences menu option availabel on all 
Layer and Substrate widgets. As shown in Figure 2.2.9, there are three options available:

Figure 2.2.9. Fresnel coefficient modification options.

In the first option, the Fresnel reflection coefficient at the top surface of layer i is multiplied by w(2*q_z(i)), where 
q_z(i)=2 pi cos(Theta(i))/lambda, Theta(i) is the propagation angle in the layer (determined from the incidence angle 
through Snell's law,) and lambda is the wavelength of light. The function w corresponds to the interface profile function 
you specify, as in Table 2.2.1.

In the second option, the reflection coefficient is multiplied by w(2*sqrt(q_z(i)*q_z(i+1))), (the so-called Nevot-Croce 
factor,) in accord with the formalism described in reference [3] which is valid below the critical angle of total external 
reflection in the X-ray region.

In the third option, both the reflection and the transmission coefficients are modified, as indicated in the Figure, in accord 
with the formalism described in reference [4].

POWER-SPECTRAL-DENSITY FUNCTIONS

For the calculation of non-specular optical functions, it is necessary to specify the power-spectral-density (PSD) function 
of each interface in the structure. The PSD function can also be used to compute the sigma values used in specular optical 
functions computations, by selecting the Determine from PSD button on the associated Layer or Substrate 
widget.

Two power-spectral-density functional forms are available in IMD, as indicated in the Power-Spectral-Density 
Function Preferences widget shown in Figure 2.2.10. This widget is accessible either from the File-
>Preferences menu option, or from the Preferences menu available on all Layer and Substrate widgets.

Figure 2.2.10. The Power-Spectral-Density Function Preferences widget.
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In the case of the first PSD function shown in Figure 2.2.10 (described in reference [10],) each interface is characterized 
by three parameters: the interfacial roughness, sigma_r, the in-plane, or parallel correlation length, xi_par, and the so-
called jaggedness factor, H. In addition, a (global) vertical or perpendicular correlation length parameter, xi_perp, can be 
specified as well, in order to account for correlated roughness in a multilayer. Following the formalism described in 
reference [8], the vertical correlation function describing the correlation between two interfaces i and j is given by

where j<=min(j,i), and zn is the thickness of layer n. The perpendicular correlation length, xi_perp, is specified on the 

Power-Spectral-Density Function Preferences widget.

The second PSD function available is based on the stochastic model of thin film growth and erosion described in 
reference [9]. In this case, the (intrinsic) PSD at each interface is characterized by the three parameters Omega, the 
volume element growth parameter, nu, the relaxation coefficent, and the exponent n; the intrinsic PSD also depends on 
the layer thickness z. (In the case of the substrate PSD, z does not necessarily refer to the substrate thickness, but is just 
another parameter that you must specify.) Note that in accord with this model of film growth, the total PSD at a given 
interface is equal to the intrinsic PSD at that interface (as specified by the Omega/nu/n/z parameters for that interface) 
plus the contribution of the PSD's of all the underlying interfaces; the amount of roughness that is replicated from layer to 
layer depends on the PSD parameters of each of the interfaces involved. Thus, this PSD model can be used to account for 
the evolution of roughness throughout a multilayer stack.

Note: The PSD function you select in the Power-Spectral-Density Preferences widget will apply to 
all interfaces in the structure you define. 
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Shown in Figure 2.2.11 is the Power-Spectral-Density Function widget associated with a layer that is part of 
a periodic multilayer, for the case of the sigma_r/xi_par/H PSD model. This type of widget appears when you press the 
Power-Spectral-Density... button of a Layer or Substrate widget. 

Figure 2.2.11. A Power-Spectral-Density Function widget, for the case of the sigma_r/xi_par/H PSD model.

Note that a graph of the PSD function is displayed in the widget, over the range of transverse momentum values, q_par 
associated with the incidence and scattering angles you define, as described in Section 2.3 (The range of q_par values 
associated with the non-specular scattering parameters you define are indicated by the grey region in the plot.)

Note: In the case of layers that are part of periodic multilayers, as in Figure 2.2.11, it is possible to define depth-
graded sigma_r and xi_par parameters as well, by pressing the Depth Grading... buttons shown in the 
widget. You will then be presented with a Depth Grading widget completely analagous to the graded-
thickness widgets described above.

Similarly, shown in Figure 2.2.12 is the Power-Spectral-Density Function widget for the case of the 
Omega/nu/n PSD model.

Figure 2.2.12. A Power-Spectral-Density Function widget, for the case of the Omega/nu/n PSD model.
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As can be seen in Figures 2.2.11 and 2.2.12, in addition to specifying the PSD parameter values for the interface, you can 
also specify a value of the interface diffuseness, sigma_d. The value of sigma_d will be used (along with the interface 
profile function you select) to compute the modified Fresnel coefficents (using the specified form of the Fresnel 
coefficient modification factors (Figure 2.2.9)) when computing the electric fields needed for non-specular reflected 
intensity calculations. (See references 4-8.)

If you have selected the Determine from PSD button on a Layer or Substrate widget, the sigma value used 
for that interface for computing specular optical functions via the modified Fresnel coefficient formalism described above 
will be equal to the value of sqrt(sigmar

2 + sigmad
2). In the case of the sigma_r/xi_par/H PSD model, the sigmar value 

used to compute tho total sigma value is just equal to the value of sigma_r that you specify on the PSD parameters widget. 
On the other hand, in the case of the Omega/nu/n PSD model, sigmar

2 is given by:

where fmin = 1 / Lmax , fmax= 1 / Lmin , and Lmin and Lmax must be specified by you, on the Power-Spectral-

Density Function Preferences widget, as shown in Figure 2.2.13. The q values (where q=2 pi f,) 
corresponding to the values of Lmin and Lmax you enter, are indicated as dashed blue lines in the PSD plots on the Power-

Spectral-Density Layer and Substrate widgets, as can be seen, for example, in Figure 2.2.12.

Figure 2.2.13. The Power-Spectral-Density Preferences widget, showing entry areas for Lmin and Lmax 

available when using the Omega/nu/n PSD model. 
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GRADED INTERFACES

Independent of the interface profile function, sigma, and PSD parameters you specify for a given interface, in IMD it's 
also possible to model the effects of a diffuse interface on the specular and non-specular optical functions by specifying a 
'graded' interface. That is, an abrupt interface can be replaced by one or more layers whose optical constants vary 
gradually between the values for the pure materials on either side of the interface.

In IMD, a graded interface is described by three parameters, as shown in Figure 2.2.14: the interface width, wg, the 

number of layers comprising the graded interface, Ng, and the distribution factor, Xg, which determines where the graded 

interface region resides relative to the original abrupt interface (as will be described below.)

Figure 2.2.14. A graded interface. 
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The optical constants in each of the Ng layers of a graded interface are computed as follows. Consider the graded interface 

between the ith and jth layers in a multilayer stack. The thickness of each of the Ng graded interface layers is equal to 

wg/Ng. The optical constants in the lth graded interface layer are thus given by

and 

with l=1,...Ng. The resulting layer thickness, di' and dj' of the pure materials in the ith and jth layers, respecitively, after 

including the graded interface layers, are given by 

and

with 0 < Xg < 1. (Note that the total thickness of the two layers - including all the graded interface layers - is constant, i.e., 

di' + dj' + wg = di + dj.) As an example, a distribution factor of 50% (Xg = 0.5) would result in equal reductions of the ith 

and jth layer thicknesses. 

To specify a graded interface in IMD, press the Graded Interface... button on the relevant Layer or 
substrate widget. Doing so will cause a Graded Interface widget to appear, as shown in Figure 2.2.15, in 
which you can specify values for the graded interface number of layers, the interface width, and the distribution factor.

Note: you must not specify graded interface parameters that result in layer thicknesses less than zero; doing so will 
cause the optical functions computation to be aborted.

Note: the same interface profile function, sigma, and PSD parameters are applied to every interface in a graded 
interface. 
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Figure 2.2.15. A Graded Interface widget.
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2.3 Specifying Variables and Coupled Parameters

DEPENDENT VARIABLES

Specifying dependent variables - the optical functions you wish to compute - is simple: just click on the desired variables in the 
DEPENDENT VARIABLES area of the main IMD widget:

SPECULAR OPTICAL FUNCTIONS / ELECTRIC FIELDS

Figure 2.1 shows the main IMD widget as it appears when the DEPENDENT VARIABLES button is selected, and the Specular Optical 
Functions / Electric Fields button is selected. Select whichever functions you wish to compute.

Note that for each specular optical function you select, the program will calculate the values of that property for pure s and pure p polarization, 
as well as the average value of the property for the specified polarization parameters f and q (described below). For instance, if you select 
reflectance as a dependent variable, when you actually perform the calculation the program will compute the reflectances for pure s and p 
polarization, R(s), and R(p), in addition to the average reflectance R(f,q). In the case of reflectance and transmittance, the program will also 
compute the phases of the reflected and/or transmitted waves for pure s and pure p polarizations; the ellipsometric psi and delta functions will be 
computed as well if Reflectance is selected as a dependent variable. Once the calculation is performed, any or all of these variables can be 
displayed.

USER-DEFINED SPECULAR OPTICAL FUNCTIONS

Once you have selected any specular optical functions (reflectance, transmittance, and/or absorptance) as dependent variables, you can also 
choose to calculate up to three so-called 'user-defined' optical functions. These functions are completely arbitrary combinations of whatever 
optical functions you're interested in. For example, to compute the ratio of reflectance for pure s to pure p polarization, you can define a user-
function equal to Rs/Rp, as shown in Figure 2.3.1 (i.e., the User 1 function):

Figure 2.3.1 The main IMD widget, showing some user-defined function examples.
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User-functions can make use of any of the specular optical functions you wish to calculate, and can also use any other valid IDL functions. The 
only constraints are that (a) you must use valid IDL syntax, (b) you must use the correct variable names of any IMD optical functions you 
reference, and (c) the user-functions you calculate must have the same dimensionality as all the other optical functions for a given calculation (an 
example of an invalid user function is total(Rs), which is a scalar.) 

Consult Appendix B.4 for a complete listing of all the IMD specular optical function variable names available for use in user-defined functions.

NON-SPECULAR OPTICAL FUNCTIONS

The non-specular (i.e., diffuse) reflected intensity from a multilayer film can be computed using either a dynamical Born approximation (BA) 
vector theory, described in reference [4], or the so-called 'Distorted-Wave Born Approximation' (DWBA) formalism, described in references [5-
8], a scalar theory which is nonetheless valid below the critical angle of total external reflection in the X-ray region. 

Note: In order to compute non-specular reflected intensities, you must define the power-spectral-density function of each interface in the 
structure. See Section 2.2 for details on how to do this.

Note: IMD uses the 'small roughness' approximation when computing non-specular reflected intensities, which is to say that the amount 
of light scattered from any interface is proportional to the power-spectral-density function of that interface.

Note: Please refer to the references listed above in order to appreciate the range of validity of each of these theories.

Figure 2.3.2 shows the main IMD widget as it appears when the DEPENDENT VARIABLES button is selected, and the Non-Specular 
Optical Functions button is selected. 

Figure 2.3.2 The DEPENDENT VARIABLES / Non-Specular Optical Functions section of the main IMD widget.
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INDEPENDENT VARIABLES

For all computations, you must specify one or more incidence angles, and one or more photon wavelengths or energies. These two independent 
variables are always listed in the Independent Variables List, as shown in Figure 2.2.3

Figure 2.3.3 The main IMD widget as it appears when the INDEPENDENT VARIABLES button is selected.
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To specify angles and wavelengths (or energies), either double-click on the corresponding Independent Variables List element, or use the Edit 
button (to the right of the Independent Variables List) after selecting the variable you wish to edit.

The Incidence Angles and Wavelengths/Energies independent variables widgets are shown in the next two figures:

Figure 2.3.4 Angles widget
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Figure 2.3.5 Wavelegths/Energies widget

As can be seen from these figures, you can specify the desired number of values, the range of values, or the step size for angles and wavelengths 
(or energies.) (You can also select logarithmic steps, if desired, in which case the step size entry area disappears, as the step size is no longer 
constant.)

Additionally, if three or more angles (wavelengths/energies) are specified, you can specify the Instrumental Angular Resolution (Instrumental 
Spectral Resolution), in order to simulate finite instrumental resolution. For example, if you specify an Instrumental Angular Resolution of 0.5 
degrees, then the optical functions you calculate will be convolved with a 0.5-degree-wide Gaussian function.

Note: Specifying instrumental resolution has no effect on the Electric Field Intensity calculations.

In the case of wavelengths/energies, you must also specify the Incident polarization factor, f, and the Polarization analyzer sensitivity, q. 
The quantity f is defined as the ratio (I(s)-I(p)) / (I(s)+I(p)), where I(s) and I(p) are the incident intensities of s and p polarizations. So for pure s-
polarization, specify f=+1; for pure p-polarization specify f=-1, or for unpolarized incident radiation, specify f=0. The quantity q is defined as 
the sensitivity to s-polarization divided by the sensitivity to p-polarization. Specifying a value of q other than 1.0 could be used to simulate, for 
example, the reflectance you would measure using a detector that (for whatever reason) was more or less sensitive to s-polarization than to p-
polarization.
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Note: For specular optical functoins, the values of f and q that you specify only determine the values of the 'average' optical properties. 

For example, the 'average' reflectance is given by:

R=(Rs*q*(1+f)+Rp*(1-f))/(f*(q-1)+(q+1)). 

The average transmittance, absorptance, and electric field intensities are given by equivalent expressions. As mentioned above, the 
optical properties for the pure polarizations are always calculated.

Note: For non-specular reflected intensity calculations using the Born approximation, since there is coupling between s and p 
polarizations (in general), things are more complicated: 

For an incident beam having a polarization factor f, the s-polarized and p-polarized components of the non-specular reflected intensity, 
(1/I0)dI/dOmega_s and (1/I0)dI/dOmega_p, respectively, are given by:

(1/I0)dI/dOmega_s=((1/I0)dI/dOmega_ss*(1+f) + (1/I0)dI/dOmega_ps*(1-f))/2

(1/I0)dI/dOmega_p=((1/I0)dI/dOmega_sp*(1+f) + (1/I0)dI/dOmega_pp*(1-f))/2

where 

(1/I0)dI/dOmega_ss = reflected intensity component having s polarization, resulting from the fraction of the incident beam having 

s polarization

(1/I0)dI/dOmega_sp = reflected intensity component having s polarization, resulting from the fraction of the incident beam having 

p polarization

(1/I0)dI/dOmega_ps = reflected intensity component having p polarization, resulting from the fraction of the incident beam having 

s polarization

(1/I0)dI/dOmega_pp = reflected intensity component having p polarization, resulting from the fraction of the incident beam having 

p polarization

The 'average' reflected intensity, i.e., as measured with a detector having polarization sensitivity q (as defined above,) is then given by:

(1/I0)dI/dOmega_a=2*((1/I0)dI/dOmega_s*q + (1/I0)dI/dOmega_p)/(1+q)

Thus, the values of the s and p components of the scattered intensity depend on the specified value of f, while the 'average' scattered 
intensity depends on both f and q.

Use the Units and Precision menus to specify angle and photon units and precision, respectively. That is, you can choose to specify 
angles relative to normal incidence or relative to grazing incidence, and in degrees, arc-minutes, arc-seconds, or milliradians, and you can choose 
to specify photon wavelengths in angstroms, nanometers, microns, or cm-1, or photon energies in eV or keV.

In addition to angles and wavelengths (or energies), any of the (continuously variable) parameters that describe the structure can be 
designated as independent variables: optical constants, densities, compositions, layer thicknesses, interface widths, PSD parameters, graded 
interface parameters, etc. You can also specify the instrumental resolutions and polarization factors (f and q) as independent variables. Up to 
eight independent variables can be specified simultaneously. 

To specify additional independent variables, press the Add button to the right of the Independent Variables List to bring up a menu of 
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parameters available. Once you add a new independent variable to the Independent Variable List, you can edit the variable in the usual way: 
either by double-clicking or pressing the Edit button.

As an example, shown in Figure 2.3.6 is the independent variable widget that would result from specifying a multilayer period N to be an 
independent variable. In this case, I have selected 9 values of N, from 5 to 50. Note that in the Structure List, shown in Figure 2.3.7, the 
multilayer description line now reads N=-variable-, indicating that N is an independent variable. Other specific examples of specifying 
multiple independent variables will be presented in Section 2.5. 

Figure 2.3.6 An independent variable widget corresponding to defining multilayer period N as an independent variable.

Figure 2.3.7 The main IMD widget showing the multilayer period N as an independent variable.
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INDEPENDENT VARIABLES SPECIFIC TO ELECTRIC FIELD CALCULATIONS

In the case of electric field intensity calculations, a third independent variable - depth, i.e., the position in the structure, measured from the top of 
the first layer - is always defined as well. This independent variable is not listed in the Independent Variables List. It is specified by pressing the 
button labelled Parameters... that appears when you select the Electric Fields dependent variable button. The depth variable is 
specified by three parameters, the spacing between calculation points, the calculation depth into the ambient, and the calculation depth into 
the substrate (if the substrate is present.) Note that the depth values are not equally spaced, as it is necessary to calculate the field intensities 
precisely at the interfaces between layers. So the specified spacing between calculation points represents an average value.

Figure 2.3.8 The Electric Field Calculation Parameters widget.

INDEPENDENT VARIABLES SPECIFIC TO NON-SPECULAR OPTICAL FUNCTIONS

For non-specular computations, you must also specify the scattering angles and the type of `scan' you wish to model. Thus, when you select 
either the BA or DWBA functions as dependent variables, two additional independent variables will be defined: the first is related to the 
scattering angle, Thetaout, the second is the scattering plane azimuthal angle, phi. These angles are illustrated in Figure 2.3.9. 

Figure 2.3.9 Scattering geometry associated with non-specular scattering.

Non-specular reflected intensity computations can be computed for any one of three different scattering geometries, or 'scans', as summarized in 
table 2.3.1 The three scan types - Rocking Scan, Detector Scan, and Offset Scan - are common to grazing incidence X-ray scattering 
measurements, but are equally valid for any wavelengths and over any range of incidence angles. 

Table 2.3.1 Non-specular scattering scan types.
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Scan Type Description

Rocking Scan Detector fixed, sample rotated
Detector Scan Sample fixed, detector rotated

Offset Scan

Sample and detector rotated simultaneously; 

Detector offset from specular direction by a constant angle

●     A Rocking Scan refers to the case of a measurement of the non-specular reflected intensity wherein the detector is held fixed relative to 
the incident beam, and the sample is rotated, or 'rocked', with respect to the incident beam. In this case, both the incidence angle Thetain 

and the scattering angle Thetaout vary simultaneously. 

●     A Detector Scan refers to the case wherein the sample is fixed relative to the incident beam, and the detector is varied. Thus Thetain is 

constant, while Thetaout is varied.

●     In an Offset Scan, the sample and detector are both rotated, with the detector offset from the specular direction by a constant offset angle, 
i.e., Thetaout-Thetain=constant

The way that you specify scattering angles in IMD depends on both the type of scan you have selected, and whether you choose to specify 
grazing incidence angles or normal incidence angles, as summarized in Table 2.3.2:

Table 2.3.2. Independent variable angle specification for non-specular scattering computations.

Scan Type
Angle specified in IMD Incidence 
Angles independent variable widget

Angle specified in IMD Scattering Angles 
independent variable widget

Rocking Scan, Normal Incidence Theta =Thetain Thetain+Thetaout

Rocking Scan, Grazing Incidence Theta = 90 deg -Thetain TwoTheta = 180 deg -Thetain-Thetaout

Detector Scan, Normal Incidence Theta =Thetain Thetain+Thetaout

Detector Scan, Grazing Incidence Theta = 90 deg -Thetain TwoTheta = 180 deg -Thetain-Thetaout

Offset Scan, Normal Incidence Theta =Thetain Delta(Thetaout)

Offset Scan, Grazing Incidence Theta = 90 deg -Thetain Delta(TwoTheta)

Shown in Figures 2.3.10 and 2.3.11 are the independent variable widgets associated with the scattering angle variable and the scattering plane 
azimuthal angle variable. Included on each widget is a schematic diagram illustrating the scattering geometry corresponding to the range of 
values you specify. In addition, the Scattering Angles widget includes plots of qx vs qz and qy vs qz, illustrating the corresponding scan 

trajectories in momentum space; the greyed regions on these plots indicate inaccessible regions of q-space, i.e., regions where either Thetain or 

Thetaout are greater than 90 degrees. The relationships between scattering angles and q-vectors are shown in Figure 2.3.12.

Figure 2.3.10. The Scattering Angles independent variable widget. In this case, a Rocking Scan has been selected for a single value of 
the scattering angle TwoTheta.
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Figure 2.3.11. The Scattering Plane Azimuthal Angle independent variable widget.

Figure 2.3.12 Relationship between incidence and scattering angles and momentum vectors.
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Although each of the three non-specular scan types refers to a one-dimensional scan, you are free to specify both multiple incidence angles and 
multiple scattering angles for any type of scan, in order to compute non-specular reflected intensity as a function of both angles. As a specific 
example, in the case of a Rocking Scan at grazing incidence, you can compute the non-specular reflected intensity for a range of incidence 
angles Theta, and for a single value of TwoTheta (as in Figure 2.3.10, for example,) or, you can compute the scattered intensity for both a range 
of Theta values and a range of TwoTheta values. In the latter case, the scattered intensity will be computed as a series of Rocking Scans, i.e., the 
scattered intensity will be computed as a function of Theta, for every value of TwoTheta you have specified. Figure 2.3.13 illustrates.

Note: The non-specular reflected intensity functions will be set to zero wherever either the incidence angle (Theta_in) or the scattering 
angle (Theta_out) exceeds 90 degrees.

Figure 2.3.13. The Scattering Angle independent variable widget for the case of a Rocking Scan when multiple values of the scattering 
angle TwoTheta have been specified.
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Note: Because of the fact that the momentum transfer vector q depends on the wavelength, the incidence angle, and the two scattering 
angles, and because it is possible in IMD to vary any or all of these four parameters simultaneously, it is not possible to specify q-vectors 
directly. However, the results of your computations can be displayed as plots in momentum space, as will be described in Section 2.5.

COUPLED PARAMETERS

It's possible in IMD to constrain individual layer or substrate parameters to be equal or proportional to other layer or substrate parameters, 
through the use of so-called 'Coupled Parameters'. 

As an example, suppose you define a structure containing two layers, and you wish to set the interfacial width of layer A to be twice the 
interfacial width of layer B. As an alternative to entering directly the interface width values for each of the two layers, you can instead define a 
coupled parameter, such that the interface width of the A layer will always be equal to 2 times the value of the B layer interface width. The main 
advantage of using a coupled parameter in this case is that if you then define the 'source' of the coupled parameter - in this case the B layer 
interface width - to be an independent variable (or a fit parameter, as described in Section 3.2) , both parameter values can be varied 
simultaneously. In fact, multiple layer or structure parameters can all be coupled to the same 'source' parameter, allowing you to vary many 
parameters simultaneously, using only a single independent variable (or fit parameter.)

To define a coupled parameter, select the COUPLED PARAMETERS button on the main IMD widget, and then press the Add button in the 
Coupled Parameters region. (See Figure 2.3.14.) You will be presented with a list of available parameters that can be designated as coupled 
parameters. Choose one of these parameters. You will then be presented with a list of available 'source' parameters. Once you select the source 
parameter, a new Coupled Parameters widget will appear, as shown in Figure 2.3.15.

Figure 2.3.14. The main IMD widget as it appears when the COUPLED PARAMETERS button is selected. 
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Figure 2.3.15. A Coupled Parameters widget.

On the Coupled Parameters widget you can enter the proportionality factor relating the source and destination parameters - a factor of 2 is 
shown in Figure 2.3.15 - and you can press the Change source parameter... button in order to (yes, you guessed it) change the source 
parameter. 

The number of coupled parameters that can defined is limited only by the number of layers you define in the structure.

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/2.3.html (13 of 14) [18/06/2002 17:01:48]



IMD 2.3 Specifying Variables and Coupled Parameters

Note: Once a parameter is defined as (the destination parameter of) a coupled parameter, it's value can no longer be specified directly, nor 
can that parameter be defined as an independent variable or fit parameter. 

See Section 2.5 for several examples illustrating the use of coupled parameters.

Back | Contents | Next
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Chapter 2. Modeling

This chapter explains how to perform a calculation using IMD.

Figure 2.1 is a picture of the main IMD window, or widget, in IDL terminology, as it appears when you start IMD for the 
first time. This widget consists of the following components: the menu bar, the STRUCTURE area, the DEPENDENT 
VARIABLES / INDEPENDENT VARIABLES / COUPLED PARAMETERS / FIT PARAMETERS area, the 
MEASURED DATA area, and the IDL Commands area.

Figure 2.1 The main IMD widget
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The sections that follow describe how to use the main IMD widget in order to accomplish these tasks:

2.1 Designating materials and optical constants

2.2 Defining the structure

2.3 Specifying variables and coupled parameters

2.4 Performing the computation

2.5 Viewing, printing, and saving the results

Back | Contents | Next
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2.4 Performing the computation

Once you have defined the structure, specified independent and dependent variables, and optionally any 
coupled parameters, select the appropriate menu item from the Calculate menu, in order to perform 
the actual computation. 

Back | Contents | Next
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2.5 Viewing, printing, and saving the results

SAVING THE RESULTS

After the calculation is completed, the results will be saved to an IMD file automatically, unless you have disabled this feature in the File-
>Preferences->Auto-Save... menu option.

Note: Unless you disable auto-save, IMD will remember exactly how you left things the last time you ran IMD, so that you can 
continue right where you left off.

If you wish to save the results of different calculations in different IMD files for later use, use the File->Save as.. menu option. Saved 
IMD files can later be opened using the (you guessed it) File->Open... menu option.

You can also save the results as plain text, if you wish, by selecting File->Save as Text... from the menu bar. You will be presented 
with a widget that allows you to specify which dependent variables you wish to save, and as a function of which independent variable, if there 
is more than one (multi-valued) independent variable available. For example, if you have calculated reflectance as a function of both 
incidence angle and wavelength, you must specify whether you wish to save reflectance vs. angle data at a specific wavelength, or reflectance 
vs. wavelength data at a specific angle. Figure 2.5.1 illustrates:

Figure 2.5.1 The IMD Save-as-Text widget associated with a transmittance calculation using three independent variables: angle, 
wavelength, and layer thickness.

VIEWING AND PRINTING THE RESULTS - IMDXPLOT
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After the calculation is completed, the results will be displayed graphically in an IMDXPLOT widget. The appearance of the 
IMDXPLOT widget depends on the dependent and independent variables you have specified, as will now be described.

Shown in Fig. 2.5.2 is the IMDXPLOT widget that results from a calculation of reflectance vs incidence angle for a 50 nm gold film on an 
amorphous SiO2 substrate.

Figure 2.5.2 IMDXPLOT example showing the reflectance of a thin film on a substrate.

For each dependent variable selected in the DEPENDENT VARIABLES area of the main IMD widget, at least three quantities are actually 
calculated, as previously mentioned: the values of the property for pure s and pure p polarizations, as well as the 'average' value. In the case of 
reflectance and transmittance, the phases are calculated as well; in the case of reflectance, the ellipsometric psi and delta functions are also 
computed. 

Shown in Figure 2.5.3 is the Plot Variables widget associated with the IMDXPLOT widget shown in Figure 2.5.2. This widget is 
accessible from the Preferences->Plot Variables... menu option on the IMDXPLOT widget. The default setting is to plot only 
the 'average' reflectance for the specified polarization parameters f and q, as shown:
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Figure 2.5.3 IMDXPLOT Plot Variables widget

Shown in Figure 2.5.4 is the plot that results after selecting instead as plot variables R(s), R(p), and also the ellipsometric psi and delta 
functions. I have also changed the colors and linestyles of the different curves using the Preferences->Plot Variables Styles 
and Labels... option, and I have adjusted the axes using the Preferences->Axes Scaling... option. The cross-
hairs at 79 degrees are due to the fact that I've also selected R(p) as the active 'cursor 
function'.

Figure 2.5.4 Plot after selecting several Plot Variables.
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You can use your mouse to zoom in on a particular region of the plot. Alternatively, more precise axis scaling can be adjusted from the menu 
items on the IMDXPLOT widget; many other aspects of the plot can be adjusted as well: colors, linestyles, thicknesses, plotting symbols, 
labels and label placement, character size, etc. Once you have adjusted the plot to your liking, you can print it using the File->Print 
menu option. 

Note: You can change the default background and plot color, by setting the values of the IDL graphics system variables !p.background 
and !p.color. For example, to produce a plot with black lines on a white background (instead of the default white plot on a black 
background), set !p.background=255 and !p.color=0, prior to plotting your results with IMDXPLOT. You can enter these commands 
either at the IDL prompt, or from within the IDL Commands area of the main IMD widget.

Note: Use the droplist widget (labeled Angles in Figure 2.5.4, for example) to the right of the plot area on an IMDXPLOT widget to 
display an optical function vs. q (momentum) rather than incidence or scattering angle.

FIXED CURVES

As a second, and somewhat more complicated example, shown in Figures 2.5.5 and 2.5.6 are IMDXPLOT widgets corresponding to the 
results of a calculation of the reflectance of a carbon film vs. angle of incidence, wavelength, and film thickness. There are many different 
ways to display the results of such a multi-variable calculation. In Figure 2.5.5, I have chosen to display a 1D plot showing Reflectance vs. 
Incidence Angle. Thus, the Continuous Variable box next to the word Theta is checked, signifying that Theta (incidence angle) is a 
continuous plot variable, whereas the boxes next to Lambda and z[a-C] are unchecked, indicating that these parameters are discrete 
variables. That is, the plot shows the reflectance-vs-angle curves for whichever value of Lambda is entered in the box labeled 'Value' to the 
right of the word Lambda. Alternatively, you can position the slider labelled Index to view R-vs-Theta curves for different wavelength 
array indices. On the other hand, in Figure 2.5.6, I've designated both angle and wavelength as continuous variables, and have displayed the 
results as a 2D surface plot.

Figure 2.5.5 A 1D plot showing the reflectance of a carbon film as a function of incidence angle.
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Figure 2.5.6 A 2D surface plot, showing the reflectance of the same carbon film, as a function of both angle and wavelength, and for two 
different film thicknesses.
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The way to display more than one curve at a time, as in Figures 2.5.5 and 2.5.6, is to add "Fixed Curves" to the plot. By pressing the Add 
button in the FIXED CURVES area of the IMDXPLOT widget, the currently displayed curves will be added to the list of "Fixed" curves. The 
appearance (i.e., color, linestyle, etc.) of each fixed curve can be edited by selecting the fixed curve in the usual way: either double-clicking on 
the line in the Fixed Curve List area, or by selecting the curve you wish to edit and pressing the Edit button. You can also change the label 
for the curve, and you can choose to use 'curve labels' (as in Figure 2.5.4, for example), or use a legend (as in Figure 2.5.5.) If you choose to 
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use a legend, you can adjust the order in which the curves are listed in the legend by using the Move Up and Move Down buttons in the 
FIXED CURVES area. You can add as many as 30 Fixed Curves to the plot.

Note: You can have more than one IMDXPLOT widget open at a time. This makes it easier to compare the results from different 
types of calculations. But, this also means that any changes you make in the main IMD widget (i.e., changes to the structure or to the 
dependent or independent variables) will only affect future instances of IMDXPLOT. So once a calculation is completed and the 
IMDXPLOT widget is created, you cannot change the data associated with that instance of IMDXPLOT (although you can always 
change the plot appearance, using the IMDXPLOT Preferences options.) This also means that any changes you make to the plot 
using the IMDXPLOT Preferences options will only affect that instance if IMDXPLOT. 

To specify preferences that you want to apply to all future instances of IMDXPLOT, use the Plot->Global Plot 
Preferences... option from the main IMD widget menu bar. 

Also, you can save the plot appearance changes (and fixed curves) you might have made in IMDXPLOT along with the data by using 
the File->Save... option from the IMDXPLOT menu bar.

STATISTICS: Estimating film thicknesses, features widths, etc. 

You can use the Tools->Statistics/Region-of-Interest IMDXPLOT menu option to define a region-of-interest, and compute 
a variety of statistics for whatever optical functions are currently displayed, including measured data. (Loading your measured data into 
IMD will be discussed in Chapter 3.)  

For example, shown in Figure 2.5.7 is the calculated X-ray reflectance of a W/Cr bilayer film, plotted as a function of q_z; the two dashed 
vertical lines on this plot refer to the region-of-interest that was defined on the Statistics widget shown in Figure 2.5.8. Note that this 
region-of-interest was digitized to encompass one period of the high-frequency modulation visible in the reflectance curve. In this example, 
this modulation is due to the total film thickness; thus, the Corresponding layer thickness indicated in the Statistics widget 
of Figure 2.5.8 is an estimate of the total film thickness. This technique is especially useful with measured data when trying to fit X-ray 
reflectance data in order to determine film thicknesses. (The data used to produce Figure 2.5.7 is contained in the file 
examples.dir/WCr_bilayer.dat.)

Figure 2.5.7. The calculated X-ray reflectance of a W/Cr bilayer film. The dashed vertical lines refer to the region-of-interest indicated in 
Figure 2.5.8. 
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Figure 2.5.8. The Statistics widget associated with the IMDXPLOT widget shown in Figure 2.5.7
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As can be seen in the Statistics widget of Figure 2.5.8, six different statistics can be determined: Minimum, Maximum, Average, 
Integral, Full-Width-Half-Max, and Full-Width-Half-Min (which refers to the width of an 'absorption' feature.) To illustrate, shown in Figure 
2.5.9 is the reflectance and transmittance of a Y/Al multilayer film, with the width of the Bragg peak in both functions indicated.

FIgure 2.5.9. The reflectance and transmittance of a Y/Al multilayer. The FWHMax of the reflectance, and the FWHMin of the transmittance 
curves are indicated.
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Note: the statistics you select are computed only over the region-of-interest you define.
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Note: to display statistics for more than one function simultaneously, as in Figure 2.5.9, you will need to compute the statistics for one 
function at a time, and then display each function as a Fixed Curve, as described above. 

EXAMPLES

Included here are a few more examples illustrating some of the types of computations and visualizations that are possible in IMD.

Reflectance and transmittance contours of a Y/Al multilayer 

Shown in Figure 2.5.10 is the reflectance and transmittance of the same Y/Al multilayer used in Figure 2.5.9. In this case, however, these 
specular optical functions are displayed as a function of both wavelength and multilayer thickness ratio (Gamma) as color contour plots: 
contours of constant reflectance are shown in green, contours of constant transmittance are shown in blue, and both sets of contours are 
overlayed on the a filled contour plot of the reflectance The grey 1D plots below and to the left of the contour plot are 'live' plots that vary as 
you move the cursor over the contour plot. (The data used to create this plot is in the file called examples.dir/YAl.rt.dat.)

Figure 2.5.10. Reflectance and transmittance contours for a Y/Al multilayer film, as a function of wavelength and layer thickness ratio. 
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Electric field intensity contours of a Mo/Si multilayer

Similarly, shown in Figure 2.5.11 are the electric field contours for a Mo/Si multilayer film, as a function of wavelength and depth into the 
film (see the file examples.dir/SiMo.fields.dat):

Figure 2.5.11. Electric field intensity contours for a Mo/Si multilayer film.
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Reflectance of a depth-graded C/Ni multilayer, using coupled parameters

The next example, shown in Figure 2.5.12 (and contained in the file examples.dir/CNi.graded.dat,) is the grazing incidence X-ray 
reflectance vs. energy of a graded C/Ni multilayer film, showing the effect of interface roughness/diffuseness on the specular reflectance. This 
calculation was made by defining two coupled parameters (see Section 2.3): the Ni layer thickness was set to be 0.8 times the C layer 
thickness (which was graded), and the Ni layer interface width was set equal to the C layer interface width, which itself was defined as an 
independent variable.

Figure 2.5.12. The grazing incidence X-ray reflectance of a graded C/Ni multilayer, as a function of interface width.
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Normal-incidence non-specular reflected intensity for a Mo/Si multilayer, using the Born approximation, with coupled 
parameters

Figure 2.5.13 shows the result of a calculation of the non-specular reflected intensity for a Mo/Si multilayer film, near normal incidence in the 
soft X-ray region, computed using the Born approximation vector theory. The Omega/nu/n PSD model was used, and the PSD parameters of 
the Mo-on-Si interface were coupled to those of the Si-on-Mo interface; the Si-on-Mo relaxation coefficient, nu, was defined as an 
independent variable. Contours of constant intensity as a function of wavelength and scattering angle are superimposed on a filled color 
contour plot, and 1D slices are shown below and to the left of the contour plot. (See the file examples.dir/SiMo.ns_ba.dat.)

Figure 2.5.13. The non-specular reflected intensity for a Mo/Si multilayer film near normal incidence, computed using the BA theory (see 
Section 2.3.)

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/2.5.html (14 of 17) [18/06/2002 17:01:53]



IMD 2.5 Viewing, Printing and Saving the Results

Grazing incidence non-specular reflected intensity of a W/Si multilayer using the distorted-wave Born approximation, 
with coupled parameters
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The last example, shown in Figure 2.5.14, is a plot in q-space of the grazing incidence, non-specular reflected X-ray intensity for a W/Si 
multilayer calculated with the DWBA theory, as a function of the lateral correlation length. The correlation length of the Si-on-W interface 
was coupled to that of the W-on-Si interface for this calculation. (See the file examples.dir/SWi.ns_dwba.dat.)

Figure 2.5.14. The non-specular reflected intensity for a W/Si multilayer film near grazing incidence, computed using the DWBA theory (see 
Section 2.3.)
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Chapter 3. Measured Data and Parameter 
Estimation

In addition to using IMD for modeling, you can also use IMD for parameter estimation (with confidence 
interval generation) using nonlinear, least-squares curve-fitting, based on the Chi^2 test of fit. 

To illustrate, I will present an example showing how to determine the optical constants of a film from 
reflectance vs. incidence angle measurements.

Note: In IMD you can choose to use either the IDL CURVEFIT function (actually, a slightly modified 
version,) which is based on the Marquardt algorithm [14] described in reference [15], or the MPFIT 
function, an implementation of the MINPACK-1 Levenberg-Marquardt algorithm [19], developed by C. 
B. Markwardt <http://astrog.physics.wisc.edu/~craigm/idl.html>

3.1 Using your measured data

3.2 Specifying fit parameters

3.3 Curve-fitting

3.4 Confidence intervals
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3.1 Using Your Measured Data

The first step in performing a fit (or just comparing your measured data to IMD calculations) is to load your measured data into IMD. The internal 
variable names that IMD uses for measured data are X_m, Y_m, and SIGY_m, where X_m is the independent variable, Y_m is the dependent 
variable, and SIGY_m is the experimental uncertainty in Y_m. So the goal here is to get your data inside these variables. (SIGY_m is optional - if 
you don't define it, IMD will just set it to zero.) 

The easiet way to load your data into IMD is to use the File->Open Measured Data File... option from the main IMD widget menu bar. 
Figure 3.1.1 shows the widget that appears as a result:

Figure 3.1.1 IMD Open Measured Data File widget

To load in measured data, you must tell IMD what sort of data you have. In the Open Measured Data widget (Figure 3.1.1), you must select 
designations for X_m and Y_m from a list of available independent and dependent variables; the choices presented will be determined by the 
independent and dependent variables you have already selected in IMD.

For this example, I will illustrate how to read an ASCII file containing reflectance vs. incidence angle data measured for a Au film, 40 nm thick, at a 
wavelength of 400 nm. 

Note: There are files located in the directory called examples.dir in the imd directory that you can load into IMD in order to follow along 
with this example. The measured data file, called 'Au_r_vs_th.MEASURED.dat', can be loaded into IMD using the File->Open 
Measured Data File... option, as described below. Use the File->Open... option to also read the file 
Au_r_vs_th.FIT.dat into IMD. 

After specifying the relevant structure parameters (i.e., Au film, 40 nm thick), and the relevant independent and dependent variables (i.e., reflectance 
vs. incidence angle) in the main IMD widget, in the Open Measured Data widget, select Reflectance, R for Y_m, and Incidence 
Angle, Theta [deg] for X_m.

Note: it's important to set - before loading the data - the independent variable Units to correspond with what's actually in your file. For 
instance, if you're reading in data as a function of Normal incidence angle, make sure that the Angle units are set for Normal 
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Incidence, and not Grazing Incidence. Likewise for wavelength/energy or length units. 

You can change units to whatever you prefer after you load in the data, but IMD needs to know what units are actually in your data file ahead 
of time.

The final step is to tell IMD what IDL commands to use to actually read the file. Since the file I'm reading in this example is an ASCII file containing 
three columns of data - angle, reflectance, and uncertainty-in-reflectance - I can use the EROM command (see the documentation for the EROM 
command, located in the windt directory). The IDL command to read in the data is thus 'EROM, X_M, Y_M, SIGY_M'. This command goes in 
the field labelled Command to read measured data file: in the Open Measured Data File widget.

Note: If you have data that is in some other format, so that you cannot use the EROM command as described here, then you must enter the 
appropriate IDL commands in the Command to read measured data file: field of the Open Measured Data File widget. 
Consult Appendix B.3 for more details.

Note: You can add offsets and/or scale factors to your measured data in the Open Measured Data File widget (Figure 3.1.1.) This 
feature can be used, for example, to correct for systematic errors in your data, or to convert measured non-specular reflected X-ray intensity 
data, normalized to your incident beam intensity, i.e., I/I0, to the form (1/I0)dI/dOmega, which is the quantity that IMD computes. That is, you 

would divide your values of I/I0 by your detector solid angle, dOmega.

Note: You can limit the range of measured data by selecting the Only use measured data within specified range button, and 
by entering the X_m values that define the range of interest. 

Once you have finished with the Open Measured Data File widget, press Open Data File to actually read the file. In this example, the 
EROM command will now ask you to select a file to open. If you wish to follow along with this example, then select the file called 
Au_r_vs_th.MEASURED.dat in the examples.dir directory.

After the data is read in successfully, the MEASURED DATA area of the main IMD widget will indicate what data has been loaded. In this example, 
the MEASURED DATA widget looks like this:

Figure 3.1.2: MEASURED DATA area of the main IMD widget after reading in data.
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B.3 Reading measured data files

Contained here are further details on loading your measured data files into IMD.

As described in section 3.1, the easiest easiet way to load your data into IMD is to use the File->Open 
Measured Data File... option from the main IMD widget menu bar. Alternatively, you can use 
the procedure IMD_M_RD (described in the previous section) directly from the IDL command line (at the 
IMD prompt.) But in either case, you must 

(a) indicate what type of data your file contains (either by setting the droplist values on the Open 
Measured Data File... widget, or by explicitly setting values for X_M_PTR and 
Y_M_PTR when using IMD_M_RD from the IDL command line)

and

(b) provide a command string to tell IMD (or IMD_M_RD) how to open your measured data file.

The Read-Measured-Data Command String

If your measured data file is an ASCII file containing columns of data, you can use the EROM procedure 
to read the file (see the documentation for EROM in the windt directory.) If the file is not an ASCII file, 
or you cannot use EROM for some reason, then you will need to write your own IDL procedure (or 
function) to read your file. 

But however you read your measured data file (EROM or your own procedure) you must either 

(a) explicitly define the IMD variables X_M, Y_M, and optionally SIGY_M in the Read-
Measured-Data Command String, as in:

"EROM, X_M, Y_M, SIGY_M"

or

"MY_PROCEDURE, X_M, Y_M, SIGY_M"

or 

(b) use the IMD_M common block (see Appendix B.4) and define X_M, Y_M, and SIGY_M 
inside the IDL procedure you write to read your data. For example:

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/B.3.html (1 of 3) [18/06/2002 17:01:55]



IMD B.3. Reading measured data files

PRO MY_PRO_TO_READ_MY_DATA

COMMON IMD_M

;; IDL code to read your data goes here

X_M=my_x_data
Y_M=my_y_data

;; and optionally
SIGY_M=my_sigy_data

return
end

So that the Read-Measured-Data Command String would read simply 

"MY_PRO_TO_READ_MY_DATA".

As indicated in section 3.1, it's important to set - before loading the data - the independent variable Units 
to correspond with what's actually in your file. For instance, if you're reading in data as a function of 
Normal incidence angle, make sure that the Angle units are set for Normal Incidence, and not 
Grazing Incidence. Likewise for wavelength/energy or length units. 

You can change units to whatever you prefer after you load in the data, but IMD needs to know what units 
are actually in your data file ahead of time, as IMD will convert (i.e., redefine) X_M after it reads the file.

But...if you want to get fancy, you can take advantage of the values of the IMD COMMON block variables 
IMD.ANGLEUNITS_PTR, IMD.PHOTONUNITS_PTR, or IMD.LAYERUNITS_PTR, (see 
Appendix B.4) to make sure that your data get converted correctly, regardless of how these pointers might 
be set. That is, if you know your data file contains, for example, reflectance vs. grazing incidence data, 
then you might write a procedure like this:

PRO MY_PRO_TO_READ_MY_GRAZING_DATA

COMMON IMD
COMMON IMD_M

;; Read an ASCII file of grazing incidence vs reflectance data

EROM, X_M, Y_M

;; Now make sure that the grazing incidence data always gets
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;; converted to normal incidence properly, regardless of how
;; IMD.ANGLEUNITS_PTR is set.  That is, if IMD thinks the file
;; contains normal incidence data (IMD.ANGLEUNITS_PTR=0), then make
;; it so, even though the file actually contains grazing incidence
;; data:

if IMD.ANGLEUNITS_PTR eq 0 then X_M=90-X_M

return
end

Remember that X_M will get converted (redefined) to "internal" units (i.e., normal incidence, or 
angstroms) after the file is read; this conversion procedes according to the current value of IMD.X_M.

Note: Included in the extras.dir directory of the imd distribution are some additional IDL 
procedures that I have used to read in my measured data files; you might wish to use these 
procedures as starting points for your own procedures.
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B.2 Some IMD functions and procedures

Described below (using standard IDL documentation formatting), are several IMD procedures and functions that you may wish 
to use directly in IDL. In the documentation for the Graphics routines, you'll find an example of how to create a plot showing 
computations stored in separate IMD data files.

●     Computation 

FRESNEL

NS_BA

NS_DWBA

●     Optical constants

IMD_F1F2TONK (procedure)

IMD_F1F2TONK (function)

IMD_NK

XNKPLOT (and the procedure NKPLOT contained within XNKPLOT)

●     File I/O

IMD_RD 

IMD_M_RD

●     Graphics

IMDSPLOT

IMDNPLOT

IMDFPLOT

IMDCPLOT

IMDMPLOT 

IMD_PLOT_LBL 
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;+
; NAME:
;
;       FRESNEL
;
; PURPOSE:
;
;       Compute specular optical functions and electric
;       field intensity for a multilayer stack.
;
; CALLING SEQUENCE:
;
;       FRESNEL, THETA,LAMBDA,NC,Z[,SIGMA,INTERFACE,F,Q]
; 
; INPUTS:
;
;       THETA - Scalar or 1-D array of incidence angles, in degrees,
;               measured from the normal.
;
;       LAMBDA - Scalar or 1-D array of wavelengths.  Units for LAMBDA
;                are the same as for Z and SIGMA.
;
;       NC - Complex array of optical constants.  The dimensions of NC
;            must be (N_ELEMENTS(Z)+2,N_ELEMENTS(LAMBDA)).
; 
;       Z - 1-D array of layer thicknesses. Units for Z are the same
;           as for SIGMA and LAMBDA.
;
;
; OPTIONAL INPUTS:
;
;
;       SIGMA - Scalar, 1D or 3D array of interface widths.  If SIGMA
;               is a scalar, then the same roughness value is applied
;               to each interface.  If SIGMA is a 1-D array, it must
;               have (N_ELEMENTS(Z)+1) elements, corresponding to the
;               number of interfaces in the stack.  If SIGMA is a 3-D
;               array, it must have
;               (N_ELEMENTS(THETA),N_ELEMENTS(LAMBDA),N_ELEMENTS(Z)+1)
;               elements. Units for SIGMA are the same as for LAMBDA
;               and Z.
;
;       INTERFACE - scalar, 1-D array, or 3-D array of interface
;                   roughness profile types.
;
;                   INTERFACE=0 corresponds to an error-function
;                   interface profile;
;
;                   INTERFACE=1 corresponds to an exponential
;                   interface profile;
;
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;                   INTERFACE=2 corresponds to a linear interface
;                   profile;
;
;                   INTERFACE=3 corresponds to a sinusoidal interface
;                   profile;
;
;                   INTERFACE=4 corresponds to a step functoin
;                   interface.

;                   If INTERFACE is a scalar, then the same roughness
;                   profile is applied to each interface.  If
;                   INTERFACE is a 1-D array, it must have
;                   (N_ELEMENTS(Z)+1) elements, corresponding to the
;                   number of interfaces in the stack.  If INTERFACE
;                   is a 3-D array, it must have
;                   (N_ELEMENTS(THETA),N_ELEMENTS(LAMBDA),N_ELEMENTS(Z)+1)
;                   elements.
;
;       F - Incident polarization factor, defined as the ratio
;           (I(s)-I(p)) / (I(s)+I(p)), where I(s) and I(p) are the
;           incident intensities of s and p polarizations. So for pure
;           s-polarization specify F=+1; for pure p-polarization
;           specify F=-1, or for unpolarized incident radiation,
;           specify F=0.
;
;       Q - Polarization analyzer sensitivity, defined as the
;           sensitivity to s-polarization divided by the sensitivity
;           to p-polarization.  Specifying a value of q other than 1.0
;           could be used to simulate, for example, the reflectance
;           you would measure using a detector that (for whatever
;           reason) was more or less sensitive to s-polarization than
;           to p-polarization.
;
;           NOTE: The values of F and Q that you specify only affect
;           the 'average' optical properties; the optical properties
;           for pure s and pure p polarization are unaffected.
;
; KEYWORD PARAMETERS:
;
;       INPUTS:
;
;              MFC_MODEL - an integer specifying the form of the modified
;                          Fresnel coefficients to be used to account for
;                          interface imperfections.  See Section 2.2 for

;                          details.
;               
;              COMPUTE_TA - Set to compute reflectance, transmittance
;                           and absorptance.
;
;              COMPUTE_FIELD - Set to compute fields, reflectance,
;                              transmittance and absorptance.
;
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;              Note: if neither COMPUTE_TA nor COMPUTE_FIELD is set,
;              then only reflectance is computed.
;                    
;
;              ARES - Instrumental angular resolution, in degrees. The
;                     optical properties (R, T, A) vs. angle will be
;                     convolved with a Gaussian of width ARES, in
;                     order to simulate a finite instrumental
;                     resolution.  You must specify three or more
;                     THETA values to use ARES.
;
;
;              PRES - Instrumental spectral resolution, in the same
;                     units as LAMBDA. The optical properties (R, T,
;                     A) vs. wavelength will be convolved with a
;                     Gaussian of width PRES, in order to simulate a
;                     finite instrumental resolution. You must specify
;                     three or more LAMBDA values to use PRES.
;
;       INPUTS FOR FIELD COMPUTATIONS ONLY (i.e., with COMPUTE_FIELD set):
;
;              PT_SPACING - The spacing (in same units as Z) between
;                           field intensity points.  If not specified,
;                           default value of 1 is used.
;
;                           Note that the actual spacing between
;                           points will not be regular, as it is
;                           necessary to compute the field intensities
;                           precisely at the interfaces between
;                           layers.  See DEPTH below.

; 
;              AMBIENT_DEPTH - The depth (in same units as Z) into the
;                              ambient material (the material above
;                              the multilayer) for which the field
;                              intensities are to be calculated.
;                              If not specified, a default value of 0
;                              is used.
;
;
;              SUBSTRATE_DEPTH - The depth (in same units as Z) into
;                                the substrate material (the material
;                                below the multilayer) for which the
;                                field intensities are to be
;                                calculated.  If not specified, a
;                                default value of 0 is used.
;
;       OUTPUTS:
;
;              RS - Reflectance for s-polarization.  
;
;              RP - Reflectance for p-polarization.
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; 
;              RA - Average reflectance, =
;                   (RS*Q*(1+F)+RP*(1-F))/(F*(Q-1)+(Q+1))
;
;              PRS - Phase of reflected wave for s-polarization.  
;
;              PRP - Phase of reflected wave for p-polarization.
; 
;              CRS - Complex reflected amplitude for s-polarization.
;
;              CRP - Complex reflected amplitude for p-polarization.
; 
;              RHO - Ratio of CRP/CRS
; 
;              PSI - Ellipsometric Psi function = ATAN(RHO*CONJ(RHO))
;  
;              DELTA - Ellipsometric Delta function =
;                      ATAN(IMAGINARY(RHO),DOUBLE(RHO))
; 
;              FUNC_USER1,
;              
;              FUNC_USER2,
;              
;              FUNC_USER3 - Strings specifying the USER1, USER2 and
;                           USER3 functions.  The IDL EXECUTE function
;                           is used to compute these functions, as in:
;                           ee=EXECUTE('user1='+func_user1).  Thus,
;                           these strings must use valid IDL syntax,
;                           and must be valid functions of any of the
;                           variables and functions internal to the
;                           FRESNEL procedure. See Section 2.3 for details.

;
;              USER1,
;
;              USER2,
;
;              USER3 - The user functions determined by the values of
;                      associated FUNC_USER* strings described above.
;
;
;       ADDITIONAL OUTPUTS when COMPUTE_TA or COMPUTE_FIELD keywords are set:
;
;              TS - Transmittance for s-polarization.  
;
;              TP - Transmittance for p-polarization.
; 
;              TA - Average transmittance, =
;                   (TS*Q*(1+F)+TP*(1-F))/(F*(Q-1)+(Q+1))
;
;              PTS - Phase of transmitted wave for s-polarization.  
;
;              PTP - Phase of transmitted wave for p-polarization.
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;
;              AS - Absorptance for s-polarization.  
;
;              AP - Absorptance for p-polarization.
; 
;              AA - Average absorptance, =
;                   (AS*Q*(1+F)+AP*(1-F))/(F*(Q-1)+(Q+1))
; 
;        The dimensions of RS, RP, RA, PRS, PRP, TS, TP, TA, PTS, PTP,
;        AS, AP, and AA are (N_ELEMENTS(THETA),N_ELEMENTS(LAMBDA).
;
;        ADDITIONAL OUTPUTS WHEN COMPUTE_FIELD IS SET:
; 
;              DEPTH - 1-D array of depth values. The number of depth
;                      values is
;
;                      1+FIX(TOTAL(Z)+AMBIENT_DEPTH+SUBSTRATE_DEPTH)/PT_SPACING
;
;                      The depth values are not equally spaced, as it
;                      is necessary to calculate the field intensities
;                      precisely at the interfaces between layers.
;                      If you need an equally spaced DEPTH array,
;                      you can interpolate the DEPTH, and INT values.
;
;             INTS - Field intensity for s-polarization. 
;
;                    Dimensions for INTS, INTP, and INTA are
;                    (N_ELEMENTS(THETA),N_ELEMENTS(LAMBDA),N_ELEMENTS(DEPTH))
;
;             INTP - Field intensity for p-polarization. 
;
;             INTS - Average field intensity, 
;                   =(INTS*Q*(1+F)+INTP*(1-F))/(F*(Q-1)+(Q+1))
;
; COMMON BLOCKS:
; 
;       COMMON IMD,IMD 
;
; PROCEDURE:
;
;       As the names suggest, this procedure uses the Fresnel
;       equations to compute the optical properties of a multilayer as
;       a function of angle and wavelength.  All computations are
;       performed in double precision.  A straightforward recursion
;       algorithm is used, which is to say that no shortcuts are
;       employed to take advantage of situations in which the
;       multilayer is purely periodic.  As such, other algorithms
;       might be faster, but this one is more general.
;
;       If the COMPUTE_TA keyword is set, to compute transmittance and
;       absorptance in addition to reflectance, then the procedure is
;       significantly slower, due to the extra computation required.
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;       If the COMPUTE_FIELD keyword is set, the computation time is
;       longer still.
; 
;       Scattering losses due to interfacial roughness or diffuseness
;       are handled according to the methods described in Section 2.2 of

;       of the hypertext IMD documentation.
;
;       Polarization averaging is performed using the function SP2A,
;       usage:
;
;       Result=SP2A(XS,XP,F,Q),
;
;       where F and Q are as defined above, XS and XP are the optical
;       functions for pure s and p polarizations, and Result is the
;       average function. For example, the average reflectance RA is
;       given by:
;
;       RA=(RS*Q*(1+F)+RP*(1-F))/(F*(Q-1)+(Q+1))
;
;       Instrumental resolution is computed by convolution with a
;       gaussian, using the function INSTRUMENT_RES, usage:
;
;       Result=INSTRUMENT_RES(X,Y,RES,ANGLE=ANGLE,
;                             WAVELENGTH=WAVELENGTH,ENERGY=ENERGY),
;
;       where RES is the width of the gaussian, and X and Y are the
;       independent and dependent variables (e.g., X=THETA, Y=RA).
;       Set ANGLE to convolve reflectance, transmittance, or
;       absorptance vs. angle, WAVELENGTH to convolve r/t/a vs.
;       wavelength, or ENERGY, to convolve r/t/a vs. energy. In the
;       case of ENERGY, both X and RES must be specified in angstroms,
;       but are converted to eV before doing the convolution.
;
; EXAMPLE:
;
;       Compute the reflectance of a gold film, 500 A thick, vs angle,
;       at a wavelength of 4000 A:
;
;       Define THETA=VECTOR(0.,90.,91), an array of angles from 0 to 90
;       degrees, in 1 degree steps.
;
;       Define LAMBDA=4000.
;
;       Using the optical constants for Au at 4000 A, we define
;       NC=[complex(1.,0.),complex(1.658,1.956),complex(1.,0.)],
;       assuming the Au film is surround by vacuum on either side.
;
;       Define Z=[500.]
;
;       FRESNEL, THETA, LAMBDA, NC, Z, RA=RA
; 
;       The value for RA we compute in this example corresponds to
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;       unpolarized light.
;
; MODIFICATION HISTORY:
;
;       David L. Windt, Bell Labs, May 1997
;
;       Updated to IMD V4.0, April, 1998
;       
;       windt@bell-labs.com
;
;-

;+
; NAME:
;
;       NS_BA
;
; PURPOSE:
;
;       Procedure to compute the non-specular reflected intensity for
;       a multilayer film, using the Born approximation theory
;       developed by D. Stearns, as described in reference [4].

;
; CALLING SEQUENCE:
;
;       NS_BA, THETA_IN,THETA_OUT,LAMBDA,NC,Z [,F,Q]
; 
; INPUTS:
;
;       THETA_IN - Scalar or 1-D array of incidence angles, in
;                  degrees, measured from the normal.
;
;       THETA_OUT - Scalar or 1-D array of scattering angles, in
;                   degrees, measured from the normal.
;
;       If THETA_IN is a scalar, then the same value of THETA_IN will
;       be used for every value of THETA_OUT.  Similarly, if THETA_OUT
;       is a scalar, then the same value of THETA_OUT will be used for
;       every value of THETA_IN.  If THETA_IN and THETA_OUT are both
;       1D arrays, then they must have the same number of elements.
;       In any case, the non-specular reflected intensity is computed
;       for pairs of THETA_IN, THETA_OUT values.
;
;       LAMBDA - Wavelength (scalar).
;
;       NC - Complex array of optical constants.  The dimensions of NC
;            must be (N_ELEMENTS(Z)+2)
; 
;       Z - 1-D array of layer thicknesses. Units for Z are the same
;           as for SIGMA and LAMBDA.
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;
; OPTIONAL INPUTS:
;           
;
;       F - Incident polarization factor, defined as the ratio
;           (I(s)-I(p)) / (I(s)+I(p)), where I(s) and I(p) are the
;           incident intensities of s and p polarizations. So for pure
;           s-polarization specify F=+1; for pure p-polarization
;           specify F=-1, or for unpolarized incident radiation,
;           specify F=0.
;
;       Q - Polarization analyzer sensitivity, defined as the
;           sensitivity to s-polarization divided by the sensitivity
;           to p-polarization.  Specifying a value of q other than 1.0
;           could be used to simulate, for example, the reflectance
;           you would measure using a detector that (for whatever
;           reason) was more or less sensitive to s-polarization than
;           to p-polarization.
;
; KEYWORD PARAMETERS:
;
;       INPUTS:
;
;       PHI - Scattering plane azimuthal angle. (Scalar.) Default is 0 deg.
;
;       MFC_MODEL - an integer specifying the form of the modified
;                   Fresnel coefficients to be used to account for
;                   interface imperfections.  See Section 2.2 for

;                   details.
;               
;       PSD_MODEL - Set PSD_MODEL=0 to use the sigma_r/xi_par/H PSD model.
;                   Set PSD_MODEL=1 to use the Omega/nu/n PSD model.
;               
;
;       If PSD_MODEL=0, then the following three parameters must be
;       supplied:
;
;       SIGMA_R - 1D array of interface roughnesses. N_ELEMENTS(Z)+1
;                 elements.
;
;       XI_PAR - 1D array of interface correlation lengths. N_ELEMENTS(Z)+1
;                 elements.
;
;       H - 1D array of interface jaggedness factors. N_ELEMENTS(Z)+1
;           elements.
;
;       In addition, you can also specify:
;
;       XI_PERP - Perpendicular correlation length (scalar).
;                 
;
;       If PSD_MODEL=1, then the following three parameters must be
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;       supplied:
;
;       OMEGA - 1D array of interface volumen
;               elements. N_ELEMENTS(Z)+1 elements.
;
;       NU - 1D array of interface relaxation
;            coefficients. N_ELEMENTS(Z)+1 elements.
;
;       N_ - 1D array of PSD exponents. N_ELEMENTS(Z)+1 elements.
;
;       You can also specify:
;
;       SUBSTRATE_Z - The Z value of the 'substrate', needed to
;                     compute the PSD of the bottom-most interface
;                     when using the Omega/nu/n PSD model.
;
;       Diffuse interfaces can be used when computing the electric
;       field intensities (needed to compute the scattered intensity)
;       by specifying values for SIGMA_D and INTERFACE.  The electric
;       fields will be computed from modified Fresnel coefficients,
;       as described in Section 2.2.

;
;              SIGMA_D - 1D array of interface diffuseness factors.
;                        SIGMA_D must have N_ELEMENTS(Z)+1 elements.
;
;
;              INTERFACE - 1D array of interface profiles
;                          functions. INTERFACE must have
;                          N_ELEMENTS(Z)+1 elements.
;
;                          INTERFACE=0 corresponds to an
;                          error-function interface profile;
;
;                          INTERFACE=1 corresponds to an exponential
;                          interface profile;
;
;                          INTERFACE=2 corresponds to a linear
;                          interface profile;
;
;                          INTERFACE=3 corresponds to a sinusoidal
;                          interface profile;
;
;                          INTERFACE=4 corresponds to a step functoin
;                          interface.
;
;
;
;              ARES - Instrumental angular resolution, in degrees. The
;                     non-specular reflected intensity vs. angle will
;                     be convolved with a Gaussian of width ARES, in
;                     order to simulate a finite instrumental
;                     resolution.  You must specify three or more
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;                     THETA_IN or THETA_OUT values to use ARES.
;
;       OUTPUTS:
;
;              DIDOMEGA_S - s-polarized component of reflected
;                           intensity.
;
;              DIDOMEGA_P - p-polarized component of reflected
;                           intensity.
;                           
;              DIDOMEGA_A - polarization-averaged reflected intensity.
;
;              See Section 2.3 for a complete description of these

;              three functions, and how they depend on f and q.
;
;
; COMMON BLOCKS:
; 
;       COMMON IMD,IMD 
;
; PROCEDURE:
;
;       Instrumental resolution is computed by convolution with a
;       gaussian, using the function INSTRUMENT_RES, usage:
;
;       Result=INSTRUMENT_RES(X,Y,RES,/ANGLE)
;
;       where RES is the width of the gaussian, and X and Y are the
;       independent and dependent variables (e.g., X=THETA,
;       Y=DIDOMEGA_S).  Set ANGLE to convolve didomega vs. angle.
;
; MODIFICATION HISTORY:
;
;       David L. Windt, Bell Labs, April, 1998
;
;       windt@bell-labs.com
;
;-

;+
; NAME:
;
;       NS_DWBA
;
; PURPOSE:
;
;       Procedure to compute the non-specular reflected intensity for
;       a multilayer film, using the distorted-wave Born approximation
;       theory developed by Sinha/Holy/de Boer, described in
;       references 5,6,7 and 8.
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;
; CALLING SEQUENCE:
;
;       NS_DWBA, THETA_IN,THETA_OUT,LAMBDA,NC,Z
; 
; INPUTS:
;
;       THETA_IN - Scalar or 1-D array of incidence angles, in
;                  degrees, measured from the normal.
;
;       THETA_OUT - Scalar or 1-D array of scattering angles, in
;                   degrees, measured from the normal.
;
;       If THETA_IN is a scalar, then the same value of THETA_IN will
;       be used for every value of THETA_OUT.  Similarly, if THETA_OUT
;       is a scalar, then the same value of THETA_OUT will be used for
;       every value of THETA_IN.  If THETA_IN and THETA_OUT are both
;       1D arrays, then they must have the same number of elements.
;       In any case, the non-specular reflected intensity is computed
;       for pairs of THETA_IN, THETA_OUT values.
;

;       LAMBDA - Wavelength (scalar).
;
;       NC - Complex array of optical constants.  The dimensions of NC
;            must be (N_ELEMENTS(Z)+2)
; 
;       Z - 1-D array of layer thicknesses. Units for Z are the same
;           as for SIGMA and LAMBDA.
;
; KEYWORD PARAMETERS:
;
;       INPUTS:
;
;       PHI - Scattering plane azimuthal angle. (Scalar.) Default is 0.
;
;       MFC_MODEL - an integer specifying the form of the modified
;                   Fresnel coefficients to be used to account for
;                   interface imperfections.  See Section 2.2 for

;                   details.
;               
;       PSD_MODEL - Set PSD_MODEL=0 to use the sigma_r/xi_par/H PSD model.
;                   Set PSD_MODEL=1 to use the Omega/nu/n PSD model.
;               
;
;       If PSD_MODEL=0, then the following three parameters must be
;       supplied:
;
;       SIGMA_R - 1D array of interface roughnesses. N_ELEMENTS(Z)+1
;                 elements.
;
;       XI_PAR - 1D array of interface correlation lengths. N_ELEMENTS(Z)+1
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;                 elements.
;
;       H - 1D array of interface jaggedness factors. N_ELEMENTS(Z)+1
;           elements.
;
;       In addition, you can also specify:
;
;       XI_PERP - Perpendicular correlation length (scalar).
;                 
;
;       If PSD_MODEL=1, then the following three parameters must be
;       supplied:
;
;       OMEGA - 1D array of interface volumen
;               elements. N_ELEMENTS(Z)+1 elements.
;
;       NU - 1D array of interface relaxation
;            coefficients. N_ELEMENTS(Z)+1 elements.
;
;       N_ - 1D array of PSD exponents. N_ELEMENTS(Z)+1 elements.
;
;       You can also specify:
;
;       SUBSTRATE_Z - The Z value of the 'substrate', needed to
;                     compute the PSD of the bottom-most interface
;                     when using the Omega/nu/n PSD model.
;
;       Diffuse interfaces can be used when computing the electric
;       field intensities (needed to compute the scattered intensity)
;       by specifying values for SIGMA_D and INTERFACE. The electric
;       fields will be computed from modified Fresnel coefficients,
;       as described in Section 2.2.

;
;              SIGMA_D - 1D array of interface diffuseness factors.
;                        SIGMA_D must have N_ELEMENTS(Z)+1 elements.
;
;
;              INTERFACE - 1D array of interface profiles
;                          functions. INTERFACE must have
;                          N_ELEMENTS(Z)+1 elements.
;
;                          INTERFACE=0 corresponds to an
;                          error-function interface profile;
;
;                          INTERFACE=1 corresponds to an exponential
;                          interface profile;
;
;                          INTERFACE=2 corresponds to a linear
;                          interface profile;
;
;                          INTERFACE=3 corresponds to a sinusoidal
;                          interface profile;
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;
;                          INTERFACE=4 corresponds to a step functoin
;                          interface.
;
;
;
;              ARES - Instrumental angular resolution, in degrees. The
;                     non-specular reflected intensity vs. angle will
;                     be convolved with a Gaussian of width ARES, in
;                     order to simulate a finite instrumental
;                     resolution.  You must specify three or more
;                     THETA_IN or THETA_OUT values to use ARES.
;
;       OUTPUTS:
;
;              DIDOMEGA - non-specular reflected intensity.
;
;
; COMMON BLOCKS:
; 
;       COMMON IMD,IMD 
;
; PROCEDURE:
;
;       Instrumental resolution is computed by convolution with a
;       gaussian, using the function INSTRUMENT_RES, usage:
;
;       Result=INSTRUMENT_RES(X,Y,RES,/ANGLE)
;
;       where RES is the width of the gaussian, and X and Y are the
;       independent and dependent variables (e.g., X=THETA,
;       Y=DIDOMEGA_S).  Set ANGLE to convolve didomega vs. angle.
;
; MODIFICATION HISTORY:
;
;       David L. Windt, Bell Labs, April, 1998
;
;       windt@bell-labs.com
;
;-

;+
; NAME:
;
;           IMD_F1F2TONK (procedure)
;
; PURPOSE:
;
;           This procedure is a widget interface to the IMD_F1F2TONK

;           function, and is used to compute optical constants (n,k)
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;           from atomic scattering factors for a compound specified by
;           composition and density.  The resulting optical constants are
;           plotted (using xnkplot; the plot can then be printed using
;           plot_print,) and can be saved to a text file (.nk format).
;
; CALLING SEQUENCE:
;
;           IMD_F1F2TONK
;           
; COMMON BLOCKS:
;
;           IMD
;           IMD_F1F2TONK
;
; RESTRICTIONS:
;
;  See the restrictions for the IMD_F1F2TONK function.
;
;
; PROCEDURE:
;
;  In this program, the optical constants are computed over a grid of
;  1000 energies, logarithmically spaced from 30 eV to 100 keV.
;
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, May 1997.
;
;   windt@bell-labs.com
;
;   November 1997: renamed from F1F2TONK; brand new widget interface.
;
;   April 1998: Default grid is now 1000 energies from 30 eV to 100
;   keV.
;
;-

;+
; NAME:
;
;           IMD_F1F2TONK (function)
;
; PURPOSE:
;
;           This function computes optical constants (n,k) from
;           atomic scattering factors for a compound specified
;           by its composition and density.
;
; CALLING SEQUENCE:
;
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;           Result=IMD_F1F2TONK(DENSITY,NUMBER,ELEMENT[,WAVELENGTH])
; 
;                      
; INPUT PARAMETERS:
;
;           DENSITY - compound density, in gm/cm3.
;           
;           NUMBER - scalar or array of relative concentrations. For example,
;                    to compute the optical constants for Al2O3, set 
;                    NUMBER=[2.,3.]
;         
;           ELEMENT - scalar or array of chemical element symbols. For example,
;                     to compute the optical constants for Al2O3, set 
;                     ELEMENT=['Al','O'].
;               
;           WAVELENGTH - vector of wavelengths. If omitted, the optical
;                        constants are computed over a logarithmically-spaced
;                        grid of 500 wavelengths from 0.413 to 413 A (i.e.,
;                        from 30 eV to 30 keV.)
;                                      
; OUTPUTS:
;
;       Result - A complex scalar or 1-D array (the same length
;                as WAVELENGTH) containing the optical constants (n,k).
; 
; KEYWORD PARAMETERS:
;
;     F1F2 - optional input or output array of atomic scattering factors.  
;            Dimensions=[2,N_ELEMENTS(NUMBER),N_ELEMENTS(WAVELENGTH)]; Thus
;            F1F2(0,0,*) are the F1 values for the first element, and 
;            F1F2(1,0,*) are the F2 values for the first element, and so on.
;            If F1F2 is dimensioned correctly, then the atomic scattering
;            factors are not read from the files corresponding to the elements
;            of the ELEMENT array, but rather the passed values are used.
;            (So be sure that the F1F2 values are correct!)
;            Conversely, if F1F2 is undefined (or ill-defined) then the
;            returned value of F1F2 will contain the F1 and F2 values read
;            from the atomic scattering factors files.
;                 
; COMMON BLOCKS:
;
;           IMD
;           IMD_F1F2TONK
;
; RESTRICTIONS:
;
;  The program uses atomic scattering factors compiled from the CXRO
;  and LLNL websites. (See Section A.3.)

;
;  The atomic scattering factor files must be located in the directory
;  specified in the file IMDSITECONFIG.PRO, located in the IMD
;  directory.  However, if the files are not found, the user will be
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;  prompted to enter the path leading to these files.
;
; PROCEDURE:
;
;  The optical constants are computed according to the principles
;  described in the paper "X-ray interactions: photoabsorption,
;  scattering, transmission, and reflection at E=50-30,000 eV,
;  Z=1-92", B.L. Henke, E. M. Gullikson, and J. C. Davis, Atomic
;  Data and Nuclear Data Tables, Vol. 54, No. 2, July 1993. (See
;  especially equations (17) and (18).)
;           
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, Nov 1997.
;   windt@bell-labs.com
;
;-

;+
; NAME:
;
;       IMD_NK
;
; PURPOSE:
;
;       A function used to read IMD optical constant files (.nk files).
;
;
; CALLING SEQUENCE:
;
;       Result=IMD_NK(MATERIAL,WAVELENGTH)
; 
; INPUTS:
;
;       MATERIAL - A string specifying the name of a valid 
;                  optical constant file, without the .nk extension.
;
;       WAVELENGTH - A scalar or 1-D array specifying the wavelength
;                    in angstroms.
;       
; OUTPUTS:
;
;       Result - A complex scalar or 1-D array (the same length
;                as WAVELENGTH) containing the optical constants (n,k).
;
; COMMON BLOCKS:
;
;       IMD
;       IMD_WIDGET
;
; PROCEDURE:
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;
;       The optical constant file is read, and the data are interpolated
;       (using FINDEX and INTERPOLATE) to get n and k at the specified
;       wavelengths.
;
; MODIFICATION HISTORY:
;
;  David L. Windt, Bell Labs, April 1997
;  windt@bell-labs.com
;-

;+
; NAME:
;
;           XNKPLOT
;
; PURPOSE:
;
;           This procedure plots optical constants n,k versus
;           wavelength, and allows the user the ability to adjust some
;           of the plot settings, and print the plot, through a GUI.
;
; CALLING SEQUENCE:
;
;           XNKPLOT[,LAMBDA,N,K]
; 
; OPTIONAL INPUTS:
;
;           LAMBDA - A 1D vector of wavelength values, in Angstroms
;
;           N, K - 1D vectors of n and k values
;
;           Note: if no inputs are supplied, the use can open a new
;           optical constant file from the File->Open menu option.
;
; RESTRICTIONS:
;
;           Requires widgets; uses lots of stuff in the
;           ~idl/user_contrib/windt directory.
;
; PROCEDURE:
;
;           Note that the procedure called NKPLOT (usage:
;           NKPLOT,LAMBDA,N,K) is the one that actually creates the
;           plot.  NKPLOT can be used on it's own if desired:
;
;           KEYWORDS to nkplot (in addition to most IDL keywords
;           accepted by the plot command):
;
;           XAXIS, NAXIS, KAXIS - 4-element vectors specifying the IDL
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;                                 [type,range(0),range(1),style] axis
;                                 values. i.e., type=1 for log plots,
;                                 etc.  For example, to plot n on a
;                                 linear scale from 0 to 2, and k on a
;                                 log scale from .1 to 10, specify
;                                 naxis=[0.,0.,2.,0.],kaxis=[1.,.1,10.,0.]
;                                 
;
;           NSTYLE, KSTYLE - 5-element vectors specifying the IDL
;                            [color,linestyle,thick,psym,symsize]
;                            values for the n and k curves. For
;                            example, to plot n using a red dashed line,
;                            specify nstyle=[2,1,0,0,0]
;                   
;           LABEL_POSITION - a scalar, in the range 0. to 1.,
;                            specifying the position along the xaxis
;                            for the 'n' and 'k' curve labels. (See
;                            the CURVE_LABEL procedure for more
;                            details.)
;
;           BANGY_N - the value of the !y system variable set after
;                     creating the n-vs-lambda plot.  the only reason
;                     to use this keyword is to enable subsequent use
;                     of the overplot keyword.
;
;           BANGY_K - the value of the !y system variable set after
;                     creating the k-vs-lambda plot.  the only reason
;                     to use this keyword is to enable subsequent use
;                     of the overplot keyword.
;
;           OVERPLOT - set this to overplot n and k vs lambda on an
;                      existing plot made with nkplot.  this keyword
;                      must be used with the bangy_n and bangy_k
;                      keywords.
;
;           Example:  plot two sets of n,k values on the same plot:
;
;
;                     NKPLOT,lambda1,n1,k1, $
;                            bangy_n=bangy_n,bangy_k=bangy_k
;                     NKPLOT,lambda2,n2,k2, $
;                            bangy_n=bangy_n,bangy_k=bangy_k,/overplot
;
; SIDE EFFECTS:
;
;           TEK_COLOR is used to set the color tables. 
;
; COMMON BLOCKS:
;
;           IMD
;           PLOT_PRINT (see ~windt/plot_print.pro)
;
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;
; RESTRICTIONS:
;
;  The program uses many procedures found in the
;  ~idl/user_contrib/windt directory.
;
; MODIFICATION HISTORY:
;
;  David L. Windt, Bell Labs, April 1997
;  windt@bell-labs.com
;-

;+
;
; NAME:
;
;     IMD_RD
;
; PURPOSE:
;
;     A function used to open IMD files.
;
; CALLING SEQUENCE:
;
;     Result=IMD_RD([FILE=FILE])
; 
; KEYWORD PARAMETERS:
;
;     FILE - The name of the IMD file to open.  If omitted, PICKFILE
;            will be used to get a file name.
;
; OUTPUTS:
;
;     Result - 0 or 1, depending on whether the file was opened
;              successfully or not.
;
; COMMON BLOCKS:
;
;     IMD
;     IMD_PARS
;     IMD_VARS
;     IMD_FPARS
;     IMD_FVARS
;     IMD_NSVARS
;
; RESTRICTIONS:
;
;     Must be used in the IMD environment.
;
;     New versions of IMD will probably not be able to open old IMD
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;     files.
;
; PROCEDURE:
;
;     IMD files are saved and opened using the IDL SAVE and RESTORE
;     commands.  The IMD_RD procedure does a few more things than just
;     calling RESTORE, so you should not try to open IMD files using
;     RESTORE directly.
; 
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, April 1997.
;   windt@bell-labs.com
;-

;+
;
; NAME:
;
;     IMD_M_RD
;
; PURPOSE:
;
;     A procedure to open a measured data file and define the IMD
;     variables X_M, Y_M, and SIGY_M, as well as the pointers X_M_PTR
;     and Y_M_PTR and some other important internal IMD variables.
;
; CALLING SEQUENCE:
;
;     IMD_M_RD,X_M_PTR=X_M_PTR,Y_M_PTR=Y_M_PTR,
;              RD_M_CMD=RD_M_CMD,
;              X_M_SCALE=X_M_SCALE,
;              Y_M_SCALE=Y_M_SCALE, 
;              X_M_OFFSET=X_M_OFFSET, 
;              Y_M_OFFSET=Y_M_OFFSET
;
; 
; INPUTS:
;
;     X_M_PTR - An integer that tells IMD to which independent variable
;               the X_M data refer.  X_M_PTR=0 indicates incidence
;               angle data and X_M_PTR=1 indicates wavelength (or
;               energy) data.  If other independent variables are
;               already defined in the IMD environment, then larger
;               values of X_M_PTR can be set.  The order of the
;               variables listed in the Independent Variables List, on
;               the main IMD widget, correspond to X_M_PTR values.
;
;               If X_M_PTR is omitted, then the data will be assumed
;               have an independent variable corresponding to the
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;               current value if IMD.X_M, i.e., if measured data has
;               already been defined, the new data will be assumed to
;               have the same independent variable, or if no data has
;               been read, IMD.X_M=0, indicating incidence angle data.
;
;     Y_M_PTR - An integer that tells IMD which dependent variable the
;               Y_M data refer to. Set 
;               
;               Y_M_PTR=0 for reflectanc 
;               Y_M_PTR=1 for transmittance 
;               Y_M_PTR=2 for absorptance 
;               Y_M_PTR=3 for psi 
;               Y_M_PTR=4 for delta 
;               Y_M_PTR=5 for user1 
;               Y_M_PTR=6 for user2 
;               Y_M_PTR=7 for user3 
;               Y_M_PTR=8 for non-specular reflected intensity 
;               
;
;     RD_M_CMD - A string specifying the command to actually read the
;                data file.  The command string must obey IDL syntax
;                rules.
;
; OPTIONAL KEYWORD PARAMETERS:
;
;     LIMIT_M - Set this keyword to 1 to cause IMD_M_RD to ignore measured 
;               data values outside the range specified by the X_M_RANGE
;               keyword if it is set, or by the current value of the
;               IMD.X_M_RANGE.  Set this keyword to 0 to use the entire data
;               set.  If LIMIT_M is not explicitly set, then the current 
;               value of IMD.LIMIT_M is used.
;               
;     X_M_RANGE - A 2-element array specifying the range of X_M values outside          
;                 of which the measured data is to be ignored.  For example,
;                 if the measured data file contains incidence angle data from
;                 0 to 90 degrees, but you wish to ignore data from 0 to 5 degrees
;                 and from 85 to 90 degrees, then set X_M_RANGE=[5.,85.].
;                 If X_M_RANGE is not set, then the current value of IMD.X_M_RANGE
;                 is used.  Note that X_M_RANGE (and/or IMD.X_M_RANGE) is only
;                 used if LIMIT_M (or IMD.LIMIT_M) is set to 1.      
;
;     X_M_OFFSET - An offset of X_M_OFFSET will be added to the X_M data.
;                  Default value is 0.
;                
;     X_M_SCALE - The X_M data will be multiplied by X_M_SCALE.
;                 Default value is 1.
;                
;     Y_M_OFFSET - An offset of Y_M_OFFSET will be added to the Y_M data.
;                  Default value is 0.
;                
;     Y_M_SCALE - The Y_M data will be multiplied by Y_M_SCALE.
;                 Default value is 1.
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;                
; COMMON BLOCKS:
;
;    IMD
;    IMD_VARS
;    IMD_PARS
;    IMD_NSVARS
;    IMD_M
;
; RESTRICTIONS:
;
;    If your data does not include experimental uncertainties, SIGY_M,
;    the uncertainty in Y_M, will be set to zero.  (In this case, you
;    will not be able to use instrumental weighting when performing
;    curve-fits in IMD.)
;    
;    NOTE: You should always use IMD_M_RD to open a measured data file from 
;    the IDL command line, even if you have written a procedure that defines
;    X_m, Y_m, and SIGY_m directly.
;
; PROCEDURE:
;
;    IMD_M_RD will read your data file, and it will set the IMD
;    measured-data-valid flag (IMD.M_VALID) accordingly.
;
;    The measured data file is opened, by using the EXECUTE function
;    with RD_M_CMD as an argument.  If RD_M_CMD does not include
;    X_M, Y_M, and optionally SIGY_M explicitly, than the procedure
;    to read the data must contain the IMD_M common block, and
;    these variables must be set inside the procedure.
;
;    Note: The X_M data will be converted to angstroms if X_M refers to 
;    wavelengths or lengths, or to degrees from the normal if X_m refers 
;    to angles.  The conversion will depend on the current values of the 
;    IMD internal pointers (IMD.ANGLEUNITS, IMD.PHOTONUNITS_PTR and 
;    IMD.LAYERUNITS_PTR; see Appendix B4), so it's important that these 

;    pointers are 'pointing' correctly BEFORE READING THE DATA.  You should
;    NEVER attempt to set these pointers yourself.
;    
;    For example, to read a measured data file containing three
;    columns of data - incidence angle, reflectance, and uncertainty
;    in reflectance - the EROM command could be used, so that the
;    value of RD_M_CMD would be set to
;
;    RD_M_CMD='EROM,X_M,Y_M,SIGY_M'
;
;    Alternatively, if you have an IDL procedure that you have written
;    to read you own measured data files, you would include the IMD_M
;    common block in your procedure (or function) and define X_M, Y_M,
;    and optionally SIGY_M explicitly:
;
;    RD_M_CMD='MY_PRO_TO_READ_MY_DATA'
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;
;    where:
;
;    PRO MY_PRO_TO_READ_MY_DATA
;
;    COMMON IMD_M
;
;    ;; IDL code to read your data goes here
;
;    X_M=my_x_data
;    Y_M=my_y_data
;
;    ;; and optionally
;    SIGY_M=my_sigy_data
;
;    return
;    end
; 
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, April 1997.
;   windt@bell-labs.com
;
;   November 1997: added the LIMIT_M and X_M_RANGE keywords.
;
;   April 1998: added the Y_M_SCALE keyword.
;   
;-

;+
; NAME:
;
;     IMDSPLOT
;     IMDNPLOT
;     IMDFPLOT
;     IMDCPLOT
;
; PURPOSE:
;
;     These four procedures produce 1D and/or 2D plots of specular
;     optical properties (reflectance/transmittance/absorptance
;     etc. ), non-specular reflected intensity, field intensity, and
;     confidence levels, respectively.
;
;     See the KEYWORD and PROCEDURE sections below for details.
;     
; CALLING SEQUENCE:
;
;     IMDSPLOT
;     IMDNPLOT
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;     IMDFPLOT
;     IMDCPLOT
; 
; KEYWORD PARAMETERS:
;
;     IVINDICES - (IMDSPLOT,IMDNPLOT, IMDFPLOT only) Array indicating
;                 the array indices of independent variables. The
;                 length of IVINDICES is equal to the number of
;                 independent variables that are defined (as indicated
;                 in the Independent Variables list on the IMD
;                 widget).  There are always at least two independent
;                 variables - angle and wavelength; in the case of
;                 IMDFPLOT, there are at least three: depth, angle,
;                 and wavelength; in the case of IMDNPLOT, there are
;                 at least four: angle, wavelength, scattering angle,
;                 and scattering plane azimuthal angle (phi).
;                 
;                 This keyword only has an effect if you're plotting
;                 data that involve more than one multi-valued
;                 independent variable.  See the PROCEDURE section
;                 below for details.
;     
;     FPINDICES - (IMDCPLOT only) Array indicating the array indices
;                 of fit parameters.  Similar to IVINDICES (above.)
;
;     LEVEL - (IMDCPLOT only) the Chi^2 confidence level (from 0-100).
;
;     JOINT - (IMDCPLOT only) 0 for independent confidence intervals,
;             1 for joint confidence intervals.
;
;     OVERPLOT - Don't draw plot axes, just overplot the data.
;     
;     S_LABEL_POS - An integer from 0 to 12, indicating the position
;                   for the Structure label.  See the PLOT_TEXT
;                   procedure for details.
;     
;     FP_LABEL_POS - An integer from 0 to 12, indicating the position
;                    for the Fit Parameters label (IMDSPLOT and
;                    IMDCPLOT only).  See the PLOT_TEXT procedure for
;                    details.
;     
;     APFQ_LABEL_POS - An integer from 0 to 12, indicating the
;                      position for the Angular Resultion/Spectral
;                      Resolution/ Polarization label.  See the
;                      PLOT_TEXT procedure for details.
;     
;     CURVE_LABEL_POS - A floating point number from 0 to 1 indicating
;                       the position for curve labels.  See the
;                       CURVE_LABEL procedure for details.  This
;                       keyword only has an effect if
;                       IMDSPLOT.LEGEND=0 (for IMDSPLOT),
;                       IMDNPLOT.LEGEND=0 (for IMDNPLOT),
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;                       IMDFPLOT.LEGEND=0 (for IMDFPLOT), or
;                       IMDCPLOT.LEGEND=0 (for IMDCPLOT).
;     
;     LEGEND_POS - An integer from 0 to 12, indicating the position
;                  for the plot legend. See the LEGEND procedure for
;                  details.This keyword only has an effect if
;                  IMDSPLOT.LEGEND=1 (for IMDSPLOT), IMDFPLOT.LEGEND=1
;                  (for IMDFPLOT), or IMDCPLOT.LEGEND=1 (for
;                  IMDCPLOT).
;     
;     CLABEL - String array to label curves using CURVE_LABEL or
;              LEGEND.  If non-null, then the values supplied will be
;              used on the plot.  Otherwise, the program will return
;              the values automatically generated.  These returned
;              values can then be used to label the plot later.  This
;              latter behavior is useful when you want to include
;              multiple variables using the OVERPLOT keyword, and you
;              wish to label all the curves using LEGEND; Use of the
;              NO_CLABEL keyword would thus be appropriate.
;
;     NO_CLABEL - Don't actually draw the curve labels. (But CLABEL
;                 will still contain the strings that would have been
;                 labelled.)
;
;     FORCE_CLABEL - Force the curve labels to include the independent
;                    variable (or fit parameter) values that would
;                    otherwise wind up in the subtitle.
;     
;     LEGEND_STYLE - An N x 5 array, where N is the number of
;                    dependent variables on the plot, containing the N
;                    values of COLOR, LINESTYLE, THICK, PSYM, and SYMSIZE
;                    for each curve.  These values can thus be used
;                    to instruct LEGEND on how to create a legend
;                    to correspond with what was plotted.
;                    
;     DCHI2_LABEL_POS - (1D IMDCPLOTs only) A floating point number from 0
;                       to 1 indicating the position for the Chi^2
;                       curve label.  See the CURVE_LABEL procedure
;                       for details.  
;     
;     DCHI2LABEL - (1D IMDCPLOTs only) A string specifying the label
;                  to use for the Chi^2 label.
;
;     XTITLE
;     YTITLE
;     PYTITLE (IMDSPLOT only; phase axis)
;     ZTITLE (IMDSPLOT, IMDNPLOT, IMDFPLOT only)
;     SUBTITLE
;     TITLE - The usual graphics keywords. If non-null, then these
;             values will appear on the plot. Otherwise, the program
;             will return the values automatically generated.
;     
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;     XTYPE, XRANGE, XSTYLE
;     YTYPE, YRANGE, YSTYLE
;     PYTYPE, PYRANGE, PYSTYLE, PYTICKS (IMDSPLOT only; phase axis)
;     ZTYPE, ZRANGE, ZSTYLE (IMDSPLOT, IMDNPLOT, IMDFPLOT only)
;             The usual graphics keywords.
;     
;     YMARGIN0 - Set this to make extra space below a plot to allow
;                for PLOT_TEXT boxes and LEGEND boxes.
;     
;     HORIZONTAL - The HORIZONTAL keyword for surface plots.
;
;     STATS_FLAGS - (IMDSPLOT, IMDNPLOT only) a six-element array of
;                   flags indicating which statistics are to be
;                   computed and displayed (overrides IMDSPLOT.STATS_FLAGS
;                   or IMDNPLOT.STATS_FLAGS)
;
;                      STATS_FLAGS(0): set to compute min
;                      STATS_FLAGS(1): set to compute max
;                      STATS_FLAGS(2): set to compute average
;                      STATS_FLAGS(3): set to compute integral
;                      STATS_FLAGS(4): set to compute fwhmax
;                      STATS_FLAGS(5): set to compute fwhmin
;
;     STATS_FUNCTION - (IMDSPLOT, IMDNPLOT only) an integer specifying
;                      which function is to be used when computing
;                      statistics (overrides IMDSPLOT.STATS_FUNCTION
;                      or IMDNPLOT.STATS_FUNCTION)
;
;                      for IMDSPLOT:
;
;                      STATS_FUNCTION = 0 for average reflectance
;                      STATS_FUNCTION = 1 for s-reflectance
;                      STATS_FUNCTION = 2 for p-reflectance
;                      STATS_FUNCTION = 3 for s-reflected phase
;                      STATS_FUNCTION = 4 for p-reflected phase
;                      STATS_FUNCTION = 5 for psi
;                      STATS_FUNCTION = 6 for delta
;                      STATS_FUNCTION = 7 for average transmittance
;                      STATS_FUNCTION = 8 for s-transmittance
;                      STATS_FUNCTION = 9 for p-transmittance
;                      STATS_FUNCTION = 10 for s-transmitted phase
;                      STATS_FUNCTION = 11 for p-transmitted phase
;                      STATS_FUNCTION = 12 for average absorptance
;                      STATS_FUNCTION = 13 for s-absorptance
;                      STATS_FUNCTION = 14 for p-absorptance
;                      STATS_FUNCTION = 15 for user1
;                      STATS_FUNCTION = 16 for user2
;                      STATS_FUNCTION = 17 for user3
;                      
;                      for IMDNPLOT:
;
;                      STATS_FUNCTION = 0 for didomega_baa
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;                      STATS_FUNCTION = 1 for didomega_bas
;                      STATS_FUNCTION = 2 for didomega_bap
;                      STATS_FUNCTION = 3 for didomega_dwba
;
;     ROI_FLAG - (IMDSPLOT, IMDNPLOT only) set to 1 to display
;                region-of-interest lines.
;
;     ROI_RANGE - (IMDSPLOT, IMDNPLOT only) a two-element array
;                 specifying the region-of-interest array indices of
;                 the X-axis plot variable.
;
;     TD_PARS - a 2-element array indicating what type of 2D plot
;               draw: For a surface plot, set TD_PARS(0)=0; for a
;               contour plot, TD_PARS(0)=1; for a filled contour
;               plots, set TD_PARS(0)=2; and for a cont_image plot
;               (using the CONT_IMAGE procedure in the windt library),
;               set TD_PARS(0)=3.  TD_PARS(1) is the number of contour
;               levels to draw when TD_PARS(0) is greater than 0.
;               
;
;     QSPACE - a scalar flag indicating that an angle axis or axes are
;              to be plotted in momentum space instead of real
;              space.
;
;              For IMDNPLOT,
;
;              QSPACE=1 => 1D plot vs. q_x
;              QSPACE=2 => 1D plot vs. q_y
;              QSPACE=3 => 1D plot vs. q_z
;              QSPACE=4 => 2D plot vs. q_x vs q_y
;              QSPACE=5 => 2D plot vs. q_x vs q_z
;              QSPACE=6 => 2D plot vs. q_y vs q_z
;
;              For IMDSPLOT, IMDFPLOT and IMDCPLOT, a QSPACE value
;              greater than one results in a 1D or 2D plot vs. q_z.
;
;              If lambda (or phi) are plot variables, momentum space
;              plots are not possible.
;
;     The following keywords determine which dependent variables
;     are plotted
;
;     IMDSPLOT only:
;
;     PLOT - an array of flags indicating which functions to plot:
;     
;     PLOT(0) - Plot average reflectance (overrides IMDSPLOT.RA)
;     PLOT(1) - Plot s-reflectance (overrides IMDSPLOT.RS)
;     PLOT(2) - Plot p-reflectance (overrides IMDSPLOT.RP)
;     PLOT(3) - Plot reflected s-phase (overrides IMDSPLOT.PRS)
;     PLOT(4) - Plot reflected p-phase (overrides IMDSPLOT.PRP)
;     PLOT(5) - Plot ellipsometric psi (overrides IMDSPLOT.PSI)
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;     PLOT(6) - Plot ellipsometric delta (overrides IMDSPLOT.DELTA)
;     PLOT(7)  - Plot average transmittance (overrides IMDSPLOT.TA)
;     PLOT(8)  - Plot s-transmittance (overrides IMDSPLOT.TS)
;     PLOT(9)  - Plot p-transmittance (overrides IMDSPLOT.TP)
;     PLOT(10) - Plot transmitted s-phase (overrides IMDSPLOT.PTS)
;     PLOT(11) - Plot transmitted p-phase (overrides IMDSPLOT.PTP)
;     PLOT(12) - Plot average absorptance (overrides IMDSPLOT.AA)
;     PLOT(13) - Plot s-absorptance (overrides IMDSPLOT.AS)
;     PLOT(14) - Plot p-absorptance (overrides IMDSPLOT.AP)
;     PLOT(15) - Plot user1 function (overrides IMDSPLOT.USER1)
;     PLOT(16) - Plot user2 function (overrides IMDSPLOT.USER2)
;     PLOT(17) - Plot user3 function (overrides IMDSPLOT.USER3)
;
;     IMDNPLOT only:
;
;     PLOT - an array of flags indicating which functions to plot:
;     
;     PLOT(0) - Plot didomega_baa (overrides IMDNPLOT.BAA)
;     PLOT(1) - Plot didomega_bas (overrides IMDNPLOT.BAS)
;     PLOT(2) - Plot didomega_bap (overrides IMDNPLOT.BAP)
;     PLOT(3) - Plot didomega_dwba (overrides IMDNPLOT.DWBA)
;
;     IMDFPLOT only:
;     
;     PLOT_FA - Plot average field intensity (overrides IMDFPLOT.FA)
;     PLOT_FS - Plot s-field intensity (overrides IMDFPLOT.FA)
;     PLOT_FP - Plot p-field intensity (overrides IMDFPLOT.FA)
;
;     The following keywords are all 5-element arrays, specifying
;     how the dependent variables are to appear.  The 5-elements
;     correspond to the [COLOR, LINESTYLE, THICK, PSYM, SYMSIZE]
;     graphics keywords.
;
;     IMDSPLOT only:
;     
;     RASTYLE - average reflectance style
;     RSSTYLE - s-reflectance style
;     RPSTYLE - p-reflectance style
;     PRSSTYLE - s-reflected phase style
;     PRPSTYLE - p-reflected phase style
;     TASTYLE - average transmittance style
;     TSSTYLE - s-transmittance style
;     TPSTYLE - p-transmittance style
;     PTSSTYLE - s-transmitted phase style
;     PTPSTYLE - p-transmitted phase style
;     AASTYLE - average absorptance style
;     ASSTYLE - s-absorptance style
;     APSTYLE - p-absorptance style
;     
;     IMDFPLOT only:
;
;     FASTYLE - average field intensity style
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;     FSSTYLE - s-field intensity style
;     FPSTYLE - p-field intensity style
;     ISTYLE - interface line style (PSYM and SYMSIZE are ignored)
;
;     NOINTERFACE - Set to inhibit IMDFPLOT from drawing the interface
;                   lines.
;
;     IMDCPLOT only:
;     
;     CSTYLE - Chi^2 style (PSYM and SYMSIZE are ignored for contour
;              plots)
;              
;     PTSTYLE - Best fit point style (only PSYM and SYMSIZE are used.)
;
;
; PROCEDURE/EXAMPLES:
;
;     If you have calculated optical properties, field intensities or
;     chi^2 values for only one independent variable (or fit
;     parameter), then you need not worry about the following
;     discussion.  Just type IMDSPLOT, IMDFPLOT, or IMDCPLOT at the
;     command line and a plot will appear.
;
;     On the other hand....
;
;     In the case of IMDSPLOT and IMDFPLOT, if more than one
;     (muti-valued) independent variable is available, or in the case
;     of IMDCPLOT, if more than one (multi-valued) fit parameter is
;     available, the value of the IMD common block variable
;     IMDSPLOT.IV, IMDFPLOT.IV, or IMDCPLOT.FP determines what is
;     actually plotted.  These three variables are bit-wise flags that
;     indicate whether or not an independent variable (or fit
;     parameter) is to be used as a continuous plot variable, or as a
;     discrete plot variable.  That is, if bit 0 of IMDSPLOT.IV is
;     set, then the optical functions will be plotted versus incidence
;     angle; if bit 1 is set, then the optical functions will be set
;     versus wavelength (or energy).  If other independent variables
;     are available (as listed in the Independent Variables List on
;     the main IMD widget), then other bits can be set as well.
;     Similarly for IMDFPLOT.IV, except bit 0 now refers to depth, bit
;     1 to incidence angle, bit 2 to wavelength, etc.  IMDCPLOT.FP
;     works the same way, except each bit corresponds to an available
;     fit parameter that has been varied to construct the Chi^2 array.
;
;     If two bits of IMDSPLOT.IV, IMDFPLOT.IV or IMDCPLOT.FP are
;     set, then a surface plot (or a contour plot in the case of
;     IMDCPLOT) will be created.
;
;     You will also need to set the value of IVINDICES (or FPINDICES
;     in the case of IMDCPLOT), in order to specify discrete independent
;     variables or fit parameters.
;
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;   EXAMPLE 1
;
;     Suppose you've computed reflectance vs incidence angle vs
;     wavelength, for 20 incidence angles and 30 wavelengths.  The IMD
;     reflectance variable (R) will thus be a 20x30 element array.  To
;     plot Reflectance vs Incidence Angle, for the wavelength
;     corresponding to the 12th element of the wavelength array,
;     use the following commands:
;
;     IMD> imdsplot.iv=1
;     IMD> imdsplot,ivindices=[0,12]
;
;     Alternatively, to plot reflectance vs. wavelength, for the
;     angle corresponding to the 9th element of the angle array,
;     type:
;
;     IMD> imdsplot.iv=2
;     IMD> imdsplot,ivindices=[9,0]
;
;     Finally, to produce a surface plot of reflectance vs angle vs
;     wavelength:
;
;     IMD> imdsplot.iv=3
;     IMD> imdsplot
;
;   EXAMPLE 2
;
;     Here's how to plot the results from two separate IMD calculations
;     on the same plot:
;
;     IMD> rd=imd_rd(file='file1.dat')
;     IMD> imdsplot
;     IMD> rd=imd_rd(file='file2.dat')
;     IMD> imdsplot,/overplot
;
;     Of course you'll probably want to make use of some of the other
;     keywords, in order to properly label and distinguish between
;     the two data sets.  For example, instead of the above, you
;     might try something like:
;     
;     IMD> rd=imd_rd(file='file1.dat')
;     IMD> imdsplot,clabel=['File 1'],s_label_pos=0
;     IMD> rd=imd_rd(file='file2.dat')
;     IMD> imdsplot,/overplot,clabel=['File 2'],rastyle=[2,0,0,0,0]     
; 
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, April 1997.
;
;   Many changes to IMD V4.0 - April, 1998.
;   
;   windt@bell-labs.com

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/B.2.html (31 of 33) [18/06/2002 17:02:01]



IMD B.2 Some IMD functions and procedures

;-

    
;+
;
; NAME:
;
;     IMDMPLOT
;
; PURPOSE:
;
;     Produce plots of measured data.
;
; CALLING SEQUENCE:
;
;     IMDMPLOT
; 
; KEYWORD PARAMETERS:
; 
;     The XTITLE, YTITLE, SUBTITLE, TITLE, CHARSIZE, OVERPLOT,
;     CURVE_LABEL_POS, LEGEND_POS, NO_LABEL, CLABEL and QSPACE
;     keywords work the same way as for IMDSPLOT/IMDNPLOT.
;
;     In addition, the MSTYLE keyword is an array specifying [COLOR,
;     LINESTYLE, THICK, PSYM, and SYMSIZE values for the measured
;     data.
;
; EXAMPLE:
;
;    Here's how to open an IMD data file, open a measured data file
;    containing reflectance vs. incidence angle data, plot the IMD
;    data, and overplot your measured data:
;
;    IMD> rd=imd_rd(file='file.dat')
;    IMD> imdsplot
;    IMD> imd_m_rd,rd_m_cmd='erom,x_m,y_m,sigy_m',x_m_ptr=0,y_m_ptr=0
;    IMD> imdmplot,/overplot
;
; 
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, April 1997.
;   
;   April, 1998: Many changes upgrading to IMD V4.0. 
;   
;   windt@bell-labs.com
;-

;+
; NAME:

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/B.2.html (32 of 33) [18/06/2002 17:02:01]



IMD B.2 Some IMD functions and procedures

;
;    IMD_PLOT_LBL
;
; PURPOSE:
;
;    A procedure to add labels to a plot.
;
; CALLING SEQUENCE:
;
;    IMD_PLOT_LBL,/OPLOT or /FPLOT or /CPLOT
; 
; INPUTS:
;
;   OPLOT, FPLOT, CPLOT - indicates what type of plot to label.
;
; KEYWORD PARAMETERS:
;
;   S_LABEL_POS
;   FP_LABEL_POS
;   APFQ_LABEL_POS
;
;   See the description of these keywords in the
;   IMDSPLOT/IMDFPLOT/IMDCPLOT documentation above.
;
;   Setting these keywords overrides the current value of the
;   corresponding flags:
;   
;   IMDSPLOT.S_LABEL,IMDFPLOT.S_LABEL, IMDCPLOT.S_LABEL;
;   
;   IMDSPLOT.FP_LABEL, IMDCPLOT.FP_LABEL;
;   
;   IMDSPLOT.APFQ_LABEL,IMDFPLOT.APFQ_LABEL, IMDCPLOT.APFQ_LABEL;
;
;
; MODIFICATION HISTORY:
;
;   David L. Windt, Bell Labs, April 1997.
;   windt@bell-labs.com
;-

Back | Contents | Next

file:///C|/Documents%20and%20Settings/srio/My%20Documents/XOP-DOC/extensions/imd/B.2.html (33 of 33) [18/06/2002 17:02:01]



IMD Appendix B. Notes for IDL programmers

Appendix B- Notes for IDL programmers

(Be warned that if you don't do much IDL programming, you might be frightened by what's contained in 
B.2 and especially B.3) 

B.1 Customizing the installation

B.2 Some IMD functions and procedure

B.3 Reading measured data files

B.4 IMD common block variables

Back | Contents | Next
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B.4 IMD COMMON block variables

Listed here, for those of you who might actually be interested in such things, are all the IMD COMMON blocks. All of 
these COMMON block variables are accessible from the IDL command line, whenever you see the IMD prompt. I'm only 
going to describe the variables that you really ought to be concerned with (to the extent that you wish to be concerned.)

Click here to go directly to the COMMON IMD_VARS section, containing the variables you are most likely to use when 
defining user-functions (as described in Section 2.3).

;  COMMON IMD, $
;    IMD,IMDHOME,IMD_NKPATH,IMD_NKPATH_PTR, $
;    IMDSPLOT,IMDSPLOT_FC,IMDSPLOT_BANGPY, $
;    IMDNPLOT,IMDNPLOT_FC, $
;    IMDFPLOT,IMDFPLOT_FC, $
;    IMDCPLOT,IMDCPLOT_FC, $
;    IMDPRINT
;  
;  ------------------------------------------------------------------------------
;  
;  IMD - A structure largely controlling the behavior of IMD.  The only
;        tags you might need to be concerned with are:
;  
;  
;  IMD.ANGLEUNITS_PTR - Pointer for angle units: 0=normal, 1=grazing.
;  
;  IMD.PHOTONUNITS_PTR - Pointer for photon units: 0=A, 1=nm, 2=um, 3=eV, 4=keV.
;  
;  IMD.LAYERUNITS_PTR - Pointer for layer (length) units: 0=A, 1=nm, 2=um
;  
;  
;  IMD.Y_M - Measured data dependent variable pointer.
;  
;  IMD.X_M - Measured data independent variable pointer.
;  
;  IMD.RD_M_CMD - Read measured data command.
;  
;  IMD.LIMIT_M - Flag to indicate whether or not to limit measured data.
;  
;  IMD.X_M_RANGE - 2-element array specifying the X_M range of valid measured data.
;  
;  IMD.X_M_OFFSET - Offset factor to be added to X_M data.
;
;  IMD.X_M_SCALE - Scale factor to be applied to X_M data.
;
;  IMD.Y_M_OFFSET - Offset factor to be added to Y_M data.
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;
;  IMD.Y_M_SCALE - Scale factor to be applied to Y_M data.
;
;  ------------------------------------------------------------------------------
;  
;  IMDSPLOT - A structure controlling the behavior of the IMDSPLOT
;             procedure, containing the following tags:
;  
;  IMDSPLOT.XAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDSPLOT.YAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDSPLOT.PYAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDSPLOT.ZAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDSPLOT.IV - Bit-wise flag for independent variables.
;  IMDSPLOT.IVINDICES - Array indices for independent variables.
;  IMDSPLOT.M - Plot measured data flag
;  IMDSPLOT.RA - Plot average reflectance flag
;  IMDSPLOT.RS - Plot s-reflectance flag.
;  IMDSPLOT.RP - Plot p-reflectance flag.
;  IMDSPLOT.PRS - Plot s-reflected phase flag.
;  IMDSPLOT.PRP - Plot p-reflected phase flag.
;  IMDSPLOT.PSI - Plot ellipsometric psi flag.
;  IMDSPLOT.DELTA - Plot ellipsometric delta flag.
;  IMDSPLOT.TA - Plot average reflectance flag
;  IMDSPLOT.TS - Plot s-transmittance flag.
;  IMDSPLOT.TP - Plot p-transmittance flag.
;  IMDSPLOT.PTS - Plot s-transmitted phase flag.
;  IMDSPLOT.PTP - Plot p-transmitted phase flag.
;  IMDSPLOT.AA - Plot average absorptance flag
;  IMDSPLOT.AS - Plot s-absorptance flag.
;  IMDSPLOT.AP - Plot p-absorptance flag.
;  IMDSPLOT.USER1 - Plot user1 flag.
;  IMDSPLOT.USER2 - Plot user2 flag.
;  IMDSPLOT.USER3 - Plot user3 flag.
;  IMDSPLOT.RASTYLE - Style parameters for average reflectance
;  IMDSPLOT.RSSTYLE - Style parameters for s-reflectance
;  IMDSPLOT.RPSTYLE - Style parameters for p-reflectance
;  IMDSPLOT.PRSSTYLE - Style parameters for s-reflected phase
;  IMDSPLOT.PRPSTYLE - Style parameters for p-reflected phase
;  IMDSPLOT.PSISTYLE - Style parameters for psi
;  IMDSPLOT.DELTASTYLE - Style parameters for delta
;  IMDSPLOT.TASTYLE - Style parameters for average transmittance
;  IMDSPLOT.TSSTYLE - Style parameters for s-transmittance
;  IMDSPLOT.TPSTYLE - Style parameters for p-transmittance
;  IMDSPLOT.PTSSTYLE - Style parameters for s-transmitted phase
;  IMDSPLOT.PTPSTYLE - Style parameters for p-transmitted phase
;  IMDSPLOT.AASTYLE - Style parameters for average absorptance
;  IMDSPLOT.ASSTYLE - Style parameters for s-absorptance
;  IMDSPLOT.APSTYLE - Style parameters for p-absorptance
;  IMDSPLOT.USER1STYLE - Style parameters for user1
;  IMDSPLOT.USER2STYLE - Style parameters for user2
;  IMDSPLOT.USER3STYLE - Style parameters for user3
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;  IMDSPLOT.MSTYLE - Style parameters for average reflectance
;  IMDSPLOT.MCLABEL - Curve label for measured data.
;  IMDSPLOT.MCURVE_LABEL_POS - Curve label position for measured data.
;  IMDSPLOT.TITLE - Title
;  IMDSPLOT.AUTO_TITLE - Automatically generate titles.
;  IMDSPLOT.SUBTITLE - Subtitle
;  IMDSPLOT.AUTO_SUBTITLE - Automatically generate subtitles.
;  IMDSPLOT.XTITLE - Xtitle
;  IMDSPLOT.AUTO_XTITLE - Automatically generate xtitle
;  IMDSPLOT.YTITLE - Ytitle
;  IMDSPLOT.AUTO_YTITLE - Automatically generate ytitle
;  IMDSPLOT.PYTITLE - Phase title
;  IMDSPLOT.AUTO_PYTITLE - Automatically generate phase title
;  IMDSPLOT.ZTITLE - Ztitle
;  IMDSPLOT.AUTO_ZTITLE - Automatically generate ztitle
;  IMDSPLOT.CHARSIZE - Charsize
;  IMDSPLOT.S_LABEL_POS - Position for structure label
;  IMDSPLOT.APFQ_LABEL_POS - Position for ares/pres/f/q label
;  IMDSPLOT.FP_LABEL_POS - Position for fit parameters label
;  IMDSPLOT.LEGEND:0 -  0: use curve_label, 1: use legend, -1: no legend
;  IMDSPLOT.CURVE_LABEL_POS - Curve_label position
;  IMDSPLOT.CLABEL - Curve labels
;  IMDSPLOT.LEGEND_POS - Position for legend.
;  IMDSPLOT.BANGX - Private copy of !x
;  IMDSPLOT.BANGY - Private copy of !y
;  IMDSPLOT.BANGZ - Private copy of !z
;  IMDSPLOT.BANGPY - Private copy of !y used for phase plots
;  IMDSPLOT.BANGP - Private copy of !p
;  IMDSPLOT.WXSIZE - Plot window X size
;  IMDSPLOT.WYSIZE - Plot window Y size
;  IMDSPLOT.QSPACE - Flag for q-space plots
;  IMDSPLOT.THREED - Flag for type of 2D plot.
;  IMDSPLOT.C_NLEVELS - Number of contour levels for contour plots.
;  IMDSPLOT.HORIZONTAL- Horizontal keyword to surface
;  IMDSPLOT.CURSOR_VALUE - Cursor function pointer.
;  IMDSPLOT.STATS_FUNCTION - Statistics function pointer.
;  IMDSPLOT.STATS_FLAGS - Array of flags for computing statistics
;  IMDSPLOT.STATS - Array of statistics values.
;  IMDSPLOT.STATS_PRECISION - Array of integers specifying statistics
;                             display precision
;  IMDSPLOT.ROI_RANGE - 2-element array of substrates for ROI
;  IMDSPLOT.ROI_MARK_FLAG - flag to indicate that the ROI is in the
;                           process of being marked.
;  IMDSPLOT.ROI - flag to indicate ROI.
;
;  ------------------------------------------------------------------------------
;  
;  IMDNPLOT - A structure controlling the behavior of the IMDNPLOT
;             procedure, containing the following tags:
;  
;  IMDNPLOT.XAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
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;  IMDNPLOT.YAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDNPLOT.ZAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDNPLOT.IV - Bit-wise flag for independent variables.
;  IMDNPLOT.IVINDICES - Array indices for independent variables.
;  IMDNPLOT.M - Plot measured data flag
;  IMDNPLOT.BAA - Plot didomega_baa
;  IMDNPLOT.BAS - Plot didomega_bas
;  IMDNPLOT.BAP - Plot didomega_bap
;  IMDNPLOT.DWBA - Plot didomega_dwba
;  IMDNPLOT.BAASTYLE - Style parameters for didomega_baa
;  IMDNPLOT.BASSTYLE - Style parameters for didomega_bas
;  IMDNPLOT.BAPSTYLE - Style parameters for didomega_bap
;  IMDNPLOT.DWBASTYLE - Style parameters for didomega_dwba
;  IMDNPLOT.MSTYLE - Style parameters for average reflectance
;  IMDNPLOT.MCLABEL - Curve label for measured data.
;  IMDNPLOT.MCURVE_LABEL_POS - Curve label position for measured data.
;  IMDNPLOT.TITLE - Title
;  IMDNPLOT.AUTO_TITLE - Automatically generate titles.
;  IMDNPLOT.SUBTITLE - Subtitle
;  IMDNPLOT.AUTO_SUBTITLE - Automatically generate subtitles.
;  IMDNPLOT.XTITLE - Xtitle
;  IMDNPLOT.AUTO_XTITLE - Automatically generate xtitle
;  IMDNPLOT.YTITLE - Ytitle
;  IMDNPLOT.AUTO_YTITLE - Automatically generate ytitle
;  IMDNPLOT.PYTITLE - Phase title
;  IMDNPLOT.AUTO_PYTITLE - Automatically generate phase title
;  IMDNPLOT.ZTITLE - Ztitle
;  IMDNPLOT.AUTO_ZTITLE - Automatically generate ztitle
;  IMDNPLOT.CHARSIZE - Charsize
;  IMDNPLOT.S_LABEL_POS - Position for structure label
;  IMDNPLOT.APFQ_LABEL_POS - Position for ares/pres/f/q label
;  IMDNPLOT.FP_LABEL_POS - Position for fit parameters label
;  IMDNPLOT.LEGEND:0 -  0: use curve_label, 1: use legend, -1: no legend
;  IMDNPLOT.CURVE_LABEL_POS - Curve_label position
;  IMDNPLOT.CLABEL - Curve labels
;  IMDNPLOT.LEGEND_POS - Position for legend.
;  IMDNPLOT.BANGX - Private copy of !x
;  IMDNPLOT.BANGY - Private copy of !y
;  IMDNPLOT.BANGZ - Private copy of !z
;  IMDNPLOT.BANGP - Private copy of !p
;  IMDNPLOT.WXSIZE - Plot window X size
;  IMDNPLOT.WYSIZE - Plot window Y size
;  IMDNPLOT.QSPACE - Flag for q-space plots
;  IMDNPLOT.THREED - Flag for type of 2D plot.
;  IMDNPLOT.C_NLEVELS - Number of contour levels for contour plots.
;  IMDNPLOT.HORIZONTAL- Horizontal keyword to surface
;  IMDNPLOT.CURSOR_VALUE - Cursor function pointer.
;  IMDNPLOT.STATS_FUNCTION - Statistics function pointer.
;  IMDNPLOT.STATS_FLAGS - Array of flags for computing statistics
;  IMDNPLOT.STATS - Array of statistics values.
;  IMDNPLOT.STATS_PRECISION - Array of integers specifying statistics
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;                             display precision
;  IMDNPLOT.ROI_RANGE - 2-element array of substrates for ROI
;  IMDNPLOT.ROI_MARK_FLAG - flag to indicate that the ROI is in the
;                           process of being marked.
;  IMDNPLOT.ROI - flag to indicate ROI.
;
;  ------------------------------------------------------------------------------
;  
;  IMDFPLOT - A structure controlling the behavior of the IMDFPLOT
;             procedure, containing the following tags:
;  
;  IMDFPLOT.XAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDFPLOT.YAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDFPLOT.ZAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDFPLOT.IV - Bit-wise flag for independent variables.
;  IMDFPLOT.IVINDICES - Array indices for independent variables.
;  IMDFPLOT.FA - Plot average field intensity flag
;  IMDFPLOT.FS - Plot s-field intensity flag.
;  IMDFPLOT.FP - Plot p-field intensity flag.
;  IMDFPLOT.FASTYLE - Style parameters for average field intensity
;  IMDFPLOT.FSSTYLE - Style parameters for s-field intensity
;  IMDFPLOT.FPSTYLE - Style parameters for p-field intensity
;  IMDFPLOT.TITLE - Title
;  IMDFPLOT.AUTO_TITLE - Automatically generate titles.
;  IMDFPLOT.SUBTITLE - Subtitle
;  IMDFPLOT.AUTO_SUBTITLE - Automatically generate subtitles.
;  IMDFPLOT.XTITLE - Xtitle
;  IMDFPLOT.AUTO_XTITLE - Automatically generate xtitle
;  IMDFPLOT.YTITLE - Ytitle
;  IMDFPLOT.AUTO_YTITLE - Automatically generate ytitle
;  IMDFPLOT.ZTITLE - Ztitle
;  IMDFPLOT.AUTO_ZTITLE - Automatically generate ztitle
;  IMDFPLOT.CHARSIZE - Charsize
;  IMDFPLOT.S_LABEL_POS - Position for structure label
;  IMDFPLOT.APFQ_LABEL_POS - Position for ares/pres/f/q label
;  IMDFPLOT.LEGEND:0 -  0: use curve_label, 1: use legend, -1: no legend
;  IMDFPLOT.CURVE_LABEL_POS - Curve_label position
;  IMDFPLOT.CLABEL - Curve labels
;  IMDFPLOT.LEGEND_POS - Position for legend.
;  IMDFPLOT.BANGX - Private copy of !x
;  IMDFPLOT.BANGY - Private copy of !y
;  IMDFPLOT.BANGZ - Private copy of !z
;  IMDFPLOT.BANGP - Private copy of !p
;  IMDFPLOT.WXSIZE - Plot window X size
;  IMDFPLOT.WYSIZE - Plot window Y size
;  IMDFPLOT.QSPACE - Flag for q-space plots
;  IMDFPLOT.THREED - Flag for type of 2D plot.
;  IMDFPLOT.C_NLEVELS - Number of contour levels for contour plots.
;  IMDFPLOT.HORIZONTAL- Horizontal keyword to surface
;  
;  ------------------------------------------------------------------------------
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;  
;  IMDCPLOT - A structure controlling the behavior of the IMDCPLOT
;             procedure, containing the following tags:
;  
;  IMDCPLOT.XAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDCPLOT.YAXIS - 4-element array corresponding to TYPE, RANGE(0:1), and STYLE
;  IMDCPLOT.FP - Bit-wise flag for fit parameters.
;  IMDCPLOT.FPINDICES - Array indices for fit parameters.
;  IMDCPLOT.CSTYLE - Style parameters for Chi^2.
;  IMDCPLOT.PTSTYLE - Style parameters for best-fit point
;  IMDCPLOT.TITLE - Title
;  IMDCPLOT.AUTO_TITLE - Automatically generate titles.
;  IMDCPLOT.SUBTITLE - Subtitle
;  IMDCPLOT.AUTO_SUBTITLE - Automatically generate subtitles.
;  IMDCPLOT.XTITLE - Xtitle
;  IMDCPLOT.AUTO_XTITLE - Automatically generate xtitle
;  IMDCPLOT.YTITLE - Ytitle
;  IMDCPLOT.AUTO_YTITLE - Automatically generate ytitle
;  IMDCPLOT.CHARSIZE - Charsize
;  IMDCPLOT.S_LABEL_POS - Position for structure label
;  IMDCPLOT.APFQ_LABEL_POS - Position for ares/pres/f/q label
;  IMDCPLOT.FP_LABEL_POS - Position for fit parameters label
;  IMDCPLOT.LEGEND:0 -  0: use curve_label, 1: use legend, -1: no legend
;  IMDCPLOT.CURVE_LABEL_POS - Curve_label position
;  IMDCPLOT.CLABEL - Curve labels
;  IMDCPLOT.JOINT - 0 for independent, 1 for joint confidence intervals
;  IMDCPLOT.LEVEL - Confidence level
;  IMDCPLOT.DCHI2_LABEL_POS - Curve_label position for Delta(Chi^2)
;  IMDCPLOT.DCHI2LABEL - Curve labels for Delta(Chi^2)
;  IMDCPLOT.LEGEND_POS - Position for legend.
;  IMDCPLOT.BANGX - Private copy of !x
;  IMDCPLOT.BANGY - Private copy of !y
;  IMDCPLOT.BANGZ - Private copy of !z
;  IMDCPLOT.BANGP - Private copy of !p
;  IMDCPLOT.WXSIZE - Plot window X size
;  IMDCPLOT.WYSIZE - Plot window Y size
;  IMDCPLOT.QSPACE - Flag for q-space plots
;  IMDCPLOT.THREED - Flag for type of 2D plot.
;  IMDCPLOT.C_NLEVELS - Number of contour levels for contour plots.
;  

;  COMMON IMD_PARS, $
;    IV,FP,FP_C,AMBIENT,AMBIENT_NC,AMBIENT_F1F2,
;    LAYER,LAYER_NC,LAYER_F1F2,SUBSTRATE,SUBSTRATE_NC,SUBSTRATE_F1F2, $
;    IV0,AMBIENT0,AMBIENT_NC0,AMBIENT_F1F20,
;    LAYER0,LAYER_NC0,LAYER_F1F20,SUBSTRATE0,SUBSTRATE_NC0,SUBSTRATE_F1F20,
;    SEED
;  
;   You shouldn't be concerned with any variables in IMD_PARS.
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;  

;  COMMON IMD_VARS, $
;    THETA,LAMBDA,IDVAR,FITPAR,CHI_2,NC,Z,SIGMA,SIGMA_FROM_PSD,
;    INTERFACE,F,Q,ARES,PRES, $
;    R,RS,RP,PRS,PRP,PSI,DELTA,
;    T,TS,TP,PTS,PTP,A,AS,AP,
;    USER1,USER2,USER3
;  
;  THETA - Incidence angles, in degrees from normal.
;  
;  LAMBDA - Wavelengths, in angstroms.
;  
;  IDVAR - A structure containing independent variable arrays.
;          Each tag of IDVAR is an array. i.e., IDVAR.IV0 = Theta,
;          IDVAR.IV1 = Lambda, etc.
;  
;  FITPAR - Similar to IDVAR, but for Fit Parameters.
;  
;  CHI_2 - Array of Chi^2 values.  Dimensions are given by the
;          number of tags to FITPAR
;  
;  NC - Complex array of indices of refraction.  Dimensions are equal to
;       N_ELEMENTS(Z)+2 by N_ELEMENTS(LAMBDA)
;       
;  Z - 1D array of layer thicknesses, in angstroms.
;  
;  SIGMA - 1D array of interface roughnesses.
;  
;  SIGMA_FROM_PSD - 1D array of flags indicating that the SIGMA value
;                   for that interface is to be computed from the PSD.
;  
;  INTERFACE - 1D array of interface profile pointers
;  
;  F - Polarization factor 
;  
;  Q - Polarization analyzer sensitivity 
;  
;  ARES - Angular resolution, in degrees.
;  
;  PRES - Spectral resolution, in angstroms.
;  
;  R, RS, RP - Reflectance
;  
;  PRS, PRP - Reflected phases.
;
;  PSI, DELTA - Ellipsometric Psi and Delta.
;  
;  T, TS, TP - Transmittance
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;  
;  PTS, PTP - Transmitted phases
;  
;  A, AS, AP - Absorptance
;
;  USER1, USER2, USER3 - User-defined functions.
;  
;   Note: the dimensions of the optical properties are determined by the
;   number of independent variables.

;   
;  COMMON IMD_FPARS,PT_SPACING,AMBIENT_DEPTH,SUBSTRATE_DEPTH
;  
;   Field calculation parameters. Don't mess with these.
;  

;  COMMON IMD_FVARS,DEPTH,INT,INTS,INTP
;  
;  DEPTH - Depth array (for field intensities)
;  
;  INT, INTS, INTP - Field intensities.
;  
;   Note: the dimensions of the field intensities are determined by the
;   number of independent variables.

;  COMMON IMD_NSVARS,Q_RANGE, $
;         THETA_IN,THETA_OUT,PHI, $
;         PSD_XI_PERP,SIGMA_D, $
;         PSD_SIGMA_R,PSD_XI_PAR,PSD_H, $
;         PSD_OMEGA,PSD_NU,PSD_N, $
;         DIDOMEGA_DWBA,DIDOMEGA_BAA,DIDOMEGA_BAS,DIDOMEGA_BAP
;
;   THETA_IN - Multi-dimensional array of Theta_in values, in degress
;              from normal.
;
;   THETA_OUT - Multi-dimensional array of Theta_out values, in
;               degress from normal.
;
;   PHI - Scattering plane azimuthal angle, in degrees.
;
;   PSD_XI_PERP - Perpendicular correlation length, used with the
;                 sigma_r/xi_par/H PSD model.
;
;   SIGMA_D - 1D array of interface diffuseness values.
;
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;   PSD_SIGMA_R - 1D array of interface roughnesses.
;
;   PSD_XI_PAR - 1D array of interface correlation lengths.
;
;   PSD_H - 1D array of interface jaggedness factors.
;
;   PSD_OMEGA - 1D array of interface volume element parameters.
;
;   PSD_NU - 1D array of interface relaxation parameters.
;
;   PSD_N - 1D array of interface PSD exponenets.
;
;   DIDOMEGA_DWBA - Non-specular reflected intensity computed from the
;                   DWBA
;
;   DIDOMEGA_BAS - s-polarized component of non-specular reflected
;                  intensity computed using the BA.
;                  
;   DIDOMEGA_BAP - p-polarized component of non-specular reflected
;                  intensity computed using the BA.
;                  
;   DIDOMEGA_BAA - polarization-averaged non-specular reflected
;                  intensity computed using the BA.

;   
;  COMMON IMD_M,X_M,Y_M,SIGY_M
;  
;  X_M, Y_M, SIGY_M - Measured data (in internal units, i.e., angstroms,
;                     degrees, etc.)

;   
;  COMMON IMD_F1F2,ATWT_LIST,ELEMENT_LIST, $
;    F1F2_COMPOUND_NAME,F1F2_DENSITY,F1F2_NUMBER,F1F2_ELEMENT, $
;    F1F2_LAMBDA,F1F2_N,F1F2_K,F1F2_AUTOPLOT
;  
;  These are all variables used by the IMD_F1F2TONK function.  You shouldn't  
;  mess with any of these.  
;

;  
;  COMMON IMD_WIDGET, $
;    MAINW,AMBW,LAYW,SUBW,IVW,OPEN_MW,FITW,CPW,FPW, $
;    PMFCW,PPSDW,PSAVW,PFLDW,NKVIEWW,PNKPATHW,PRINTW,F1F2W
;  
;    Widget ids.  You definitely shouldn't mess with these.
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;  
;  COMMON IMD_STR, $
;    IV_STR,CP_STR,FP_STR,AMBIENT_STR,LAYER_STR,SUBSTRATE_STR
;  
;    Structure variable templates.  You definitely shouldn't mess with
;    these.
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Appendix A - Optical Constants

A.1 The IMD optical constants database

A.2 Using your own optical constants

A.3 Creating new X-ray optical constants
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Chapter 4. Problem solving and reporting bugs

Should you encounter a situation in which IMD stops running, the easiest thing to do is to start over from 
scratch. That is, exit IDL, remove the IMD default configuration file, named imdsave.dat, and start 
IDL and IMD again. If you believe you have discovered a problem with IMD, please let me know about 
it. Also, I'd be most interested to hear about any suggestions you might have for future improvements. 

Note: Please understand that specifying many layers and many independent variables can easily 
result in very large arrays which might consume memory exceeding what is available to IDL. 
Should IDL run out of memory during a computation, you can try adjusting the value of the 
SP_MAX_ARRAY_SIZE and/or NS_MAX_ARRAY_SIZE variables, as described in Appendix 
B.1

Note: There is a huge number of bugs in IDL 5.0 for Windows and Macintosh. You are strongly 
encouraged to upgrade to IDL 5.1/5.2: you will see a dramatic difference!

I can be reached at windt@bell-labs.com. If you're reporting a problem, be sure to include as many 
details about the problem as you can.

Back | Contents | Next
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3.2 Specifying Fit Parameters

To perform a fit to your measured data, you must specify which parameters you wish to vary. As in the case of selecting 
independent variables, any parameters that describe the structure or the incident 'beam' can be chosen to be fit parameters (so 
long as they are not already designated as independent variables or coupled parameters.) So before specifying fit parameters, 
make sure the structure and independent variables are defined appropriately.

Continuing with our example (having already specified the structure as a single Au film, 40 nm thick,) to designate fit 
parameters select the FIT PARAMETERS button on the main IMD widget, as in Figure 3.2.1:

Figure 3.2.1 The main IMD widget as it appears when the FIT PARAMETERS button is selected.
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Now press the Add button on the FIT PARAMETERS page. You will be presented with the list of available fit parameters. 
You can choose as many parameters as you like, so long as the number of data points available is greater than the number of 
fit parameters.

Note: The structure parameters you choose as fit parameters will be indicated as such in the Structure List after the fit 
is completed.

In this example, I will choose two fit parameters: the refractive index, n, and the extinction coefficient, k of the Au film.

For each fit parameter selected, IMD will create a Fit Parameter widget that allows you to specify an initial value for 
the parameter, and, optionally, constraints on the range of acceptable fit values.

Figure 3.2.2 shows the Fit Parameter widget corresponding to the refractive index of Au. The initial value is 
automatically set to the value of n for Au at 400 nm obtained from the IMD optical constant database, i.e., n=1.657893. 
Likewise, the initial value for k is automatically set to 1.95601. 

Figure 3.2.2 Fit Parameter widget example.

Note: It's important to specify initial parameter values that are as close to the actual values as possible, or else the 
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fitting algorithm may not converge. Although the actual parameter values are usually unknown (which is probably 
why you're doing a fit), try to make as good a guess as you can.

For our example, to make things (slightly) more interesting, I will set the initial values for n and k to be far from the actual 
values; I'll choose initial values of (n,k)=(1.,1.). To see what happens in this thrilling example, go to the Next page...

Back | Contents | Next
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3.3 Curve-Fitting

Once the initial values (and optionally parameter constraints) have been set, select Calculate->Fit Optical 
Properties to Measured Data to perform the fit. A new widget will appear indicating the progress of the fit 
with each iteration. 

Once the calculation is completed, the results will be saved to an IMD file automatically, unless you have disabled this 
feature in the File->Preferences->Auto-Save... menu option.

Note: You can choose to save the measured data along with the calculation by selecting this option in the File-
>Preferences->Auto Save... menu option.

The results of our example are shown in Figure 3.3.1. The fit results are listed on the plot, showing the number of 
iterations, the final Chi^2 value, and the initial and final values of the fit parameters. The fit results are also indicated on 
the FIT PARAMETERS section of the main IMD widget, and the individual Fit Parameters widgets are updated to 
show the final fit parameter values as well.

Figure 3.3.1 Fit results.
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There are several other parameters that you can adjust on the Curve-Fit Parameters widget which affect how the 
fit is performed. This widget is shown in Figure 3.3.2, and is accessible by pressing the Curve-Fit Parameters... 
button in the FIT PARAMETERS section of the main IMD widget.

●     You can choose to use either the Marquardt (CURVEFIT) or Levenberg-Marquardt (MINPACK-1) fitting 
algorithms.

●     You can limit the Maximum number of iterations, and you can specify the Acceptance tolerance: the fitting will 
stop when the decrease in the (reduced) Chi^2 statistic is less than the Acceptance tolerance in one iteration. 
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●     You can designate the Weighting factor: if you have loaded in measured data that includes estimated uncertainties 
(non-zero SIGY_m), then you should use Instrumental weighting: 1/SIGY_m^2. Otherwise, you can use either 
Statistical weighting: 1/Y_m, or no weighting. (See reference [15] for more details.) 

●     You can select Logarithmic Fitting, in which case the Chi2 function will be computed from the logarithms of the 
calculated and measured optical functions.

●     You can add a fixed offset and/or scale factor to the dependent variable, to account for a possible systematic error 
in your data; or, you can set the offset and/or scale factor values to be fit parameters if desired (using the Add 
button on the FIT PARAMETERS section of the main IMD widget.

Figure 3.3.2. The Curve-Fit Parameters widget. 

The results of a more complicated fitting example are shown in Figure 3.3.3. In this case, the X-ray reflectance of a W/Cr 
bilayer film was fit, using eight fit parameters. (The IMD file used to produce this plot is called 
examples.dir/WCr_bilayer.FIT.imd; the measured data file is called 
examples.dir/WCr_bilayer.MEASURED.dat.)

Figure 3.3.3. Fit to X-ray reflectance data of a W/Cr bilayer film
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3.4 Confidence Intervals

The abbreviated discussion of confidence intervals presented in this section is based largely on the methods described in 
references [16] and [17]. Please consult those papers for a full discussion.

To quote Lampton, et al., "In parameter estimation, it is the range of parameter values to which a theory is restricted that is 
the useful result of an experiment. The discrete best-fitting values of the parameters are essentially statistical artifacts subject 
to a variety of correlated random errors originating in the counting statistics of the original data. If an experiment could be 
repeated without systematic changes, best-fitting parameter values would differ, while their properly derived allowed ranges 
will overlap."

Once you have performed a fit, IMD can compute independent and joint confidence interval estimates on the fit parameters. 
The confidence intervals are estimated by computing the value of the Chi^2 statistic on a grid of points in parameter-space. 
Although there is no limit on the number of fit-parameters you can select when performing curve-fitting in IMD, due to the 
limit of 8-dimensional arrays imposed by IDL, you can only compute 8-dimensional confidence intervals. (If this is a 
problem for you, then you're probably doing something you shouldn't be doing anyway.)

To compute confidence intervals, you must first designate which fit parameters are to be included in the parameter space to 
be examined. So, for each parameter of interest, you must check the box labelled Compute confidence intervals 
for this parameter, in the associated Fit Parameter widget. Shown in Figure 3.4.1 is the Fit Parameter 
widget for the refractive index, n of the Au film in the example of the previous section.

Figure 3.4.1 Fit Parameter widget for refractive index, n
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For each fit parameter you select, you must specify the parameter grid over which the Chi^2 statistic is to be computed. To 
illustrate, in figure 3.4.1, because the best fit value for n is approximately 1.66, I have selected 21 parameter values, ranging 
from n=1.5 to 2.0. Similarly, I have selected 21 values for k, ranging from 1.9 to 2.1 (not shown.)

Once you have completed the parameter grid specifications for all fit parameters of interest, select the Calculate-
>Compute Confidence Intervals option from the main IMD widget. IMD will then iterate through each of the 
parameter values throughout the parameter-space grid you have defined, and compute the value of Chi^2. 

The actual method used to compute Chi^2 at each point in the parameter space you have defined depends on what fraction of 
the fit parameters you have specified for confidence interval generation. That is, if you have elected to compute confidence 
intervals for all of the fit parameters used to perform the fit, then IMD will simply compute the value of the optical function 
for each of the parameter values, and compare it with the measured data in order to compute the value of Chi^2 at that point 
in parameter space. On the other hand, if you have selected only some of the parameters for confidence interval generation, 
then IMD will perform a non-linear, least-squares fit to the data at each of the points in the parameter-space grid you have 
defined, with the remaining fit parameters used as adjustable parameters to minimize Chi^2 at that point in parameter 
space. This latter option is useful if, for example, your fit parameters consist of a mix of 'interesting' and 'uninteresting' 
parameters. As an example, if you have derived optical constants, n and k, from reflectance vs. incidence angle data, and 
have also used a Reflectance Offset as a fit parameter to account for some offset in your data, then you might wish to 
compute confidence intervals for n and k, but not for the Reflectance Offset.

After the calculation is completed, the results will be saved to an IMD file automatically, unless you have disabled this 
feature in the File->Auto-Save Preferences menu.

The confidence intervals will be displayed in another IMDXPLOT widget, as shown, for example in Figure 3.4.2:

Figure 3.4.2 Confidence Intervals plot.
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By checking the Continuous Variable boxes next to each of the fit parameters (in the FIT PARAMETERS area of the 
IMDXPLOT widget,) you can display either 1D plots of Chi^2 versus the parameter value, or 2D contour plots showing 
contours of constant Chi^2. You can use the Value and Index widgets for non-continuous fit parameters to display 
Chi^2 plots for discrete parameter values, and you can used the FIXED CURVES buttons to overlay multiple confidence 
intervals on the same plot.

The area of the IMDXPLOT widget labelled CONFIDENCE LEVEL allows you to adjust which confidence level is 
displayed, and, if you have computed confidence intervals for more than one parameter, whether independent or joint 
confidence intervals are shown. These adjustments determine the value of Delta(Chi^2) that is displayed on the plots. That 
is, the confidence interval corresponds to the region in parameter space for which the value of the Chi^2 statistic is less than 
the minimum value (i.e., the value at the best-fit point) plus an amount Delta(Chi^2). For example, if you have computed 
confidence intervals for 2 fit parameters, then the 68% joint confidence interval corresponds to Delta(Chi^2) = 3.5, which is 
the value of the Chi^2 function for 2 parameters with significance 1-.68=.32. (Please refer to Lampton et al. for further 
details.)

Shown in Figure 3.4.2 are 68% and 90% joint confidence intervals for n and k, for the example we have been discussing. The 
meaning of these contours is the following: there is a 68% (90%) probability that the true values of n and k both lie within 
the green (red) region displayed in the figure. 
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1.4 Starting IMD

Before you attempt to start IMD, make sure that the imd directory is included in your IDL Path. Consult 
the IDL manuals for instructions on how to do this.

To start IMD, at the IDL prompt type:

IDL> .run imdstart

This will load IMD and launch the main IMD program. If you exit IMD and wish to run it again during 
the same IDL session, at the IDL prompt type:

IMD> imd

Note: You can define NORUN=1 before executing '.run imdstart', to inhibit automatic 
execution of the imd procedure.

Note: On Unix platforms, the IDL_DEVICE environment variable must be set to 'X'.
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